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0. ÚVODNÍ CVIČENÍ  

CÍL 

Seznámení se s prostředím Catia V5 a vytvoření šablony pro další cvičení.  

  

Manuál nemusí vždy přesně popisovat jednotlivé funkce, vychází spíše z praktických zkušeností. Je určen jak úplným 
začátečníkům (myšleno CATIA začátečníkům, ne CAD začátečníkům), kteří se pokouší namodelovat svůj první model, 

tak i zkušeným konstruktérům, kteří zde mohou nalézt užitečné postřehy. 
 

 

 
 

PŘEDPOKLADY 

 Základní znalosti ovládání počítače. 

 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Prostředí 
 Moduly 

 Ovládání 
 Tvorba šablony 
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Krok č.1  Jak používat tyto manuály 

Tato učebnice je složena z několika lekcí, mapující možnosti a způsob užití Mechanical Design a částečné ukázky 

z Shape modulů programu Catia. Každá lekce má na začátku stanovené cíle a potřebné znalosti pro dokončení. 
Na první stránce je rovněž ukázáno, jak by měl vypadat výsledek. 

 

Lekce je rozdělena do série kroků, které jsou vzestupně číslované 

 

Každý krok obsahuje jeden nebo více bodů, které jsou rovněž číslovány a často je na ně odkazováno 

 
Mimo přímý popis postupu bývají v jednotlivých krocích i okýnka s doplňujícími informacemi 

 

 

 

 
 

Krok č.2 Spuštění a seznámení se základním oknem 

1. Program spustíte klasickým způsobem. Poklikáním na ikonu zástupce na ploše nebo z nabídky Start. 

2. Standardně se po spuštění programu v základním nastavení se otevře prázdná sestava (assembly). 
 

 
 

Upozornění nebo varování 

 

Doplňující informace 

 

Tip pro zjednodušení 
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3. V horní části je běžné roletové menu s následujícími sekcemi. 

 

 
 

 Start - spouštění jednotlivých modulů CATIA 

 ENOVIA V5 VPM - PDM databáze Dassaultu 

 File - Otevírání souborů nových/ze šablon, ukládání, tisk, odeslání dat na email,… 

 Edit - Undo/Redo, Copy/Paste, hledání, výběrové sety, vazby mezi soubory (Links) 

 View - nastavení zobrazování, nastavení ovládacích lišt 

 Insert - vyvolání všech dostupných funkcí zvoleného modulu 

 Tools - nástroje, každý modul má dostupné jiné nástroje 

 Analyze – nástroje pro analýzu (měření délek, tvarů,…) (v závislosti na modulu) 

 Window - rozdělení oken, je-li jich otevřeno více 

 Help – nápověda 

 

 
 

 

4. Základní popis okna. 

 

 
 

 

 

Kopas: Kompas slouží k orientaci v prostoru, pomocí něj lze otáčet a posouvat se scénou. V některých 
modulech má i další využití. 

Strom: Strom je zobrazení všech komponent a objektů v aktuálního projektu a jejich vzájemné propojení. 
Dialogové okno: V Dialogovém oknu se nastavují jednotlivé parametry aktuální operace. 

Společné ovládací prvky: Panel s funkcema fungujícíma napříč moduly, jedná se příkazy na ovládání 

pohledu, apod. 
 

Společné ovládal prvky 

Kompas 

Kontextová nápověda Vstup (příkazy,…) 

Ovládací prvky modulu 

Strom specifikací (prvků) 

Model 
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Krok č.3 Nastavení a popis základních lišt  

5. V roletovém menu vyberte nabídku View -> Toolbars a nyní aktivujte tyto nabídky (pokud tak již nemáte). 

 Graphic Properties 

 User-Selection Filters 

Panel Standard -  Jeden ze základních panelů s nástroji, který je zobrazen ve všech modulech.  

 
Panel Standard 

 

 

New - Otevře malé dialogové okno s výběrem typu nového dokumentu. 

 

New From * - Otevře nový soubor ze šablony. *) Funkce je dostupná pouze v roletovém menu File. 

 

Open - Otevře stávající objekt ze zvoleného umístění. Zde je možnost zatrhnou možnost Otevřít jen pro 

čtení. Objekt potom nepůjde přeuložit, pouze uložit pod jiným názvem. 

 

Save - Uloží aktivní dokument v aktivním okně. Chceme-li uložit více objektů najednou, musíme použít 

funkci Save Management. 

 

Print - Vytiskne zvolený dokument. 

 

Cut - Vyjmout - standartní funkce vyjmutí elementu do schránky (Ctrl + x). 

 

Copy - Kopírovat do schránky (Ctrl + c.) 

 

Paste - Vložení ze schránky (Ctrl + v). 

 

Undo - Vrátí zpět poslední provedenou operaci. 

 

Undo With History - Otevře dialogové okno s posledními operacemi (jejich počet lze upravit v nastavení). 

Výběrem jednotlivých operací se můžeme rychle vrátit do požadovaného stavu. 

 

Redo - Obnoví poslední operaci, která byla vrácena funkcí Undo. 

 

Redo With History - Viz Undo With History, ale namísto vracení operací zpět můžeme obnovit operace, 

které již byly vráceny. 
 

Panel Graphic Properties -  Nástroje pro nastavení grafických atributů (barva, průhlednost, tloušťky čar,...) u 
jednotlivých objektů a elementů. 

 
 

Barva - v nabídce je 16 barev. Kliknete-li na More, otevře se okno, kde si můžeme nadefinovat další barvy. 

Průhlednost - základní nastavení je Auto. Je-li nastaven jiný mód Shadingu než Shading With Material, bude 

průhlednost vždy 50% nezávisle na tom, jaká bude její hodnota. 
Tloušťky čar - tloušťka 3D křivek (skic). Předdefinováno několik hodnost, lze nadefinovat další. 

Typ čar - typ 3D křivek (plná, čárkovaná, ...). 
Symbol 3D bodu - způsob, jakým se budou zobrazovat 3D body. 

Mód Shadingu - prozatím neznáma funkce (pozn. aut). 

Hladiny - přesune objekt do zvolené hladiny. Potřebuje-li nadefinovat novou hladinu, zvolíme v nabídce  
Other layers... a v okně, které se otevře klikneme na New. 

 

Painter 
Štětec, podobná funkce jako jiných aplikací. Pozor! Funguje obráceně. Nepřebírá vlastnost prvního 

objektu a neaplikuje jí na druhý, ale prvnímu objektu změní vlastnost podle druhého. 

 

Graphic Properties Wizard 
Průvodce nastavením grafických vlastností - otevře se okno, ve kterém se po vybrání některého 

elementu zobrazí jakási hierarchie vybraného elementu s jednotlivými vlastnostmi, které můžeme 

měnit. 
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Panel View - funkce pro pohyb s modelem, rychlé natočení modelu do základních směrů (nárys, bokorys, ...) a 

dále funkce pro nastavení aktuálního zobrazení (s hranami, bez hran, drátový model, vykreslení textur, atd). 

 

 
 

 

Fly - Mód pro pohyb s modelem. Pohyb v modelovém prostoru napodobuje let letadlem. Ovládání 

pomocí myši není právě moc komfortní, mód je určený spíše pro speciální polohovací zařízení. 

 

Fit In All - Velice praktická funkce. Nazoomuje celý modelový prostor tak, aby bylo vidět vše, co je v 
modelu (sestavě) zobrazeno. Pomůže nám např. v případech, kdy se některý velmi malý objekt, který 

při malém zoomu již téměř není vidět, dostane tam, kde nemá být. Pokud se nám se nám model po 
spuštění této funkce "smrskne" do malé tečky uprostřed, víme s jistotou, že ještě někde něco bude. 

 

Pan - Posouvání modelu (vlevo, vpravo, nahorů, dolů) - po spuštění uchopíme model myší a 

pohybujeme jím do stran. 

 

Rotation - Otáčení modelu - po spuštění uchopíme model myší a můžeme jím otáčet. 

 

Zoom In - Přiblíží model o určitou vzdálenost. 

 

Zoom Out - Oddálí model o určitou vzdálenost. 

 

Normal View - Natočí model paralelně k obrazovce podle vybrané rovinné plochy. Velmi praktická 

funkce. 

 

Create Multi View - Rozdělí okno do čtyř menších oken. V každém z nich lze modelem pohybovat 
nezávisle na ostatních. Praktické v případech, kdy potřebujeme vidět model z více stran najednou. 

 

Isometric View - Natočí model do izometrického pohledu. Pod touto funkcí jsou skryty další funkce 

pro ostatní základní pohledy (nárys, půdorys,...). 

 

Shading (SHD) - Různé módy pro zobrazení kontur, hran a ploch. V tomto módu jsou zobrazeny 
pouze vnější plochy modelu. 

 

Shading With All Edges - Zobrazí model se všemi plochami a jejich hranicemi. Základní nastavení. 

 

Shading With Edges Without Smooth Edges - Zobrazí pouze plochy a ostré (netangentní) 
hrany. Praktické, potřebujeme-li zjisti právě tangentnost napojení jednotlivých ploch. 

 

Shading With All Edges And Hidden Edges - Zobrazí model se všemi plochami a jejich hranicemi 

a navíc všechny neviditelné hrany. 

 

Shading With Material - Zobrazí model s texturou, pokud má přiřazen materiál. Jinak je zobrazení 
stejné jako u Shading. V tomto módu se plynule projevuje nastavení průhlednosti (v ostatních 

módech je nezávisle na nastavení průhlednost 50%, pokud je nastavena). 

 

Wireframe - Drátové zobrazení - jsou zobrazeny pouze hranice ploch a hrany, ale žádné plochy 
(Vzpomínáte si ještě na CATIA V4?). 

 

Customize View Parameters - Uživatelsky definovatelné zobrazení. Otevře se dialogové okno, kde 

lze zatrháváním jednotlivých položek nastavit co a jak se bude zobrazovat. Při práci s plochami se 
může hodit volba Isoparameters. 

 

Hide/Show - Přesune objekt z viditelného do neviditelného prostoru nebo obráceně. Je-li objekt 

zobrazený či skrytý je snadno poznat vhierarchickém stromu - skrytý objekt je zobrazen průhledně. 

 

Swap Visible Space - Změna mezi viditelným a neviditelným prostorem. Neviditelný prostor má 
světle zelené pozadí 

 
 

Dále v roletovém menu View existují funkce pro nastavení osvětlení, efektu hloubky,  

 

Lighting - Osvětlení modelového prostoru. Lze jej úplně vypnout, nebo si vybrat z jedno-, dvou- či 

vícebodového světelného zdroje. Lze měnit intenzitu a barvu světel. 

 

Depth Effect - Velmi praktická funkce. Nastaví se pevná vzdálenost modelu od roviny obrazovky.  

 

Ground - Zobrazí rast ve směru XY - pomyslnou "zem". Lze s ní pohybovat myší ve směru Z. 

 

Magnifier - Zvětšení detailu. V modelovém prostoru se zobrazí obdélníkový výběr, který je zvětšen v 

nově otevřeném okně. 
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User Selection Filter -  slouží k nastavení výběrového filtru pro prostředí modelu a také pro prostředí skicáře. 

 

 
 
 

 Point – aktivní výběr pouze bodů 

 Curve – aktivní výběr křivek 

 Surface – aktivní výběr ploch 

 Volume – aktivní výběr více prvků 

 Feature Element Type – výběr modelů, skic, geometrical setů,  

 Geometrical Element Type – geometrické prvky (roviny, body, úsečky,… prvky vytvořené základními 

funkcemi (Line, Point,…) v prostoru modelu) 
 

Krok č.4 Nastavení pohledu pomocí myši 

Zprvu je způsob ovládání značně složitý, ale po určitém čase se jedná o velice rychlý a efektivní způsob ovládání. 

 
Výběr: Kliknutí levým tlačítkem myší 

Pohyb s modelem: podržet prostřední tlačítko myší a hýbat myší  

Zoom: podržet prostřední tlačítko myši, kliknout pravým a hýbat myší  
Rotace: podržet prostřední a pravé tlačítko myši a hýbat myší 

Kontextové menu: Kliknutí pravým tlačítkem myši 
 

Rotace 

Kontextové 
menu 

Zoom 

Výběr 

Pohyb 

Držet 

Kliknout 
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Krok č.5 Strom specifikací (prvků) 

 

6. Jednotlivé uzly stromu se dají rozbalit a sbalit kliknutím na šedivý kroužek s křížkem.  
7. Pozor! Kliknete-li na větev stromu (čára spojující jednotlivé uzly) nebo na malý osový kříž vpravo dole, model 

zašedne a nelze s ním hýbat, a strom lze zvětšit/zmenšit stejným způsobem jako při zoomu modelu (lze vypnout v 
Options). 

8. Strom lze i posunovat po obrazovce - stačí ho chytnout levým tlačítkem za větev a můžeme s ním pohybovat.  

9. Stisknutím klávesy F3 lze strom skrýt. 
 

10. Pomocí roletové nabídky View – Tree Expansion -> Expand First Level – rozbalí první level stromu 
-> Expand Second Level - rozbalí druhý level stromu 

-> Expand All Level -  rozbalí všechny nabídky stromu 

-> Collapse All – sbalí všechny nabídky stromu 
-> Expand Selection - rozbalí vybranou část stromu 

 

Základní konstrukční hladiny 

Aktivní prvek 

Podtržení – aktivní pracovní prvek 

Uživatelem vytvořené parametry 

Prvek 

Skica 

Prvky skici 

Vybraný prvek 

Vazby sestavy 

Materiál těla 

Component 

Product 

Part Body 

Part 
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Krok č.6  Nastavení pohledu pomocí kompasu 

11. Kompas je zobrazen v každé pracovní ploše 

12. Kompas je nástrojem, který v sobě integruje funkčnosti, známé z jiných aplikací pro 3D modelování jako posun a 
rotace. Umožňuje tedy libovolně posouvat a otáčet pohledy na zobrazenou součást. Použití kompasu vyžaduje 

určitý cvik, především při jeho řízení. 

13. Lze ho zobrazit / skrýt přes nabídku View - > Compass 
14. Pokud kliknete pravým tlačítkem myši na kompas a aktivujete volbu 

Snap Automatically to Selected Object, můžete vybráním 
komponentu přesunout kompas na součást. 

15. Pomocí View - > Reset Compass vrátíte kompas na svou pozici 
v pravém rohu okna. 

 

 
Posun ve směru osy 

 

 
Volná rotace 

 

 
Posun v ploše 

 

 
Nastavení pohledu ve směru osy 

 

 
Rotace v jedné ose 

 
Přemístění kompasu 
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Krok č.7  Ukládání 

16. Pro ukládání dat máme několik způsobů. První a nejjednodušší je funkce Save (panel Standard) - uloží aktivní 

dokument. Buď jen samostatný model nebo sestavu(s tím co obsahuje). NADŘAZENÉ dokumenty se neukládají. 
Tento typ doporučuji používat opravdu jen u samostatných modelů. 

17. Nejlepší způsob pro ukládání je použít funkci Save Management (roletové menu File). Otevře se následující 

okno, ve kterém je výpis všech dokumentů, které jsou otevřeny. U každého dokumentu je informace o jeho 
stavu, názvu, umístění, prováděné akci a čtecích právech. Stav dokumentů může být následující: 

 New - nově otevřený, ještě neuložený dokument 
 Open - otevřený dokument beze změn 

 Open(Read Only) - otevřený dokument, který je pouze pro čtení (nelze jej přeuložit) 

 Modified - dokument, na kterém byly provedeny změny 

 Modified(Read Only) - dokument, na kterém byly provedeny změny, ale je pouze pro čtení 

 Modified By Synchronisation - dokument, který byl modifikován při synchronizaci 

18. U každého objektu můžeme nastavit co s ním chceme provést - uložit (Save) nebo uložit pod jiným názvem 

(Save As). Funkce Propagate Directory nastaví jedno jediné umístění u všech dokumentů. Reset vrátí 

všechny změny. 
19. Pokud ukládáme sestavu, automaticky se uloží všechny dokumenty, které obsahuje. Tuto možnost lze potlačit 

volbou Enable Independent Saves. Pak lze ukládat jednotlivé dokumenty naprosto nezávisle. Samotné uložení 
provedeme stiskem tlačítka OK. 

 

UPOZORNĚNÍ: V žádném případě nepoužívejte souborové manažery k přeukládaní. Může to vést k přerušení 

vazeb a ztrátě dat. 
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Krok č.8  Důležité lišty Part Design 

20. Pomocí Start -> Mechanical Design -> Part Design se přepnete do okna pro modelování. 

21. Po přepnutí do tohoto modulu se ve spodní liště obvily nové panely. 

Panel Tools - můžete zde nastavit mód Updatu, zobrazení, vytváření "mrtvé" geometrie. 

 
 

 

Update - Provede update celého modelu (aktivního dokumentu). 

 

Manual Update Mode - Mód updatu. Je-li funkce vypnuta, update se provede automaticky po 
potvrzení / ukončení funkce nebo po opuštění skicáře. Pokud funkci zapneme, update se provede 

jen při kliknutí na jeho ikonu. 

 

Mean Dimension - Vypočte střední hodnotu tolerovaných rozměrů. 

 

Pickable Visible Background - Různé módy zobrazení, viz. Sketcher. 

 

Create Datum - Pokud je tato funkce zapnutá, výsledkem většiny funkcí je pouze mrtvá 

geometrie. 

 

Only Current Body - Pokud je tato funkce zapnutá, jsou zobrazeny pouze objekty (geometrie), 

která je uvnitř Body, ve kterém pracujeme. 

 

Only Current Operated Solid - Pokud je tato funkce zapnutá, je zobrazeno pouze těleso (solid), 
ve kterém pracujeme, tj. uvidíme vše co je v Body od prvního elementu do pracovního elementu. 

 

Catalog Browser - Prohlížeč katalogů. Obdoba klasického windows průzkumníka - umožňuje 
vkládaní katalogových komponentů (normálie, makra, powercopy,...) 

 

Measure – můžete odměřit délky, průměry, uhly, hmotnost,… u vybraných modelů 

 

 
 

 Measure Between – měření vzdáleností (metr) 

 Measure Item – měření průměrů, radius,… (“posuvka”) 

 Measure Inertia – měření vlastností (hmotnost, poloha težistě,…) 

 
 

Apply material – nastavení materiál z knihovny 
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Krok č.9 Skicáři 

22. Skicář je prostředí (okno) pro tvorbu skic, které se dále využívají. 

 

Constraint - panel sloužící pro tvorbu kót, vazeb mezi nakreslenými prvky 
 

 
 

 

Constraint - rozměrové vazby - vzdálenost, délka, průměr, úhel.  

 

Contact Constraint - vytvoří kontaktní vazbu mezi vybranými elementy (tečnosti, koincidence - v 

závislosti na typu elementů). 

 

Fix Together - sváže všechny vybrané elementy do jedné skupiny. Praktické u velkého počtu 

malých elementů vzniklých třeba při projekci. 

 

Auto Constraint - automatické vytváření vazeb ... 

 

Animate Constraint - rozpohybování skici - některému rozměru se přiřadí rozmezí hodnot a počet 
kroků, na kolik se má přesunout z počáteční do cílové polohy a funkce jej sama rozpohybuje.  

 

Edit Multi Constraint – zatím ještě nevyužito (pozn. autora) 

 

 

Sketch tools – panel nastavení prostředí, přepínání mezi konstrukční a normálním módem a zapnutí tvorbu vazeb 

(vazby, kóty) 

 
 

 

Grid - mřížka, která pomáhá při vytváření geometrie. Rozteč je implicitně 10mm, lze přenastavit. 

 

Snap to point - při vytváření geometrie se kurzor chytá bodů v mřížce 

 

Construction/Standard Element – pro tvorku konstrukčních či normálních prvků 

 

Geometrial Constraint – automatické nabízení tvorby vazeb 

 

Dimensional Constraint – automatické vytváření kót, které byly zadány při vytváření geometrie 

 

 

 

 

Do skicáře se přepnete pokud kliknete na  Sketch a vyberete jednu ze zobrazených rovin. 
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23. V základním nastavení lišt skicáře je zobrazení pouze lišty Profile a Operation. 

                      
 

24. Tyto lišty slouží k tvorbě základních geometrii (čar, oblouků,…) a editování geometrii (sražení, zaoblení, mazání, 
kopírování, zrcadlení,…) 

25. Převážně všechny funkce v tato nabídce jsou rozkliknutelné a skrývají tak další možnosti pro tvorbu geometrii. 

Pokud kliknete na ikonu, rozbalí se nabídka dalších prvků. 
26. Pokud kliknete na černou šipku u ikony, zobrazí se nabídka s dalšími prvky. Tuto nabídku si následně můžete 

přesunout a umístit na lišty dle potřeby. 
 

 

        
 

 



Krok č.10 Vytvoření šablony 

27. Zavřete Catii.  

28. Nyní překopírujte soubory ze složky …00_UVODNI_CVICENI\B19\win_b64\... do složky kde máte nainstalovanou 
Catii. Standardně se Catie vyskytuje: C:\Program Files\Dassault Systems\B19\win_b64\... poslední dva názvy 

složek se mohou lišit (závisí na typu Catie a názvu počítače). 

 

29. Spusťte Catii. Otevře se okno pro tvorbu sestavy (zmíněno dříve). 

30. Zavřete okno sestavy (spodní křížek). 
31. Nyní jsou dva způsoby spuštění modeláře. 

První způsob  

32. Klikněte na nabídku Start -> Mechanical Design -> Part Design. 
33. Otevře se okno New Part. Vložte název 00_SABLONA.  

34. Zde odškrtněte Enable hybrid design a zaškrtněte Create a geometrical set. 

35. Nabídku potvrďte . 

 
 

Druhý způsob  

36. Klikněte na   New ve spodní liště nebo klávesová kombinace CTRL+N. 
37. Otevře se okno New. 

38. V okně vyberte Part a výběr potvrďte . 
39. Otevře se okno New Part. Vložte název 00_SABLONA.  

40. Zde odškrtněte Enable hybrid design a zaškrtněte Create a geometrical set. 

41. Nabídku potvrďte . 
 
 

42. Zkontrolujte, zda máte pro práci aktivní geometrical set. 

43. Klikněte na  Point v boční nástrojové liště., 

44. Zobrazí se okno pro tvorbu bodu. 
45. Nastavte Point type: Coordinates 

46. Všem souřadnicím nastavte nulovou hodnotu. 

47. Nabídku potvrďte . 

 

Catie jde ukončit taktéž přes nabídku Start -> Exit. 

 

Nyní jste přidali nové razítko a dva nové formáty do Catie, které budete využívat později při tvorbě výkresů. 

 

Aktivaci provedete klikem na geometrical set pravým tlačítkem a nabídce vyberte Define In Work Object. 
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48. Klikněte na  Line v boční liště. 

49. Vyberte Line type: Point-Direction. 

50. Nyní vyberte vytvořený bod. 
51. Jako Direction vyberte rovinu xy. 

52. Nastavte Start hodnotu -50mm a End hodnotu 50mm. 

53. Nastavení potvrďte . 

 

 

54. Vyberte vytvořenou úsečku. 
55. V horní liště nastavte typ čáry čerchovanou. 
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56. Stejným způsobem vytvořte další dvě osy na roviny yz plane a zx plane (v tomto pořadí). 

 

 

57. Klikněte pravým tlačítkem na xy plane a vyberte Properties. 

58. Vyberte záložku Feature Properties. 
59. Přejmenujte Feature Name na Pudorys. 
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60. Stejným způsobem přejmenujte i ostatní prvky ve stromě prvků dle obrázku. 

 

 

61. Klikněte na  Save v spodní liště. 

62. Vyberte složku pro uložení a potvrďte . 

 

 
 
 

 

 

Tuto vytvořenou šablonu budeme využívat později při tvorbě modelů, proto je důležité, aby byla vytvořena správně. 
Předpřipravenou šablonu naleznete taktéž ve složce 00_UVODNI_CVICENI. 
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1.CVIČENÍ  

CÍL 

Osvojit si základy tvorby komponentů v systému CATIA V5 na ukázkovém příkladu tvorby jednoduché součásti síta 

mlýnku na maso. 
  

 

PŘEDPOKLADY 

 znalost základů systému popsaných v tutoriálu UVOD 

 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Protažení (Pad) 

 Kapsa (Pocket) 
 Díra (Hole) 

 Pole prvků definovaných uživatelem (User Pattern) 
 Sražení hran (Chamfer) 

 Aplikace materiálu (Apply material) 

 Výpočet hmotnosti (Measure Inertia) 
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Krok č.1 Vytvořit novou součást 

1. V nástrojové liště klikněte na tlačítko . 

2. Otevřete si šablonu z předešlého cvičení.  

3. V nabídce File vyberte Save As. 
4. Vyberte složku pro uložení součásti. 

5. Jako File name zadejte 01_SITKO 
6. Potvrďte tlačítkem . 

 
 

 

 

Krok č.2 Protažení obrysu sítka (Pad) 

7. Klikněte na ikonu protažení Pad v boční nástrojové liště.   

 Nejprve vytvoříme skicu (sketch). 

8. Začneme kliknutím na  . 

9. Vyberte rovinu (např. PUDORYS) klepnutím levým tlačítkem myši 
v hlavním okně nebo ve stromě. 

 Na této rovině bude ležet skica (sketch), kterou vytvoříme. 

10. Vybráním plochy se automaticky přepnete do skicáře (sketcher). 

 

 

 

 
 

 
 

 

 
 

 
 

11. V horní liště zkontrolujte zapnutí/vypnutí nabídek   

12.  V boční liště vyberte  Circle pro vytvoření kružnice 

s počátkem v středu souřadnic.  

13. Vytvořte pomocí   kótu kružnice. Dvojklikem na kótu upravte 
na 53mm  

14. Režim skicáře ukončíte kliknutím na ikonu  v boční nástrojové 
liště 

 

V názvech souborů nepoužívejte diakritiku ani speciální znaky. 
Potřebujete-li v názvu souboru mít mezeru, použijte podtržítko “_“. 
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15. Přepište velikost protažení na 5mm. Pomocí   nastavte směr vysunutí. 

 Velikost protažení lze nastavit taky upravením kóty v hlavním okně. Směr vytažení lze nastavit též pomocí klikem na šipku 
v hlavním okně. 

 

 

16. Ukončete nabídku pomocí  

 
 

 

 
 

 
 

 
 

Krok č.3 Vyříznutí drážky (Pocket) 

17. Klikněte na ikonu protažení  Sketch. 

18. Vyberte rovinnou plochu právě vytvořeného tělesa. 

19. Z boční lišty vyberte  a klikněte na vnější hranu modelu. Docílíte promítnutí této hrany do skicáře. 
 

 
 

 

 
 

 
 

Více informací o prvku PROTAŽENÍ viz dokument PROTAZENI. 

 

Jak MANIPULOVAT S MODELEM se dozvíte v dokumentu ÚVOD. 

 

Hrana promítnutá pomocí příkazu Project 3D Elements se automaticky modifikuje, pakliže se změní rozměry 
původního tělesa. Funguje zde vztah RODIČ-POTOMEK (PARRENT-CHILD), kdy promítnutá hrana a tudíž i celý prvek 
protažení, který právě vytváříme je potomkem původního prvku protažení, který jsme vytvářeli v kroku č.2 

Nezapomínejte pravidelně ukládat, abyste se případně mohli vrátit k dřívější verzi souboru. 
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 Pro lepší přehlednost přepněte na drátový model. 

20. Klikněte na  Circle  vytvořte kružnici o průměru 3.5mm se středem na svislé ose se vzdáleností od středu 

souřadnic 25.5mm. 

 Kružnice by měla zezelenat, což značí dostatečné zavazbení. 

 

 

 
 

 

21. Příkazem  Line vytvořte dvě úsečky následujícím postupem: 

 
o První bod úsečky vytvoříte na kružnici. 

o Druhý bod úsečky (viz obr vlevo) vytvoříte tak, aby se zobrazil znak značící geometrickou vazbu 

tečnosti kružnice a nově vytvořené úsečky. Bod leží na promítnuté kružnici. 
o Druhou úsečku vytvoříte obdobným způsobem jako první úsečku. 

o Označte obě vytvořené čáry (výběr více předmětů klávesa Ctrl). Klikněte na  a zaškrtněte vazbu 

Vertical, přidaná vazba se zobrazí u čáry (viz. obr. vpravo). A potvrďte . 
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22. Klikněte na   Quick Trim a odstraňte části úseček, kružnic apod. tak, aby zůstala ve skicáři pouze jedna 

uzavřená smyčka 

 Dvojklikem na ikonu vybereme příkaz, který bude aktivní, dokud ho neukončíme klávesou Esc. 

 

 
 

23. Pomocí  Sketch Analysis, v dolní liště, lze zkontrolovat zde je profil uzavřen. 

24. Režim skicáře ukončíte kliknutím na ikonu  v boční nástrojové liště 
 

25. Označte vytvořenou skicu. 

 Profil lze vybrat v hlavním okně, nebo ve stromě příkazů. 

26. Klikněte na  Pocket v boční nástrojové liště.   

27. Přepněte zobrazení modelu zpět na stínovaný ikonou  
28. Jako Limit vyberte protilehlou plochu proti skice. 

 

 
 

29. Ukončete příkaz kliknutím na . 

 

 
 

 

Pravidelně ukládejte (CTRL+S) 
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Krok č.4 Vytvoření díry (Hole) pro pole User Pattern 

 Nyní vytvoříme díru, ze které pak následně pomocí funkce User Pattern vytvoříme pole děr. 

30. Klikněte na  Hole v boční nástrojové liště a vyberte rovinnou plochu na tělese.  

31. V nabídce klikněte na  Sketch. Přepnete se tímto do skicáře. 

32. Vyberte vytvořený bod a Nulový bod a pomocí  vložte vazbu Coincidence. 

33. Režim skicáře ukončíte kliknutím na ikonu  v boční nástrojové liště. 
34. V nabídce vyberte Up To Surface, jako Limit vyberte protilehlou rovinou plochu. 

35. Nastavte průměr 4mm a ukončete příkaz kliknutím na . 

 

 

Krok č.5 Vytvoření skici pro pole User Pattern 

 Nyní vytvoříme skicu, ze které pak následně pomocí funkce PATTERN vytvoříme pole děr. 

36. Klikněte na  Sketch v boční nástrojové liště. 

37. Vyberte jednu rovinou plochu. 

 Pro lepší přehlednost přepněte na drátový model. 

38. V horní nástrojové liště zapneme funkci  Construction element. 

39. Klikněte na   Hexagon a vytvořte šestiúhelník s počátkem ve středu souřadnic (viz. obr. vlevo). 

40. Vyberte vytvořenou úsečku, klikněte na  a zaškrtněte Horizontal, vytvoří se horizontální vazba (viz. obr. 

vpravo). 

 

   

1 - 6



41. Klikněte na  Line a spojte střed souřadnic s levým horním vrcholem šestiúhelníku (viz. obr. vlevo). 

42. V horní nástrojové liště vypněte funkci  Construction element.  

43. Dvojklikem na  Point vytvoříme několik bodů. 

   Vždy se ujistěte, že se zobrazí znak , který Vám zaručí vznik vazby Coincidence /Concentricity.  

o Prvních šest bodů bude ležet ve vrcholech šestiúhelníku (viz. obr. vpravo). 
o Dalších šest bodů umístěte na střed stran šestiúhelníku (viz. obr. vpravo).  

 

    
 

44. Klikněte na  Constraint a vytvořte kótu 5,2mm mezi zelenou úsečku a nejbližším bodem. 
 

 
 
 

 
 

 

 

Pravidelně ukládejte (CTRL+S) 
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45. V horní nástrojové liště zapneme funkci  Construction element. 

46. Kliknete na  Hexagon a vytvořte vetší šestiúhelník jako v bodě 39. a 40. 

47. V horní nástrojové liště vypneme funkci  Construction element. 

48. Dvojklikem na  Point vytvoříme šest bodů ve vrcholech druhého šestiúhelníku (viz- obr. vlevo). 

   Vždy se ujistěte, že se zobrazí znak , který Vám zaručí vznik vazby Coincidence/Concentricity.   

 

 

 

49. Klikněte na  Constraint vytvořte kótu 5,2mm mezi hranami šestiúhelníků (viz. obr. vpravo). 
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50.  Pro lepší přehlednost vyberte všechny zobrazené pomocné kružnice a dvě vytvořené kóty a kliknete na            
Hide/Show v dolní nástrojové liště. 

 

 
 

 
 

 

 

51. Dvojklikem na  Intersection Point vytvoříme 12 bodů na druhém šestiúhelníku. 
o Vyberte vždy jako první stranu vnitřního šestiúhelníku (1) a poté hranu vnějšího šestiúhelníku (2), 

s kterou by se po prodloužení protínala. 
o Tento postup jednotlivě opakujete, dokud na každé úsečce druhého šestiúhelníka nevzniknou dva body. 

      
 

Prvky, které jste takto skryli, lze přepnutím do  Swap visible space, označením a 

klikem na  Hide/Show opět zobrazit. 

(1) 

(2) 
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52. V horní nástrojové liště zapneme funkci  Construction element. 

53. Kliknete na  Hexagon a vytvořte vetší šestiúhelník jako v bodě 39. a 40. 

54. Klikněte na  Constraint vytvořte kótu 5,2mm mezi hranami šestiúhelníků. 

55. V horní nástrojové liště vypneme funkci  Construction element. 

56. Dvojklikem na  Point vytvořte šest bodů ve středu hran třetího šestiúhelníku.  

   Vždy se ujistěte, že se zobrazí znak , který Vám zaručí vznik vazby Coincidence/Concentricity.  

57. Dvojklikem na  Intersection Point vytvoříme 12 bodů na třetím šestiúhelníku. 
o Vyberte vždy jako první stranu druhého šestiúhelníku (1) a poté hranu třetího šestiúhelníku (2), s kterou 

by se po prodloužení protínala  

o Tento postup opakujete, dokud na každé úsečce třetího šestiúhelníka nevzniknou dva další body  
 

 
 

58. Režim skicáře ukončíte kliknutím na ikonu  v boční nástrojové liště 
 
 

 

 
 

  

(2) 

(1) 

Pravidelně ukládejte (CTRL+S) 
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Krok č.6 Vytvoření pole děr (User Pattern) 

59. Vyberte díru, kterou jste vytvořili v Kroku č.4. 

60. Klikněte na  User Pattern v boční nástrojové liště. 
61. Jako Positions vyberte skicu vytvořenou v Kroku č. 5 

62. Příkaz ukončete kliknutím na . 
 

   
  

Krok č.7 Vytvoření díry (Hole) 

63. Spusťte příkaz  Hole z boční nástrojové lišty. 
64. Klikněte na rovinnou plochu tělesa. 
 

 
 

65. Přepište Diameter na hodnotu 8mm. 

66. V nabídce vyberte Up To Surface, jako Limit nastavte protilehlou rovinnou plochu. 

67. Klikněte na  Sketch.  

68. Vyberte středový bod a bod středu díry a klikněte na  a vyberte vazbu Coincidence. 

69. Režim skicáře ukončíte kliknutím na ikonu  v boční nástrojové liště 

70. Příkaz ukončete kliknutím na . 

 
 

 
 

 
 

 

 

Protože z předešlé tvorby díry zůstaly nastaveny parametry díry, zobrazí se hlášení Feature Definition Error. Toto 
upozornění potvrdíte.  

Pravidelně ukládejte (CTRL+S) 
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Krok č.8 Vytvoření sražení (Chamfer) 

71. Klikněte na  Chamfer v boční nástrojové liště. 
72. Jako Object(s) to chamfer vyberte hrany, které chcete srazit (viz. obr. vlevo).  

73. Hodnotu Length zadejte 0,5mm. Angle ponechte 45°. Příkaz ukončete kliknutím na . 

74. Jako Object(s) to chamfer vyberte hrany, které chcete srazit (viz. obr. vpravo).  

75. Hodnotu Length zadejte 0,5mm. Angle ponechte 45°.  Příkaz ukončete kliknutím na . 

 

    
 

Krok č.8 Nastavení konečných vlastností 

76. Klikněte na  Apply material ve spodní nástrojové liště. 
77. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

78. V záložkách Knihovny (Library) vyberte Metal a Steel. Příkaz ukončete kliknutím na . 

79. Klikněte na  Measure Inertia ve spodní nástrojové liště. 
80. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

81. Klikněte na  a zaškrtněte pouze Volume, Density a Mass a potvrďte . 

82. Zaškrtněte Keep measure a potvrďte . 

83. Ve stromě vyberte Geometrical Set.1 a klikněte na  Hide/Show. 
 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

Uložte (CTRL+S) 
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2.CVIČENÍ 

CÍL 

Osvojit si základy tvorby komponentů v systému CATIA V5 na ukázkovém příkladu tvorby jednoduché součásti rukojeti 
pro mlýnek na maso. 

 

 

PŘEDPOKLADY 

 Připravená šablona ze cvičení 0. 

 Funkce z předešlého cvičení 1. 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Rotace (Shaft) 
 Díra (Hole) 

 Zaoblení (Edge Fillet) 

 Pomocné prvky 
 Alternativní postupy vytváření rukojeti 

 Multi-Sections Solid 

 Drážka (Groove) 
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Krok č.1 Vytvořit novou součást 

1. V nástrojové liště klikněte na tlačítko . 

2. Otevřete si šablonu z předešlého cvičení.  
3. V nabídce File vyberte Save As. 

4. Vyberte složku pro uložení součásti. 
5. Jako File name zadejte 02_RUKOJET 

6. Potvrďte tlačítkem . 

 
 

 
 

Krok č.2 Tvorba rukojeti 

7. Klikněte na ikonu rotace Shaft v boční nástrojové liště.   

 Nejprve vytvoříme skicu (sketch). 

8. Začneme kliknutím na  . 
9. Vyberte rovinu (např. Nárys) klepnutím levým tlačítkem myši v hlavním 

okně nebo ve stromě. 

 Na této rovině bude ležet skica (sketch), kterou vytvoříme. 

10. Vybráním plochy se automaticky přepnete do skicáře (sketcher). 

 

 

 
 

 
 

 

 
 

 
 

11. Klikněte na  Spline v boční nástrojové liště. 

12. Vytvořte spline křivku o 6 bodech. 

 Ukončení příkazu Spline dvojklikem u posledního bodu při zobrazení ikony “zákaz vjezdu“ nebo klávesa Esc. 

 

 
 

V názvech souborů nepoužívejte diakritiku ani speciální znaky. 
Potřebujete-li v názvu souboru mít mezeru, použijte podtržítko “_“. 
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13. Pomocí  Line z boční nástrojové liště vytvořte dvě čáry vedoucí z koncových bodů k ose rotace. 
14. Při tvorbě čar vždy počkejte dokud tvořená čára nezmodrá, vytvoří se tak automaticky vertikální vazba. Vazbu lze 

přidat vybráním čáry, klikem na   Constraint Box v horní nástrojové liště a zaškrtnutím Vertical. 
 

 
 

   Vždy se ujistěte, že se zobrazí znak , který Vám zaručí vznik vazby Coincidence/Concentricity.  

15. Klikněte na  Axis a vytvořte osu rotace spojením koncových bodů úseček. 

16. Klikněte na   Constraint  v horní nástrojové liště. Vyberte koncový bod křivky a vytvořenou osu rotace, 
klikněte na pravé tlačítko myši a vyberte Radius/Diameter. Kóta se změní na kótu průměrovou. 

17. Přepiště hodnotu kóty na průměr 20mm. 
 

    
 

 
 

 

 
 

 
 

 

 
 

 

Pravidelně ukládejte (CTRL+S) 

 

Pokud znáte hodnoty průměrů kót a nechcete překlikávat všechny kóty. Lze do hodnoty zapsat: 
 “hodnotu koty průměru / 2“. Program automaticky vypočte hodnotu.  
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18. Dvojklikem na  Constraint v horní nástrojové liště okótujte skicu dle obrázku. 

 
 

19. Označte úsečkou a vertikální osou vytvořte vazbu Coincidence klikem na   Constraint Box 

20. Režim skicáře ukončíte kliknutím na ikonu  v boční nástrojové liště. 
 

 

21. V nabídce Shaft Definition nastavte: First angle 0deg, Second angle 360deg. Osa rotace se automaticky vybrala 
z vytvořené skici. Pokud se tak nestalo vyberte osu rotace. 

22. Příkaz ukončete kliknutím na . 

 
 

 

 

Ukončení příkazu kotování proveďte přes opětovné kliknutí na  Constraint.  

 

Přes tlačítko  se lze podívat na tvar při aktuálním nastavení.  
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  Krok č.3 Tvorba díry (Hole) 

23. Klikněte na  Hole v boční nástrojové liště. 

24. Klikněte na rovinou plochu součásti. 

25. Klikněte na  Sketch.  

26. Vyberte bod a Nulový bod ve stromě, klikněte na  Constraints Box a vložte vazbu Coincidence. 

27. Režim skicáře ukončete kliknutím na ikonu  v boční nástrojové liště. 
28. V nabídce vyberte Up To Next, hodnotu průměru 6mm. 

29. Příkaz ukončete kliknutím na . 
 

 

  Krok č.4 Tvorba zaoblení (Edge Fillet) 

30. Klikněte na  Edge Fillet v boční nástrojové liště. 

31. Vyberte hrany, které chcete zaoblit (viz. obr.). 
32. Hodnotu Radiusu zadejte 1mm. 

33. Příkaz ukončete kliknutím na . 

 
 

 

 
 

 

Přes tlačítko  se lze podívat na tvar při aktuálním nastavení.  
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Krok č.5 Tvorba sražení (Chamfer) 

34. Klikněte na  Chamfer v boční nástrojové liště. 
35. Vyberte hrany, které chcete zkosit (viz. obr.). 

 
 

36. Hodnotu Lenght zadejte 1mm, Angle: 45deg. 

37. Příkaz ukončete kliknutím na . 
 

 

 

 

Krok č.8 Nastavení konečných vlastností 

38. Klikněte na  Apply material ve spodní nástrojové liště. 

39. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

40. V záložkách Knihovny (Library) vyberte Wood a zde Dark Oak. Příkaz ukončete kliknutím na . 

41. Klikněte na  Measure Inertia ve spodní nástrojové liště. 

42. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

43. Klikněte na  a zaškrtněte pouze Volume, Density a Mass a potvrďte . 

44. Zaškrtněte Keep measure a potvrďte . 

45. Ve stromě vyberte Geometrical Set.1 a klikněte na  Hide/Show. 

 
 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 
 

 

Pravidelně ukládejte (CTRL+S) 

 

Pokud Vám dělá problém vybrat hranu, klikněte na  Curve Filter v horní nástrojové liště.  

Přes tlačítko  se lze podívat na tvar při aktuálním nastavení.  
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ALTERNATINVNÍ ZPŮSOB TVORBY RUKOJETI 

Krok č.1 Tvorba rukojeti 

46. Klikněte na  Sketch a vložte ho na rovinu Bokorys. 

47. Klikněte na  Circle a vytvořte kružnici s počátkem v středu souřadnic a o průměru 40mm. 

48. Režim skicáře ukončíte kliknutím na ikonu  v boční nástrojové liště. 

Nastavte hodnotu Lenght 73mm a příkaz ukončete kliknutím na . 

49. Klikněte na  Sketch a vložte ho na rovinu Nárys. 

50. Klikněte na  Intersect 3D Elements a klikněte na rovinu Bokorysu. 

51. Klikněte na  Spline a vytvořte křivku o šesti bodech začínající na promítnuté hraně. 

52. Klikněte na  Axis a vytvořte horizontální osu rotace s počátkem v středu souřadnic 

53. Dvojklikem na  Constraint zakotujte skicu dle obrázku. 

54. Klikněte na  Quick Trim a ořežte přesahující část promítnuté hrany. 

55. Režim skicáře ukončíte kliknutím na ikonu  v boční nástrojové liště. 
 

 

56. Klikněte na  Groove v boční nástrojové liště. 

57. Vyberte vytvořenou skicu, First angle 360deg, Second Angle: 0deg. A potvrďte . 
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ALTERNATINVNÍ ZPŮSOB TVORBY RUKOJETI 

Krok č.1 Tvorba pomocných rovin 

58. Ve stromě prvků označte Part. 

59. Vyberte nabídku Insert -> Geomitrical Set… 
60. V nabídce napište Name: Pomocné prvky. A za Father vyberte 

Geometrical Set.1 

61. Nabídku ukončete kliknutím na .  

 

 

 
 

62. Klikněte na  Plane v boční nástrojové liště. 
63. Vyberte rovinu Bokorys. Hodnotu Offset zadejte 6mm. 

64. Nastavte směr offsetu klikem na  a potvrďte . 

65. Toto opakujte dokud nevytvoříte 4 další roviny o vzdálenosti 17mm, 45mm, 58.4m, 73mm  od Bokorysu 
 

 

Krok č.6 Tvorba rukojeti 

66. Klikněte pravým tlačítkem na PartBody ve stromě prvků a vyberte Define In work Object. 

67. Klikněte na  Sketch a vložte ho na rovinu Bokorys. 

68. Klikněte na  Circle a vytvořte kružnici s počátkem v středu souřadnic.  

69. Klikněte na  Constraint zakotujte kružnici průměr 20mm. 

70. Režim skicáře ukončíte kliknutím na ikonu  v boční nástrojové liště. 

71. Toto opakujte na každé rovině přičemž 
o první pomocná plocha – průměr 25mm 

o první pomocná plocha – průměr 17,7mm 
o první pomocná plocha – průměr 31mm 

o první pomocná plocha – průměr 26,5mm 
o první pomocná plocha – průměr 13mm 

 

Ve stromě prvků zkontrolujte zda položka “Pomocné prvky“ je podtržena. Toto značí, 
že tvořené prvky budou spadat do této položky. Pokud položka není podtržena 
klikněte na ní pravým tlačítkem a vybert Define In Work Object. 
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72. Klikněte na  Multi-Sections Solid v boční nástrojové nabídce. 

73. Vyberte postupně v jednom směru vytvořené skici.  
74. Zkontrolujte, zda u každé skici směřuje šipka od Closing Point na stejnou stranu. Případně klikem na šipku 

změníte její směr.  

75. Příkaz ukončete kliknutím na . 
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3.CVIČENÍ 

CÍL 

Procvičení základních typů prvků pro modelování součástí, ukázka práce ve skicáři, vytváření skic, kót a geometrických 
vazeb, vysvětlení funkce a použití příkazu Family Table, vytváření závitu na vnější válcové ploše.  To vše na 

ukázkovém příkladu tvorby šroubu u mlýnku na maso. 
  

 

PŘEDPOKLADY 

 Připravená šablona ze cvičení 0. 

 Základy Swept Blend z předchozího cvičení 

 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Rotace (Revolve) 
 Protažení (Extrude) 

 Tažení s proměnnými průřezy (Variable Section Sweep) 
 Swept Blend 

 Závit (Cosmetic Thread) 

 Family table 
 Vytváření a kótování skic 

 Funkce Potlačení (Suppress) 
 Seskupení prvků (Group) 
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Krok č.1 Vytvoření nové součásti 

1. V nástrojové liště klikněte na tlačítko . 

2. Otevřete si šablonu z předešlého cvičení.  

3. V nabídce File vybereme Save As. 
4. Vyberte složku pro uložení součásti. 

5. Jako File name zadáme 03_SROUB 
6. Potvrďte tlačítkem . 

 
 

 

 

Krok č.2 Tvorba profilové skici pro prvek (Rib) 

7. Klikněte na  Sketch v boční nástrojové liště. Jako poloho vyberte rovinu Bokorys. 

8. Klikněte na  Elipse v boční nástrojové liště. A vytvořte elipsu s počátkem v středu souřadnic. 

9. Označte elipsu, klikněte na  Constraint defined a vyberte vertikální vazbu. 

10. Klikněte na  Constraint a zakotujte elipsu, hodnota 10,2mm. 

11.   Klikněte na  Constraint a zakotujte elipsu. Vytvoří se totožná kóta, proto klikněte na pravé tlačítko myši a 
vyberte Semiminor Axis, hodnota 7,5mm. 

12.  Režim skicáře ukončete kliknutím na ikonu  v boční nástrojové liště 
 

   
 
 

 
 

 

 
 

 
 

 

 
 

 
 

 

 
 

 

V názvech souborů nepoužívejte diakritiku ani speciální znaky. 
Potřebujete-li v názvu souboru mít mezeru, použijte podtržítko “_“. 

 

Pravidelně ukládejte (CTRL+S) 
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Krok č.3 Tvorba vodící skici pro prvek (Rib) 

13. Klikněte na  Sketch v boční nástrojové liště. Jako poloho vyberte rovinu Nárys. 

14. Klikněte na  Profile v boční nástrojové liště a vytvořte skicu viz. obr. 

 Na obrázku je vidět, že při tvorbě jsme využili automatické tvorby vazeb přichycením k jedné z os. Pokud byste takto 

neučinili, lze vazby dodat přes  Constraint defined. 

 

15. Klikněte n  Corner v boční nástrojové liště. Vybráním dvou sousedícíc úseček vytvoříte rádius. Po potvrzení se 

nám automaticky vytvoří kóta. Tu přepíšeme na hodnotu 6mm. 
16. Toto zaoblení zopakujeme i na druhém ostrém rohu, zde vytvořenou kotu smažte. 

  

    

17. Označte vytvořené rádiusy a osu. V pořadí rádius, rádius, osa. 

 
 

18. Klikněte na  Constraint defined a vložte vazbu symmetry. 

 

 

Vícenásobné označení provedete přidržením klávesy Ctrl. 
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19.  Klikněte na  Constraint a vytvořte kóty dle obrázku. 

20. Režim skicáře ukončíte kliknutím na ikonu  v boční nástrojové liště 
 

 

Krok č.4 Tvorba prvku Rib 

21. Klikněte na  Rib v boční nástrojové liště. 
22. Jako Profile vyberte skicu vytvořenou v Krok č.2. 
23. Jako Centre curve vyberte skicu vytvořenou v Krok č.3. 

24. Ukončete příkaz kliknutím na . 

 

 
 

 
 

 

Skici lze vybírat v hlavním okně, nebo ve stromě příkazů. 

Před potvrzením nabídky se lze podívat na výsledek nastavení pomocí tlačítka . 
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Krok č.5 Tvorba prvku Pad 

25. Klikněte na  Pad v boční nástrojové liště. 

26. Klikněte na  Sketch v nabídce, a vložte skicu na Půdorys. 

27. Klikněte na  Circle a vytvořte kružnici o průměru 10mm s počátkem v středu souřadnic. 

28. Režim skicáře ukončete kliknutím na ikonu  v boční nástrojové liště 

29. V nabídce Pad Definition klikněte na . 

30. V First Limit -> Length zadejte 92mm. 

31. V Second Limit -> Length zadejte -42mm. 

32. Ukončete příkaz kliknutím na . 

 

 
 

 
 

 

Záporná hodnota druhé délky je udávaná záměrně. Díky záporu dochází k tvorbě kóty ve stejném kvadrantu jako kóty 
první. Pokud by jste tak neučinili vytvořila by se kóta na opačnou stranu. 
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Krok č.6 Tvorba prvku Multi-Pad 

33. Klikněte na  Sketch v nabídce, a vložte skicu na horní plochu vytvořeného prvku v předešlém kroku. 

34. Klikněte na  Circle a vytvořte dvě kružnice o průměru 2mm a 5mm, s počátkem v středu souřadnic. 

35. Režim skicáře ukončete kliknutím na ikonu  v boční nástrojové liště 

36. Klikněte na  Multi-Pad v boční nástrojové liště a vybete vytvořenou skicu. 

37. V nabídce Domains vyberte řádek tak, aby zmodrala pouze vnitřní kružnice. Pro tento výběr nastavte hodnotu 

Length 4mm. 

 
 

 

 
 

38. Nyní vyberte druhou položku v Domains zadejte Length 7mm. 

 

 
 
 
 

39. Ukončete příkaz kliknutím na . 

Pokud byste se podívali přes , výsledek prozatímního nastavení by bylo vysunutí profilu vnitřní kružnice do 
nastavené výšky 4mm. 

Hodnota 7mm je vzdálenost vysunutí od polohy skici. 
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Krok č.7 Tvorba vodící skici pro Multi-sections Solid 

40. Klikněte na  Sketch v nabídce, a vložte skicu na rovinu Nárys. 

41. V horní nástrojové liště zapneme funkci  Construction element. 

42. Klikněte na   Project 3D Element. A promítněte si pomocné hrany 
(viz. obr. vpravo). 

43. V horní nástrojové liště vypněte funkci  Construction element. 

 
 

 
 

 

 

   Vždy se ujistěte, že se zobrazí znak , který Vám zaručí vznik vazby Coincidence/Concentricity. 

44. Klikněte na  Line a vytvořte vertikální úsečku začínají ve středu promítnuté horní čáry. (viz. obr. vlevo). 

45. Klikněte na   Tree Point Arc Starting With Limits a vytvořte oblouk. (viz. obr. vpravo). 

o Vyberte koncový bod úsečky 
o Vyberte střed promítnuté hrany 

o Vytvořte třetí bod tak, aby vynikla tečné vazba mezi čárou a obloukem. 

 

    
 

46. V horní nástrojové liště zapneme funkci  Construction element. 

47. Klikněte na  Line a vytvořte úsečku začínají ve středu promítnuté 

dolní čáry. 

48. Mezi úsečku a oblouk vložte pomocí   Constraint defined tangentní 

vazbu. 

49. Mezi úsečku a promítnutou hranu vložte pomocí   Constraint 

defined vazbu Perpendicular. 

50. V horní nástrojové liště vypněte funkci  Construction element. 

51. Klikněte na  Point a vytvořte dva body viz. obr. 

52. Režim skicáře ukončete kliknutím na ikonu  v boční nástrojové liště 
 
 

 
 

 

 
(48) 

(48) 

(49) 

(49) 

(48) 
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Krok č.8 Tvorba prvku Multi-sections Solid 

53. Klikněte na  Multi-section Solid v boční nástrojové liště. 
54. Vyberte konečnou plochu taženého profilu. Hned poté vyberte obvodovou plochu. Na tuto plochu bude prvek tečně 

navazovat. (viz. obr. vlevo). 
55. Pravým tlačítkem myši klikněte na Closing Point1, vyberte replace a vyberte bod ležící na hraně profilu. 

(viz. obr. vpravo). 

 

    
 

56. Klikněte na . 

57. Vyberte spodní plochu vysunutí. (viz. obr. vlevo). 

58. Pravým tlačítkem klikněte na Boundary.2, vyberte Replace Tangent a vyberte plochu, na kterou bude profil tečně 
navazovat 

59. Pravým tlačítkem myši klikněte na Closing Point2, vyberte replace a vyberte bod ležící na hraně profilu. 
(viz. obr. vpravo). 

 

  
 
60. Zkontolujte zda šipky jdoucí od Closing Point jsou orientovány stejným směrem. Pokud ne, klikem na šipku změníte 

směr orientace. 
 

 

 
 

 

Bod 

První výběr 

Druhý výběr 

První výběr 

Druhý výběr 

Bod 
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61. Překlikněte na záložku Spine a vyberte skicu vytvořenou v Kroku č.4 

62. Klikem na  zkontrolujte nastavení. 

63. Ukončete příkaz klikem na . 

 

Krok č.9 Tvorba závitu 

64. Klikněte na  Thread z boční nástrojové lišty. 
65. Vyberte válcovou plochu prvku Pad. 

66. Jako Limit Face vyberte horní plochu prvku Pad. 
67. V nabídce Type vyberte Metric Thin Pitch. Automaticky se určí M10x1 

68. Délku závitu (Thread Depth) nastavte 45mm. 

69. Ukončete příkaz klikem na . 

 

 

Krok č.10 Zaoblení 

70. Vztvořte zaoblení R=0,5mm dle obrázku. 
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Krok č.11 Tvorba roznýtování 

71. Klikněte na  Split z boční nástrojové lišty. 

72. Vyberte vnitřní plochu Multi-Padu. Směr šipky změnte k části kterou chcete nechat. 

73. Ukončete příkaz klikem na . 

 

 

74. Klikněte na  Plane z boční nástrojové lišty. 
75. Vyberte právě uříznutou plochu, nastavte Offset 3mm a zkontrolujte, že se plocha tvoří nad tuto plochu. 

76. Ukončete příkaz klikem na . 

77. Přejmenujte tuto plochu na ROV_STOLU. 
 

 

78. Klikněte na nabídku  Sketch a umístěte skicu na rovinu Nárysu. 

79. V horní nástrojové liště zapněte funkci  Construction element. 

80. Vyberte   Project 3D Element z boční nástrojové lišty a promítněte horní hranu. 

81. Vyberte   Intersect 3D Element  z boční nástrojové lišty a vyberte pomocnou rovinu z předešlého kroku. 

82. V horní nástrojové liště vypněte funkci  Construction element. 
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83. Klilkněte na  Profile a vytvořte profil dle obrázku. 

 

 
 

 

84. Klikněte na  Constraint z horní nástrojové lišty a vytvořte kóty dle obrázku. 

85. Režim skicáře ukončete kliknutím na ikonu  v boční nástrojové liště 
 

 

86. Vyberte osu rotace (Osa Z)  

87. Ukončete příkaz klikem na . 

 

 

Pokud se soustředíme na tvorbu profilu, lze si ušetřit čas následným přidáváním vazeb přes  Constraint defined. 
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Krok č.12 Deaktivace prvků 

88. Klikněte na prvek Split.1 pravým tlačítkem myši. 

89. Vyberte Split.1 Object -> Deactivate. 

90. V nabídce zaškrtněte Deactivate all children a potvrďtě . 

 

 
 

   

Krok č.13 Nastavení konečných vlastností 

91. Klikněte na  Apply material ve spodní nástrojové liště. 

92. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

93. V záložkách Knihovny (Library) vyberte Metal a Steel. Příkaz ukončete kliknutím na . 

94. Klikněte na  Measure Inertia ve spodní nástrojové liště. 

95. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

96. Klikněte na  a zaškrtněte pouze Volume, Density a Mass a potvrďte . 

97. Zaškrtněte Keep measure a potvrďte . 

98. Ve stromě vyberte Geometrical Set.1 a klikněte na  Hide/Show. 

 

 
 

 

 
 

 
 

 

 
 

Tímto vypneme prvky, které budeme používat pouze při tvorbě výkresu. 

Uložte (CTRL+S) 
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4.CVIČENÍ  

CÍL 

Jednoduchý příklad tvorby sestavy (svařence). Tvorba konstrukčních vazeb v sestavě. Zopakování jednoduchých 
funkcí rotace, zaoblení, sražení, závit …  

 

PŘEDPOKLADY 

 Připravená šablona ze cvičení 0. 

 Základy skicování a vytváření geometrických vazeb z 1-3. cvičení 

 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Vytvoření sestavy, tvoření vazeb 
 Modul Svařování (Welding) 

 Rotace (Shaft) 

 Tažení (Rib) 
 Zaoblení (Edge Fillet) 

 Sražení hran (Chamfer) 
 Závit (Thread) 

 Multi-section Solid 

 Manipulation 
 Kopírování skici a změna polohy 
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Krok č.1 Vytvoření nové součásti těla šroubu kliky 

1. V nástrojové liště klikněte na tlačítko . 
2. Otevřete si šablonu z předešlého cvičení.  

3. V nabídce File vyberte Save As. 
4. Vyberte složku pro uložení součásti. 

5. Jako File name zadejte 04_CEP 
6. Potvrďte tlačítkem . 

 

 
 

 

Krok č.2 Rotace hlavy šroubu (Revolve) 

7. Klikněte na  Shaft, klikněte na  Sketch a umístěte skicu na 
rovinu nárys. 

8. Klikněte na  Axis a vytvořte osu dle obrázku. 

9. Klikněte na  Profile vytvořte skicu dle obrázku. 

10. Pomocí  Line vytvořte konstukční horizontální úsečku. 

11. Pomocí  Constraint defined vytvořte vazby dle obrázku.  
 

 
 

 

12. Dvojklikem na  Constraint v horní nástrojové liště okótujte profil dle obrázku. 

13. Režim skicáře ukončíte kliknutím na ikonu  v boční nástrojové liště. 
 

 

V názvech souborů nepoužívejte diakritiku ani speciální znaky. 
Potřebujete-li v názvu souboru mít mezeru, použijte podtržítko “_“. 

 

Nezapomeňte, že konstrukční (pomocná) čára musí být 

čárkovaná, neboli prvek typu  Construction element. 
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14.  Zkontrolujte správné nastavení úhlů. 

15.  Přes klávesu  se podívejte na řešení a následně potrďte . 

 

 

Krok č.3 Tvorba závitu 

16. Klikněte na  Thread a vytvořte závit M6 na válcové ploše o délce 13mm. 

17. Potvrďte provedení příkazu . 

 

 
 

 
 

 

Pravidelně ukládejte (CTRL+S) 
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Krok č.4 Tvorba zaoblení 

18. Klikněte na  Edge Fillet a zaoblete dle obrázku. 
 

    
 

Krok č.5 Tvorba zaoblení 

19. Klikněte na  Champer a vytvořte zkosení dle obrázku. 

 

 

Krok č.6 Nastavení konečných vlastností 

20. Klikněte na  Apply material ve spodní nástrojové liště. 
21. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

22. V záložkách Knihovny (Library) vyberte Metal a Steel. Příkaz ukončete kliknutím na . 

23. Klikněte na  Measure Inertia ve spodní nástrojové liště. 
24. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

25. Klikněte na  a zaškrtněte pouze Volume, Density a Mass a potvrďte . 

26. Zaškrtněte Keep measure a potvrďte . 

27. Ve stromě vyberte Geometrical Set.1 a klikněte na  Hide/Show. 

 
 

 
 

 

Uložte (CTRL+S) 
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Krok č.7 Vytvoření nové součásti oka šroubu kliky 

28. V nástrojové liště klikněte na tlačítko . 
29. Otevřete si šablonu z předešlého cvičení.  

30. V nabídce File vyberte Save As. 

31. Vyberte složku pro uložení součásti. 
32. Jako File name zadejte 04_OKO 

33. Potvrďte tlačítkem . 
 

 
 

 

Krok č.8 Tvorba vodící skici pro prvek Rib 

34. Klikněte na  Sketch a umístěte skicu na rovinu Nárys. 

35. Klikněte na  Elipse a vytvořte elipsu s počátkem ve středu souřdnic.   

36. Zakótujte  a vytořte vazby  dle obrázku. 

 

 

37. V horní nástrojové liště zapněte funkci  Construction element. 

38. Vytvořte tři konstrukční úsečky  Profile dle obrázku. 

39. Zakótujte  a vytořte vazby  dle obrázku. 
 

 
 

V názvech souborů nepoužívejte diakritiku ani speciální znaky. 
Potřebujete-li v názvu souboru mít mezeru, použijte podtržítko “_“. 
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40. Klikněte na  Quick Trim a ořežte elipsu dle obrázku 

41. Režim skicáře ukončíte kliknutím na ikonu  v boční nástrojové liště. 
 

 
 
 

 

Krok č.9 Tvorba profilové skici pro prvek Rib 

42. Klikněte na  Sketch a umístěte skicu na rovinu Bokorys. 

43. Klikněte na   Intersect 3D Element a vyberte skicu z předešlého kroku, 
vytvoří se takto bod. 

44. Klikněte na   Circle a vytvořte kružnici o průměru 3mm s počátkem v 
bodě.   

45. Z vytvořených bodu udělejte konstrukční prvek. Vyberte a klikněte na   
Construction element. 

46. Režim skicáře ukončíte kliknutím na ikonu  v boční nástrojové liště. 
 

Krok č.10 Tvorba oka (Rib) 

47. Klikněte na  Rib. 

o Jako Profil nastavte skicu kružnice 

o Jako Center Curve skicu elipsy 
 

 

Pravidelně ukládejte (CTRL+S) 
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Krok č.11 Nastavení konečných vlastností 

48. Klikněte na  Apply material ve spodní nástrojové liště. 
49. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

50. V záložkách Knihovny (Library) vyberte Metal a Steel. Příkaz ukončete kliknutím na . 

51. Klikněte na  Measure Inertia ve spodní nástrojové liště. 
52. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

53. Klikněte na  a zaškrtněte pouze Volume, Density a Mass a potvrďte . 

54. Zaškrtněte Keep measure a potvrďte . 

55. Ve stromě vyberte Geometrical Set. 1 a klikněte na  Hide/Show. 
 
 

 

 

Krok č. 12 Založení a uložení svařence 

56. Vyberte Start -> Mechanical Design -> Weld Design 

57. V nabídce File vyberte Save As. 

58. Vyberte složku pro uložení součásti. 
59. Jako File name zadejte 04_SROUB_KLIKA 

60. Potvrďte tlačítkem . 
 

 
 

 

 

Uložte (CTRL+S) 
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Krok č. 13 Vložení prvků 

61. Vložení prvku probíhá přes nabídku Insert -> Existing 

Component…  
62. Poté co kliknete na Existing Component, vyberte ve stromě prvků 

Product.1.  

63. V File selection vyberte 04_CEP. 
64. Nyní vložte 04_OKO úplně stejným způsobem. 

65. Zobrazí se Vám okno Part number conflicts. Zde vždy označte 

položku a klikněte na . 

66. Poté ukončete okno . 

 

        

Krok č.14 Tvorba vazby 

67. Rozklikněte si strom prvků tak, abyste viděli roviny Nárys, Bokorys, Půdorys u obou vložených prvků. 
 

 
 

   Tvorba pevné vazby (součást nejde v žádném směru posunout ani pootočit). 

68. Klikněte na  Fix a vyberte čep.  

   Tvorba offsetové vazby (lze nastavit vzdálenost dvou rovin). 

69. Klikněte na   Offset Constraint a ve stromě prvků vyberte obě roviny Půdorysu. 

70. V nabídce Constraint Properties nastavte hodnotu Offset: 25mm, Orientation: Same a potvrďte . 

 

  

Pokud se soustředíme na tvorbu profilu, lze si ušetřit čas následným přidáváním vazeb přes  Constraint defined. 
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71.  Po potvrzení nabídky prvky zůstanou v původní poloze, pouze přibude kóta 25, značka offsetové vazby 25mm 

(viz. obr. vlevo).  

72. Proto klikněte na  Update v dolní nástrojové liště. Prvky a vazby se zaktualizují. (viz. obr. vpravo). 

 

           

73. Klikněte, ve stromě, pravým tlačítkem na  Part a v záložce Product přepište Instace name na CEP či OKO, 
podle toho, jaká součást zoranžoví v okně. (proveďte pro obě součásti). 

74. Po aktualizaci se zdá, že prvky jsou ve správné poloze a dostatečně zavazbené, proto klikněte na  

Analyze -> Constraints… v horních nabídkách. Zde vidíte informace o vazbách.  
75. Klikněte na záložku Degrees of freedom. Zde vidíte, že součást OKO má 3 stupně volnosti = není plně 

zavazbená. 

76. Analýzu ukončete . 

 

 
 
 

 

 
 

Pravidelně ukládejte (CTRL+S) 
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   Názorné zjištění stupňů volnosti  

77. Klikněte na   Manipulation v boční nástrojové liště. 

78. Zaškrtněte With respect to constraints. Nyní pokud vyberete směr pohybu či rotace, můžete součástí 

uchopením pohybovat či otáčet, pokud není plně zavazbená.  
Např. 

o Pohyb v ose X (viz. obr. vlevo nahoře). 

o Pohyb v ose Y (viz. obr. vpravo nahoře). 
o Rotace v ose Z (viz. obr. vlevo dole). 

o Rotace kolem své osy (viz. obr. vpravo dole). 
 

   
 

    
 

79. Příkaz ukončete . 

 
 

 
 

 

 
 

 

Po ukončení příkazu zůstane součást v pozici, do jaké jsme ji nastavili. A také ikona pro Update je neaktivní . 

Důvodem je, že náš pohyb součástí je v souladu s vazbami. Pokud byste odškrtli With respekt to constraints, 

můžete se součástí volně pohybovat s ignorováním vazeb. Po takém to pohybu se ikona Update zaktivuje  a klikem 
na ni se opět zaktualizují vazby. 
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   Plné zavazbení součástí.  

80. Klikněte na  Coicidence Constraint a vyberte roviny Nárysu. A potvrďte . 
 

 
 

81.  Klikněte na  Coicidence Constraint a vyberte roviny Bokorysu. A potvrďte . 

 

 

82. Proveďte aktualizaci pomocí  Update v spodní nástrojové liště. 
83. Zkontrolujte pomocí Analyze -> Constraints… počet stupňů volnosti. Pokud není záložka  Degrees of freedom, 

součásti by měli být plně zavazbené. 

                                                           
 

84. Ve stromě prvků vyberte Constraint a klikněte na  Hide/Show. Po lepší přehlednost dále. 
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Krok č.15 Tvorba uživatelem definovaného svaru 

85. V nabídkách vyberte Insert -> New Part a ve stromě klikněte na Product1. 

86. V okně New Part: Origin Point klikněte na . 

87. V stromě prvků vyberte vzniklý  Part a pravým tlačítkem (Alt-Enter) vyberte Properties.  

88. Přepište Instance name a Part Number: SVAR a potvrďte . 

89. Dvojklikem na název Part nebo pravým tlačítkem Part3 object - > Edit přepněte do modulu modeláře. 

90. Zaktivujte si PartBody (Pravým tlačítkem a vyberte Define In Work Object). 

91. Klikněte na  Sketch a umístěte ho na rovinnou plochu oka (viz. obr. vlevo) 

92. Klikněte na   Cut Part By Sketch Plane pro zobrazení součásti v řezu (viz. obr. vpravo) 

93. Klikněte na   Normal View pro kolmé natočení pohledu na skicu (viz. obr. vpravo)  

 

                   

94. Klikněte na  Project 3D Element a promítněte hranu oka dle obrázku. 

95. Klikněte na  Profile a vytvořte profil dle obrázku. 
 

 
 

96. Klikněte na  Constraint a vytvořte kóty dle obrázku. 

97. Klikněte na  Quick Trim a ořežte kružnici dle obrázku. 

98. Režim skicáře ukončete kliknutím na ikonu . 

 

 

Pokud se soustředíme na tvorbu profilu, lze si ušetřit čas následným přidáváním vazeb přes  Constraint defined. 

4 - 12



99. Označte vytvořenou skicu a zkopírujte jí Ctrl+C.  

100. V nabídkách vyberte Edit -> Paste Special… Vyberte As Result With Link a potvrďte . 

101. Klikněte pravým tlačítkem myši na vloženou skicu v Sketch.X object -> Change Sketch Support… 
102. Vyberte Positioned. Jako Reference vyberte opačnou rovinnou plochu oka. 

103. V části Origin vyberte Part origin. 

104. Zaškrtněte Reverse H a potvrďte . 

 

 
 

 

 

105. Klikněte na  Multi-sections Solid a vyberte obě skici a potvrďte . 

 

 

106. Klikněte dvakrát na Product1 ve stromě příkazů. Přepnete se takto do modulu pro svařence. 

 
 

 

Pokud zeditujete nějako kótu v první skice, druhá skica se automaticky změní taktéž. 

Přepnutí lze provést: pravé tlačítko myši na Product1 a zde vybrat Product1 object -> Edit 
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107. Klikněte na  User Weld v boční nástrojové liště. 
108. Jako Weld Name napište SVAR. Za Weld Bead vyberte vytvořený tvar. 

109. Do kolonky Welded Parts vyberte OKO a CEP. Body Name přepište jako SVARENEC a potvrďte . 

 

 

Krok č.16 Nastavení konečných vlastností   

1. Klikněte na  Apply material ve spodní nástrojové liště. 
2. Ve stromě vyberte položku Product1, aby se vybrala celá součást. 

3. V záložkách Knihovny (Library) vyberte Metal a Steel. Příkaz ukončete kliknutím na . 

4. Klikněte na  Measure Inertia ve spodní nástrojové liště. 

5. Ve stromě vyberte položku Product1, aby se vybrala celá součást. 

6. Klikněte na  a zaškrtněte pouze Volume, Density a Mass a potvrďte . 

7. Zaškrtněte Keep measure a potvrďte . 

 

 
 

 

Uložte (CTRL+S) 
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5.CVIČENÍ 

CÍL 

Vytvoření součásti nože do sestavy mlýnku na maso s použitím probraných příkazů a nově probraných prvků Boundary 

Blend a Draft. 
  

 

PŘEDPOKLADY 

 Připravená šablona ze cvičení 0. 

 Základy modelování z předchozích cvičení. 

NOVĚ PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Zkosení (Draft Angle) 

 Kruhové pole (CircularPattern)  

 Fill (modul plochy)  
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Krok č.1 Vytvoření nové součásti 

 

1. V nástrojové liště klikněte na tlačítko . 
2. Otevřete si šablonu z předešlého cvičení.  

3. V nabídce File vybereme Save As. 
4. Vyberte složku pro uložení součásti. 

5. Jako File name zadáme 05_NUZ 

6. Potvrďte tlačítkem . 
 

 
 

 

 
 

 
 

 

 

Krok č.2 Tvora základního těla  

7. Klikněte na  Pad a vytvořte kvádr dle obrázku.  

8. Skicu položte na rovinu Půdorys. A vytvořte pomocí  Retangle 

čtverec dle obrázku. Zakótujte pomocí  a vytvořte vazby pomocí . 

9. Výšku vysunutí nastavte 8mm nad rovinu Půdorys a 1mm pod rovinu. 

10. Příkaz potvrďte  

 

 
 

 

 
 

 

 
 
 

 
 

 

 
 

Pravidelně ukládejte (CTRL+S) 

 

V názvech souborů nepoužívejte diakritiku ani speciální znaky. 
Potřebujete-li v názvu souboru mít mezeru, použijte podtržítko “_“. 
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Krok č.3 Zkosení boků kvádru. 

11. Klikněte na  Draft Angle. 

12. Vyberte 4 plochy po obvodě (viz. obr. vlevo). 
13. Jako Neutral Element vyberte horní plochu kvádru (viz. obr. vpravo). 

 

    
 

14. Nastavte Angle: 10 stupňů a klikněte na Preview. Zobrazené plochy by se měli rozšiřovat směrem od horní 

plochy dolu. Pokud tak tomu není, změňte směr klikem na šipku. 

15. Nyní nastavte Angle na 1,5 stupňů a potvrďte  

 

 
 
 

 
 

 

 
 

 
 

 

 
 

 
 

Pravidelně ukládejte (CTRL+S) 
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Krok č.4 Vytvoření pomocných rovin 

16. Klikněte na  Plane. 

17. V nabídce vyberte Through two line, vyberte dvě hrany dle obrázku. 

18. Nabídku potvrďte . 
 

 
 

19. Klikněte na  Plane. 

20. V nabídce vyberte Offset from plane, vyberte vytvořenou rovinu. 

21. Hodnotu Offset nastavte na 22mm, nastavte směr vysunutí a potvrďte .  

 

 

22. Klikněte na  Plane. 

23. V nabídce vyberte Offset from plane, vyberte rovinu Půdorys. 

24. Hodnotu Offset nastavte na 0,5mm, nastavte směr vysunutí (směr dolu) a potvrďte .  

25. Tuto rovinu si prozatím skryjte pomocí  Hide/Show. 
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Krok č.5 Vytvoření profilových skic pro Multi-section Solid 

26. Klikněte na  Sketch a vložte skicu na první pomocnou plochu 

 
 

 

27. Pomocí  Profile vytvořte skicu dle obrázku. 

28. Zakótujte pomocí  a vytvořte vazby pomocí  dle obrázku. 

29. Skicář ukončete pomocí . 
 

 
 

30. Označte vytvořenou skicu. A stiskněte Ctrl+C a poté Ctrl+V. 

31. Na zkopírované skice klikněte pravím tlačítkem a vyberte Sketch.X object -> Change Sketch Support. 

32. Zobrazené upozornění potvrďte . 

33. Klikněte na druhou pomocnou rovinu. Skica se přesune na tuto rovinu. 

34. Dvojklikem na skicu zeditujte skicu dle obrázku. A potvrďte úpravy . 

 

 
 
 

 

 
 

 

Pro zpřehlednění při kreslení profilu můžete využít drátové zobrazení tělesa. 

Pravidelně ukládejte (CTRL+S) 
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Krok č.6 Vytvoření řezací části (Multi-section Solid) 

35. Klikněte na  Multi-Section Solid. 

36. Vyberte obě vytvořené skici, zkontrolujte polohu Closing point a směr šipky jdoucí odtud.  

37. Klikněte na Preview a potvrďte . 

 

 

Krok č.7 Zkopírování řezací části (CircularPattern) 

38. Klikněte na   CircularPattern v boční nástrojové liště. 

39. Hodnotu Instance(s) zadejte 4. Angular spacing zadejte 90 deg. 
40. V Referent Direction do kolonky Reference element vyberte Osa Z. 

41.  Object to Pattern vyberte Multi-section Solid z předešlého kroku. 

42. Klikněte na Preview pro kontrolu nastavení a potvrďte . 
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Krok č.8 Tvorba pomocné plochy (Catia modul pro plochy) 

43. Přepněte se pomocí Start -> Shape -> Generative Shape Design do modulu pro tvorby ploch. 

44. Klikněte na  Sketch a jako rovinu vyberte obvodovou plochu. 

45. Pomocí   Project 3D Elements promítněte hrany dle obrázku (zobrazeny žlutě). 

46. Klikněte na  Connect v boční nástrojové liště a vyberte promítnuté hrany. 

47. Skicář ukončete pomocí . 
 

 
 

48. Klikněte na  Rotate a vyberte vytvořenou skicu. 

49. Jako osu rotace nastavte Osa Z.  
50. Angle nastavte na 90deg. A zaškrtněte Repeat object after OK. 

51. Potvrďte nastavení .  
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52. Hodnotu Instance(s) zadejte 2. 

53. Odškrtněte Create in New Body a potvrďte . 
 

 

54. Klikněte na  Fill v boční nástrojové lište. 

55. Vyberte čtyři vzniklé křivky a příkaz ukončete . 

56. Pokud si skryjete PartBody pomocí příkazu  Hide/Show. Zobrazí se Vám vytvořená plocha. 
 

    
 

57. Zobrazte si opět PartBody a zároveň zaktivujte Partbody jako pracovní object. (Define to Work Object). 
58. Přepněte se zpět do modulu pro tvorbu modelů (objemových těles).  

Pomocí nabídky Start -> Mechanical Design -> Part Design 
 

 

 
 

 
 

 
 

Pravidelně ukládejte (CTRL+S) 
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Krok č.9 Odříznutí spodku nože 

59. Kliknete na  Split v boční nástrojové liště. 

60. Ve stromě prvků vyberte plochu vytvořenou v předešlém kroku. 

61. Směr šipky nasměrujte tak, aby směřovala do části, která bude zůstávat. A potvrďte . 
62. Ve stromě prvků vyberte pomocné plochy, Fill a čtyři křivky, a pro lepší přehlednost je dejte skrýt. 

 

     

Krok č.10 Tvorba skici pro Multi-Pocket 

63. Klikněte na  Sketch a položte skicu na horní rovinu nože. 

64. Klikněte na rovinnou plochu nože, čímž se Vám označí obvodové hrany a klikněte na  Offset. Vytvoříte tak 

menší čtverec. Kótu offsetu přepište na -3mm. 

65. Klikněte na  Circle a vytvořte kružnici o poloměru 15mm s počátkem ve středu souřadnic. 

66. Skicář ukončete pomocí . 
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Krok č.11 Vyříznutí středové díry 

67. Klikněte na  Multi-Pocket a vyberte připravenou skicu. 

68. Klikněte na . 

69. Pro vnitřní profil (čtverec) nastavte: First Limit – Depth: 10mm, Second Limit – Depth: 0mm 
70. Pro vnější profil nastavte: First Limit – Depth: 10mm, Second Limit – Depth: -6,5mm 

71. Příkaz ukončete pomocí . 

 

 
 

 
 

 
 

 

 
 

 
 

 

Pravidelně ukládejte (CTRL+S) 

 

Tvorba díry lze provézt i postupním odebráním materiálu příkazem  Pocket.  
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Krok č.12 Zkosení vnitřní díry 

72. Klikněte na  Draft Angle a zkoste vnitřek tak, aby směrem od neutrální plochy se průřez zužoval. 

 

 

Krok č.13 Zaoblení nože (Edge Fillet) 

73. Rádius R3 

      

74. Rádius R1 
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75. Rádius R2 

    

76. Radius R1 

    

77. Radius R1 

   
 

 

 
 

 
 

Pravidelně ukládejte (CTRL+S) 
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78. Radius R0,5 

   

79. Radius R1 

   

Krok č.14 Tvorba ostří nože 

80. Klikněte na  Split a vyberte třetí pomocnou rovinu, nastavte směr a potvrďte . 
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81. Klikněte na  Pocket, skicu umístěte na rovinu Půdorys. 

82. Vytvořte skicu dle obrázku a odřízněte touto skicou všechen materiál. 

 

    

83. Klikněte na   CircularPattern a zkopírujte tak odříznutí na ostatní nože. 

 

 

84. Označte plochy ostří a nastavte odlišnou barvu.   

 

    

5 - 14



 

Krok č.16 Nastavení konečných vlastností   

Klikněte na  Apply material ve spodní nástrojové liště. 

85. Ve stromě vyberte položku Product1, aby se vybrala celá součást. 

86. V záložkách Knihovny (Library) vyberte Metal a Steel. Příkaz ukončete kliknutím na . 

87. Klikněte na  Measure Inertia ve spodní nástrojové liště. 

88. Ve stromě vyberte položku Product1, aby se vybrala celá součást. 

89. Klikněte na  a zaškrtněte pouze Volume, Density a Mass a potvrďte . 

90. Zaškrtněte Keep measure a potvrďte . 
 

 
 

 

Uložte (CTRL+S) 
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6.CVIČENÍ 

CÍL 

Vytvoření součásti šneku do sestavy mlýnku na maso. Součást prvku na maso je vytvořena pomocí šroubovice. 

Šroubovice je řízená grafem stoupání. 
 

 

PŘEDPOKLADY 

 Připravená šablona ze cvičení 0. 

 Základy modelování z předchozích cvičení. 

NOVĚ PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Tvorba ploch (Revolve, Sweep, Fill) 

 Offset 

 Intersect, Curve Smooth,  
 Extract 

 Law 
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Krok č.1 Vytvoření nové součásti 

1. V nástrojové liště klikněte na tlačítko . 

2. Otevřete si šablonu z předešlého cvičení.  
3. V nabídce File vyberte Save As. 

4. Vyberte složku pro uložení součásti. 
5. Jako File name zadejte 10_TELO 

6. Potvrďte tlačítkem . 

 
 

 

 

 

 

 

Krok č.2 Pomocné roviny 

7. Klikněte na  Plane  a vytvořte rovinu offset 88 mm od roviny Půdorys. Přejmenujte tuto rovinu na Horní. 

 

 

8. Klikněte na  Plane  a vytvořte rovinu offset 150 mm od roviny Nárys.  Přejmenujte tuto rovinu na Zadní. 

 

 

V názvech souborů nepoužívejte diakritiku ani speciální znaky. 
Potřebujete-li v názvu souboru mít mezeru, použijte podtržítko “_“. 
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Krok č.3 Pomocné plochy 

9. Vytvořte nový Geometrical Set, který přejmenujte na Pomocné plochy. Za Father nastavte Geometrical Set.1. 

 Insert -> Geometrical Set (více viz. předchozí cvičení) 

10. Přepněte se do modulu pro tvorbu ploch. Start -> Shape -> Generative Shape Design 

11. Na rovině Nárys vytvořte skicu dle obrázku. 

12. Klikněte na  Revolve a vytvořte plochu dle obrázku. 

 

 

13. Na rovině Nárys vytvořte skicu dle obrázku. 

14. Klikněte na  Revolve a vytvořte plochu dle obrázku. 
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Krok č.4 Tvorba šroubovice 

15. Vytvořte nový Geometrical Set, který přejmenujte na Sroubovice. Za Father nastavte Geometrical Set.1. 

16. Na rovině zadní vytvořte skicu dle obrázku. Křivku vytvořte příkazem  Spline. 

 

 

17. Klikněte na  Develop v boční nástrojové liště. 
18. Za Wire to develop vyberte vytvořenou skicu. 

19. Za Support Surface vyberte válcovou rovinu z kroku č.3. 

20. Klikněte na  a zkontrolujte směr točení šroubovice a potvrďte . 
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21. Klikněte na  Sweep v boční nástrojové liště. 

22. Vyberte typ sweepu Line  . 
23. Subtype vyberte With reference surface. 

24. Guide curve vyberte promítnutou šroubovici na válci. 
25. Reference Surface vyberte rovinu Horní. 

26. Hodnotu Angle ponechte 0deg, délku Length1 10mm, Lenght2 2mm. 

27. Klikněte na  a zkontrolujte, zda vytvořená plocha odpovídá obrázku, poté potvrďte . 

 

 
 

28. Klikněte na  Offset a vyberte plochu vytvořenou v předešlém kroku. 
29. Hodnotu offsetu nastavte 2mm. Stranu offsetu nastavte tak, aby se nová plocha tvořila nad stávající. 
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30. Pro přehlednost skryjte válcovou plochu a promítnutou šroubovici. 

31. Klikněte na  Intersection v boční nástrojové liště. 

32. First element vyberte kuželovou plochu, Second element vyberte Sweep plochu. 

33. Klikněte na  a potvrďte . 

 

 

34. Klikněte na  Intersection v boční nástrojové liště. 

35. First element vyberte kuželovou plochu, Second element vyberte Offset plochu. 

36. Klikněte na  a potvrďte . 
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 Oprava a vyhlazení křivky 

37. Klikněte na  Curve Smooth v boční nástrojové liště. 

38. Vyberte první křivku Intersection. 
39. Maximum deviation nastavte 0,001 

40. Zaškrtněte Curvature, klikněte na  a potvrďte . 

 

 

41. Klikněte na  Curve Smooth v boční nástrojové liště. 

42. Vyberte druhou křivku Intersection. 

43. Zkontrolujte Maximum deviation. 

44. Zaškrtněte Curvature ,klikněte na  a potvrďte . 
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45. Skryjte všechny pomocné prvky, ponechte pouze vyhlazené křivky. 

 

                     

Krok č.5 Tvorba šneku 

46. Vytvořte nový Geometrical Set, který přejmenujte na Snek. Za Father nastavte Geometrical Set.1. 

47. Klikněte na  Sweep v boční nástrojové liště. 

48. Vyberte typ sweepu Line  . 
49. Subtype vyberte Two limits. 

50. Za Guide curve 1,2 vyberte obě křivky., 

51. Hodnotu Length 1,2 nastavte 0mm. 

52. Klikněte na  a potvrďte . 
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53. Klikněte na  Split v boční nástrojové liště. 

54. Vyberte vytvořenou plochu. 
55. Jako Cutting elements vyberte rovinu Bokorys. 

56. Zaškrtněte Keep both sides. 

57. Klikněte na  a potvrďte . 

 

 

Krok č.6 Tvorba pravidla pro sklon zubu 

58. Klikněte na  Formula v dolní nástrojové liště. 

59. U ikony   nastavte Length a Single Value. A klikněte na . 
60. Mezi parametry se přidá nový parametr. 

 

 

Přidaný parametr 
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61. Nyní přepište název parametru na U1 a hodnotu nastavte na 290mm. (velikost úhlu). 

 Hodnotu U1 zadáváme v mm kvůli tvorbě skici. Ale při tvorbě boku šneku bude tato hodnota odpovídat velikosti sklonu 
zubu od referenční plochy. 

 

 

62. Vytvořte další parametr U2 s hodnotou 295mm. (velikost úhlu). 

63. Vytvořte další parametr R1 s hodnotou 3mm (velikost rádiusu). 
64. Vytvořte další parametr D1 s hodnotou 10mm 

65. A poté potvrďte . 

66. Po potvrzení nabídky se ve stromě prvků zobrazí skupina Parameters. V této skupině poklikáním na jednotlivé 
parametry lze měnit jejich hodnoty. 

67. Vytvořte skicu dle obrázku. Vytvořte kóty dle obrázku, ale needitujte je. 

 

 

Název parametru 

Hodnota parametru 
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68. Klikněte na  Formula v dolní nástrojové liště. 

69. Nyní klikněte na kótu rádiusu. V nabídce se zobrazí adresa kóty a její hodnota. 
 

 
 

70. Klikněte na  a ve stromě prvků vyberte parametr R1.  

71. Vložení formuly potvrďte . 

 

 
 

 

Vybraná kóta 

Hodnota kóty 

Cesta kóty 
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72. Po potvrzení přidání formuly se hodnota kóty upraví a zobrazí se u ní znak . 

73. Tímto způsobem přidejte parametry podle obrázku vlevo. 
74. Po vytvoření parametrů obrázek vpravo. 

 

                   

75. Klikněte na  Law v boční nástrojové liště. 

76. Jako Reference vyberte poziční ukazatel H u vytvořené skici. 
77. Jako Definition vyberte vytvořenou křivku. 

78. Pokud na ose X posunete ukazatel, změní se Vám hodnota Y, což je naše pravidlo. V závislosti na poloze se bude 
měnit náš úhel, který bude mít hodnotu Z. 
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Krok č.7 Tvorba boků šneku. 

79. Klikněte na  Extract v boční nástrojové liště. 

80. Vyberte první element stuhy a potvrďte . 

 

 
 

81. Tímto způsobem vytvořte dalších 7 extract prvků nejlépe jdoucí postupně za sebou. 

 Každá barva tvoří jeden prvek (Extract) ve stromě prvků. 

 

 
 

82. Nyní skryjte prvek Split ve stromě prvků. 
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83. Klikněte na  Sweep v boční nástrojové liště. 

84. Vyberte typ sweepu Line  . 
85. Subtype vyberte With reference surface. 

86. Jako Guide curve vyberte horní hranu prvního prvku Extract. 
87. Jako Reference surface vyberte plochu Extract. 

88. Pro nastavení úhlu klikněte na . 
89. Po otevření nabídky Law Definition vyberte ve stromě prvků vytvořené pravidlo z Kroku č.6. Nabídku zavřete 

pomocí . 
90. Hodnotu Length.1 nastavte 14mm a Length.2 nastavte 0mm. 

91. Klikněte na  a potvrďte . 

 

 

92. Vytvořte takto dalších 7 horních ploch u ostatních Extrude prvků. 

93. Pro usnadnění vyberte vytvořenou plochu a pomocí Ctrl+C a Ctrl+V zkopírujte plochu. 

94. Poklikejte na zkopírovanou plochu a upravte pouze Guide curve a Reference Surface. 
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95. Klikněte na  Sweep v boční nástrojové liště. 

96. Vyberte typ sweepu Line  . 
97. Subtype vyberte With reference surface. 

98. Jako Guide curve vyberte spodní hranu prvního prvku Extract. 
99. Jako Reference surface vyberte plochu Extract. 

100. Pro nastavení úhlu klikněte na . 
101. Po otevření nabídky Law Definition vyberte ve stromě prvků vytvořené pravidlo z Kroku č.6. Nabídku 

zavřete pomocí . 
102. Hodnotu Length.1 nastavte 14mm a Length.2 nastavte 0mm. 

103. Klikněte na  a potvrďte . 

 

 

104. Opět vytvořte dalších 7 spodních ploch, buď nastavováním, nebo rozkopírováním. 
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105. Klikněte na  Line v boční nástrojové liště. 

106. Vyberte tvorbu Point-Point a vytvořte úsečky dle obrázku. 

 

   

107. Klikněte na  Fill v boční nástrojové liště. 

108. Zapněte si filtr pro výběr  v horní nástrojové liště. 
109. Vyberte postupně hrany dle obrázku. 

110. Klikněte na  a potvrďte . 

 

   
 

 

 
 

 
 

 
 

 

 
 

Pravidelně ukládejte (CTRL+S) 
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111. Klikněte na  Fill v boční nástrojové liště a předešlým způsobem vytvořte plochu dle obrázku. 
 

 

112. Klikněte na  Joint v boční nástrojové liště. Ve stromě prvků vyberte všechny prvky Extract, Sweep a Fill. 

113. Ponechte zaškrtnuté pouze Check connexity a klikněte na . 

114. Potvrďte tvorbu . 

 

 
 

 

 
Pravidelně ukládejte (CTRL+S) 
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Krok č.8 Tvorba jádra šneku 

115. Přepněte se do prostředí pro modelování objemového tělesa. Start -> Mechanical Design -> Part Design 

116. Skryjte si geometrical set – Snek. A zobrazte si válcovou plochu z kroku č.3. 
117. Vytvořte skicu dle obrázku na rovině Nárys. 

 

 

118. Klikněte na  Revolve a z vytvořené skici vytvořte jádro šneku. 
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Krok č.9 Tvorba zubů šneku 

119. Skryjte plochu válce a zobrazte si geometrical set - Snek. 

120. Klikněte na  Sew Surface v boční nástrojové liště. 
121. Do Object to sew vyberte vytvořený tvar zubů. 

122. Do Face to remove ponechte prázdné. 

123. Zaškrtněte Intersect body a potvrďte . 

 

 

124. Skryjte geometrical set - Snek. 
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Krok č.10 Tvorba horní části šneku 

125. Vytvořte rovinu Orez ve vzdálenosti 91mm od roviny Půdorys. 

 

 

126. Klikněte na  Split v boční nástrojové liště a ořízněte model rovinou Orez. 
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127. Na oříznuté ploše vytvořte skicu dle obrázku. 

 

 

128. Klikněte na  Multi-Pad v boční nástrojové liště. 

129. Nastavte vzdálenosti vysunutí 7mm a 16mm dle obrázku. 
 

 
 

 
 

 

 
 

Pravidelně ukládejte (CTRL+S) 

 

Více informací o tvorbě prvku multi-pad viz předešlé cvičení č.3. 
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Krok č.11 Tvorba spodní části šneku 

130. Klikněte na  Plane  a vyberte Trough two lines a vyberte úsečky dle obrázku. 

 

 

131. Vytvořte skicu na vytvořené rovině dle obrázku. 
 

 

132. Klikněte na  Rotate a vytvořte prvek dle obrázku. Za osu rotace vyberte Osa Z 
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133. Klikněte na  Split v boční nástrojové liště a ořízněte model dle obrázku. 
 

 

134. Pomocí  Pad vytvořte výstupek dle obrázku o průměru 15,6mm do výšky 22mm. 

 

 
 
 

 

 
 

 

Pravidelně ukládejte (CTRL+S) 

 

Více informací o tvorbě prvku Rotate, Split, Pad viz předešlá cvičení. 
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135. Pomocí  Pad vytvořte výstupek dle skici do výšky 14mm. 

 

 

Krok č.12 Zkosení 

136. Vytvořte zkosení 1,5deg dle obrázku. 

 Červeně jsou vybrány plochy ke zkosení. Modře je vybrána neutrální plocha. 
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137. Vytvořte zkosení 1,5deg dle obrázku. Stěny se od neutrální plochy zužují.  

 

 

Krok č.13 Díra 

138. Vytvořte díru se závitem M6x1 – 14,5 a hloubka díry 20mm. 

 

 

Krok č.14 Sražení 

139. Vytvořte sražení 1x45° dle obrázku. 
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Krok č.15 Zaoblení 

140. Vytvořte zaoblení dle obrázků. 

 Značení: Edge Fillet – E; Variable Fillet – V; Choral Fillet - Ch . 

 

   

 

  
 

 

E – R2 E – R0,5 

E – R0,5 

E – R0,5 E – R0,3 
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141. Vyberte hranu dle obrázku 

 

 
 

142. Klikněte na nabídku . 

143. Klikněte do pole Edge to keep a vyberte fialově vyznačenou hranu. 

 

 
 

144. Klikněte na  a potvrďte . 

 

    

E – R20 
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CH – R10 E – R3 

E – R2 

Pravidelně ukládejte (CTRL+S) 
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E – R1 E – R2 

E – R1 E – R0,5 

E – R0,5 
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Krok č.16 Obarvení obráběných ploch 

145. Obarvěte plochy dle obrázku. 

 

 
 

 

Krok č.30 Nastavení konečných vlastností 

146. Klikněte na  Apply material ve spodní nástrojové liště. 
147. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

148. V záložkách Knihovny (Library) vyberte Metal a Steel. Příkaz ukončete kliknutím na . 

149. Klikněte na  Measure Inertia ve spodní nástrojové liště. 
150. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

151. Klikněte na  a zaškrtněte pouze Volume, Density a Mass a potvrďte . 

152. Zaškrtněte Keep measure a potvrďte . 

153. Ve stromě vyberte Geometrical Set.1 a klikněte na  Hide/Show. 

 

 
 

Nezapomeňte uložit (CTRL+S) 

 

6 - 30



7.CVIČENÍ 

CÍL 

Vytvoření součásti kliky do sestavy mlýnku na maso. Tato součást je tvořena prvkem Multi-sections Solid, několika 

protaženími a zaobleními. 
 

 

PŘEDPOKLADY 

 Připravená šablona ze cvičení 0. 

 Znalost vytváření pomocné geometrie,  

 Znalost prvků Protažení(Pad), Kapsa (Pocket) Díra(Hole), Zaoblení(Edge Fillet), Sražení hrany(Chamfer) 

NOVĚ PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Oboustranné zkosení (Draft Angle) 

 Tvarový výběr (Removed Multi-sections Solid) 
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Krok č.1 Vytvoření nové součásti 

1. V nástrojové liště klikněte na tlačítko . 
2. Otevřete si šablonu z předešlého cvičení.  

3. V nabídce File vyberte Save As. 
4. Vyberte složku pro uložení součásti. 

5. Jako File name zadejte 07_KLIKA 
6. Potvrďte tlačítkem . 

 
 

 

 

 

 

 

Krok č.2 Řídící skica pro kliku (Multi-sections Solid) 

7. Klikněte na  Sketch a vložte skicu 
na rovinu Nárys. 

8. Zapněte   Construction element 
v horní nástrojové liště. 

9. Vytvořte skicu pomocí  Profile a 
zakótujte dle obrázku. 

10. Zapněte   Construction element 
v horní nástrojové liště. 

11. Pomocí   Connect propojte 

horizontální úsečky a ukončete . 
 

 

Krok č.3 Profilová skica pro kliku 1 (Multi-sections Solid) 

12. Klikněte na  Sketch a vložte skicu na rovinu 
Bokorys. 

13. Vytvořte a zakótujte elipsu  Elipse dle obrázku. 

14. Ukončete pomocí . 
 
 

 

 
 

 
 

 

 
 

 
 

 
 

 

 

V názvech souborů nepoužívejte diakritiku ani speciální znaky. 
Potřebujete-li v názvu souboru mít mezeru, použijte podtržítko “_“. 

 

Pravidelně ukládejte (CTRL+S) 
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Krok č.4 Profilová skica pro kliku 2 (Multi-sections Solid) 

15. Klikněte na  Plane. 
16. V nabídce vyberte Normal to Curve a vyberte konečný koncový bod a křivku. 

17. Potvrďte výběr . 
 

 

18. Vložte na vytvořenou rovinu skicu a promítněte si koncový bod křivky pomocí  Project 3D Elements. 
19. Vytvořte skicu elipsy dle obrázku. Střed elipsy leží promítnutém bodě. 

20. Potvrďte skicu pomocí . 
 
 

 
 

 
 

Nezapomeňte na vložení vertikální či horizontální vazby. Bez této vazby nebude elipsa plně nadefinována (zelená). 
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Krok č.5 Profilová skica pro kliku 2 (Multi-sections Solid) 

21. Klikněte na  Multi-sections Solid v boční nástrojové liště. 
22. Vyberte obě profilové skici a zkontrolujte orientaci šipek. 

23. Přepněte se na záložku Spine a vyberte řídící skicu z kroku 2. 

24. Klikněte na  a potvrďte . 

 

 

Krok č.6  Profilová skica 1 pro drážku  (Removed Multi-sections Solid) 

25. Klikněte na  Sketch a vložte skicu na rovinu Bokorys. 
26. Vytvořte kružnici dle obrázku.  

  

Krok č.7  Profilová skica 2 pro drážku (Removed Multi-sections Solid) 

27. Klikněte na  Sketch a vložte skicu na pomocnou rovinu. 
28. Vytvořte kružnici dle obrázku.  
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Krok č.8 Drážka na klice (Removed Multi-sections Solid) 

29.  V prvku Multi-sections Solid si zobrazte řídící skicu. 

30. Klikněte na   Remove Multi-sections Solid v boční nástrojové liště. 
31. Vyberte obě skici kružnic a zkontrolujte orientaci šipek. 
32. Přepněte na záložku Spine a vyberte řídící křivku. 

33. Klikněte na  a potvrďte . 
 

 

Krok č.9 Konec kliky 1 (Pad) 

34. Pomocí  Pad vytvořte válec o průměru 25mm dle obrázku. Skica leží na rovině Nárys. 
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Krok č.10 Tvarová díra (Pocket) 

35. Pomocí  Pocket vytvořte díru dle obrázku. Díra je průchozí. Skica leží na rovinné ploše válce. 
 

 

Krok č.11 Konec kliky 2 (Pad) 

36. Pomocí  Pad vytvořte válec o průměru 16mm dle obrázku. Skica leží na rovině Nárys. 
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Krok č.12 Díra pro rukojeť (Hole) 

37. Klikněte na  Hole a vytvořte průchozí díru o průměru 5mm dle obrázku. 

 

 

Krok č.12 Zkosení vybrání (Draft Angle) 

38. Klikněte na  Draft Angle v boční nástrojové liště. 
39. Jako plochy ke zkosení (Face(s) to draft) vyberte plochy prvku pocket. 
40. Jako Neutral element vyberte rovinnou plochu válce na straně drážky. 

41. Pomocí  zkontrolujte, zda se díra zužuje směrem od neutrální plochy a potvrďte . 
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Krok č.13 Zkosení válců (Draft Angle) 

42. Klikněte na  Draft Angle v boční nástrojové liště. 
43. Jako plochy ke zkosení (Face(s) to draft) vyberte válcové plochy. 

44. Klikněte na  a zde zaškrtněte Parting = Neutral a Draft both side. 
45. Jako Neutral element vyberte rovinu Nárys. 

46. Nastavte hodnotu Angle 10 deg a klikněte . Pokud se válcová plocha zužuje směrem od neutrální plochy, 

přenastavte Angle na 1,5deg a potvrďte . 
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Krok č.13 Zaoblení (Edge Fillet) 

47. Průměr zaoblení r=0,5mm 
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48. Průměr zaoblení r=2mm 
 

    

49. Průměr zaoblení r=2mm 
 

   

Krok č.14 Sražení (Chamfer) 

50.  Sražení 1x45° 
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Krok č.15 Nastavení konečných vlastností 

51. Klikněte na  Apply material ve spodní nástrojové liště. 

52. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

53. V záložkách Knihovny (Library) vyberte Metal a Steel. Příkaz ukončete kliknutím na . 

54. Klikněte na  Measure Inertia ve spodní nástrojové liště. 

55. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

56. Klikněte na  a zaškrtněte pouze Volume, Density a Mass a potvrďte . 

57. Zaškrtněte Keep measure a potvrďte . 

58. Ve stromě vyberte Geometrical Set.1 a klikněte na  Hide/Show. 

 
 

 
 

 

 

 
 

 

Uložte (CTRL+S) 
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8.CVIČENÍ 

CÍL 

Vytvoření součásti osičky, podložky a tyčky do sestavy mlýnku na maso.  

PŘEDPOKLADY 

 Připravená šablona ze cvičení 0. 

 Znalost příkazů:  

o Protažení (Extrude) 

o Rotace (Shaft)  
o Zaoblení (Edge Fillet) 

o Sražení hrany (Edge Chamfer) 

NOVĚ PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Rotace tenkostěnného tělesa 
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Krok č.1 Vytvoření nové součásti 

1. V nástrojové liště klikněte na tlačítko . 

2. Otevřete si šablonu z předešlého cvičení.  
3. V nabídce File vyberte Save As. 

4. Vyberte složku pro uložení součásti. 
5. Jako File name zadejte 08_OSICKA 

6. Potvrďte tlačítkem . 

 

Krok č.2 Rotace (revolve) 

7. Příkazem  Shaft vytvořte rotační těleso (viz obr.) se skicovací rovinou NARYS.  
 

 
 
 

 
 

 

Krok č.3  Zaoblení hlavy (Round) 

8. Zaoblete podle obrázku. 
 

   
 

 
 

Vytváření skic a vytváření geometrických vazeb bylo podrobněji probráno v 1.cvičení  
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Krok č.4 Zaoblení hlavy (Round) 

9. Zaoblete podle obrázku. 

 

   

Krok č.5 Sražení hran (edge chamfer) 

10. Proveďte sražení hran dle obrázků. 

 

             

Krok č.7 Uložení součásti a vytvoření nové 

11. Uložte vytvořenou součást. 
12. Zavřete okno. 

13. Otevřete šablonu, a přeuložte (Save As) pod názvem 08_PODLOZKA 
 

 

 
 

 
 

 

 
 

 
  

Otevření a přeuložení viz. Cvičení I. 
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Krok č.9 Rotace (revolve) 

14. Příkazem  Shaft vytvořte rotační těleso se skicovací rovinou NARYS a osou rotace OSA_Z. 

15. Před vytvořením vlastní skici je důležité zaškrtnout Thick Profile, čímž dáte systému najevo, že budete vytvářet 

tenkostěnné těleso  
16. Po vytvoření skici nastavte Thickness na 1mm.  

 

 
 

   

Krok č.10 Vyříznutí otvoru pro šroub (Pocket) 

17.  Vyřízněte kruhový otvor příkazem  Pocket dle obrázku. 
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Krok č.11 Vytvoření nové součásti 

18. Uložte vytvořenou součást. 

19. Zavřete okno. 
20. Otevřete šablonu, a přeuložte (Save As) pod názvem 08_TYCKA 

 

 

 

Krok č.2 Protažení (Extrude) 

21. Příkazem Extrude protáhněte kruhový průřez do vzdálenosti 25mm. 

 

   

22. Na koncích tyčky vytvořte sražení 0,3x45° 

 

 

Krok č.15 Nastavení konečných vlastností (u všech součástí) 

23. Klikněte na  Apply material ve spodní nástrojové liště. 

24. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

25. V záložkách Knihovny (Library) vyberte Metal a Steel. Příkaz ukončete kliknutím na . 

26. Klikněte na  Measure Inertia ve spodní nástrojové liště. 

27. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

28. Klikněte na  a zaškrtněte pouze Volume, Density a Mass a potvrďte . 

29. Zaškrtněte Keep measure a potvrďte . 

30. Ve stromě vyberte Geometrical Set.1 a klikněte na  Hide/Show. 

 

 

 

Otevření a přeuložení viz. Cvičení I. 

 

Uložte (CTRL+S) 
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9.CVIČENÍ 

CÍL 

Vytvoření součásti víčka do sestavy mlýnku na maso. Tato součást je tvořena několika rotacemi, zúkosováním 

některých stěn a několika zaobleními. 
 

PŘEDPOKLADY 

 Připravená šablona ze cvičení 0. 

 Znalost vytváření pomocné geometrie 

 Znalost prvků Rotace(Shaft), Kruhové pole (Circular Pattern), Zkosení(Draft), Zaoblení (Edge Fillet), 

Drážka (Groove), Závit(Thred) 

NOVĚ PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Obarvení tělesa 

 Zaoblení (Choral Fillet) 
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Krok č.1 Vytvoření nové součásti 

1. V nástrojové liště klikněte na tlačítko . 

2. Otevřete si šablonu z předešlého cvičení.  
3. V nabídce File vyberte Save As. 

4. Vyberte složku pro uložení součásti. 
5. Jako File name zadejte 09_VICKO 

6. Potvrďte tlačítkem . 

 
 

 

 

Krok č.2 Pomocná skica 

7. Klikněte pravým tlačítkem na Geometrical Set a vyberte Define In Work Object. 

8. Na rovině Bokorys, pomocí  Sketch vytvořte skicu dle obrázku. A potvrďte . 

 

 
 

 
 

 

 
 

V názvech souborů nepoužívejte diakritiku ani speciální znaky. 
Potřebujete-li v názvu souboru mít mezeru, použijte podtržítko “_“. 

 

Více tvorbě skici, kotování a tvorbě vazeb viz. předešlá cvičení.  
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Krok č.3 Tělo víčka (Shaft) 

9. Klikněte pravým tlačítkem na PartBody a vyberte Define In Work Object. 

10. Klikněte na   Sketch vytvořte skicu na rovině Bokorys. 

11. Pomocí  Project 3D Element a promítněte si tři úsečky z pomocné skici. 
12. Dvě úsečky změňte na konstrukční prvek dle obrázku. 

13. Pomocí  Profile vytvořte skicu dle obrázku. A plně ji okótujte. 
 

 

14. Pomocí  Shaft vytvořte tělo dle obrázku. Jako osu rotace vyberte Osa Y. 

15. Klikněte na  a potvrďte . 
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Krok č.4 Výstupek I. (Shaft) 

16. Klikněte na   Sketch vytvořte skicu na rovině Bokorys. 

17. Pomocí  Project 3D Element a promítněte si dvě úsečky (žlutě) z pomocné skici. Obě úsečky změňte na 
konstrukční prvek dle obrázku. 

18. Pomocí  Line a  Spline vytvořte skicu dle obrázku. A plně ji okótujte. 

19. Pomocí  Shaft vytvořte výstupek dle obrázku. Jako osu rotace vyberte Osa Y. 
20. Úhly rotace nastavte na 11deg. 

21. Klikněte na  a potvrďte .  
 

  

22. Klikněte na   Circular Pattern a vytvořte dalších pět výstupků. A potvrďte . 
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Krok č.5 Pomocná rovina 1,2,3,4 (plane) 

 Pomocná rovina 1 a 2 ( viz. obr.1. na konci listu). 

23. Klikněte na  Plane a v nabídce vyberte Angle/Normal to plane. 

24. Za osu rotace vyberte Osa Y, Reference: Bokorys, Angle: 30deg. 

25. Zaškrtněte Repeat object after OK. A potvrďte . 

26. Počet dalších prvků nastavte na jedna. Odškrtněte Create in a new Body a potvrďte . 

 

  

 Pomocná rovina 3 a 4 ( viz. obr.2. na konci listu). 

27. Klikněte na  Plane a v nabídce vyberte Angle/Normal to plane. 

28. Za osu rotace vyberte Osa Y, Reference: Půdorys, Angle: 30deg. 

29. Zaškrtněte Repeat object after OK. A potvrďte . 

30. Počet dalších prvků nastavte na jedna. Odškrtněte Create in a new Body a potvrďte .   
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Krok č.6 Výstupek II. (Shaft) 

31. Klikněte na   Sketch vytvořte skicu na rovině dle obrázku. Pro lepší přehlednost 

můžete skrýt Geometrical Set. 

32. Klikněte na   Cut Part By Sketch Plane v dolní nástrojové liště. 

33. Pomocí  Project 3D Element a promítněte dvě úsečky z těla.  Tyto promítnuté 

hrany nejlépe vytvoříte pootočením tělesa a vybráním plochy. Obě úsečky změňte na 
konstrukční prvek dle obrázku. 

34. Pomocí  Spline vytvořte skicu dle obrázku. A plně ji okótujte. 

35. Pomocí  Shaft vytvořte výstupek dle obrázku. Jako osu rotace vyberte Osa Y. 

36. Úhly rotace nastavte na 11deg. 

37. Klikněte na  a potvrďte .  

 

 
 
 

 
 

 

 
 

 

Pravidelně ukládejte (CTRL+S) 
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Krok č.7 Výstupek III. (Shaft) 

38. Klikněte na   Sketch vytvořte skicu na rovině dle obrázku. Pro lepší přehlednost 

můžete skrýt Geometrical Set. 

39. Klikněte na   Cut Part By Sketch Plane v dolní nástrojové liště. 

40. Pomocí  Project 3D Element a promítněte dvě úsečky z těla. Tyto promítnuté 

hrany nejlépe vytvoříte pootočením tělesa a vybráním plochy. Obě úsečky změňte na 
konstrukční prvek dle obrázku. 

41. Pomocí  Spline vytvořte skicu dle obrázku. A plně ji okótujte. 

42. Pomocí  Shaft vytvořte výstupek dle obrázku. Jako osu rotace vyberte Osa Y. 

43. Úhly rotace nastavte na 11deg. 

44. Klikněte na  a potvrďte .     

 

 
 
 

 
 

 

 
 

 
 

 

 

Pravidelně ukládejte (CTRL+S) 
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Krok č.8 Znásobení výstupků II. A III.  (Shaft) 

45. Klikněte na   Circular Pattern, vyberte Výstupek II. a vytvořte dalších dva výstupky. A potvrďte . 

 

 

46. Klikněte na   Circular Pattern, vyberte Výstupek III. a vytvořte dalších dva výstupky. A potvrďte . 
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Krok č.9 Zkosení výstupků III. 

47. Klikněte na  Draft Angle. 
48. Jako Face(s) to draft vyberte boční plochy výstupku na obrázku hnědě. 

49. Za Pulling Direction vyberte rovinu kolmou na výstupek. K výběru nejlépe používejte strom prvků. 

50. Šipku orientujte proti výstupku. 
51. Neutral Element vyberte tvarové plochy těla na obrázku modře. 

52. Angle nastavte 25deg, klikněte na  a potvrďte .     
 

 

53. Zopakujte tento postup u dalších dvou výstupků III. 
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Krok č.10 Zkosení výstupků I. 

54. Klikněte na  Draft Angle. 

55. Jako Face(s) to draft vyberte boční plochy výstupku na obrázku hnědě. 
56. Za Pulling Direction vyberte rovinu kolmou na výstupek. 

57. Šipku orientujte proti výstupku. 

58. Neutral Element vyberte tvarové plochy těla na obrázku modře. 

59. Angle nastavte 25deg, klikněte na  a potvrďte .     

 

 

60. Zopakujte tento postup u dalších dvou výstupků III. 
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Krok č.11 Zaoblení 

61. Pomocí  Edge Fillet, poloměr r=4mm. 

 

   

62. Pomocí  Edge Fillet, poloměr r=4mm. 

 

  
 
 

 

 
 

 
 

 
 

Pravidelně ukládejte (CTRL+S) 
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63. Pomocí  Edge Fillet, poloměr r=3mm. 

 

   

64. Pomocí  Chordal Fillet, poloměr r=3mm. 
 

   
 
 

 

 
 

 
 

 
 

 

 
 

Pravidelně ukládejte (CTRL+S) 
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65. Pomocí  Edge Fillet, poloměr r=3mm. 

 

   

66. Pomocí  Edge Fillet, poloměr r=4mm. 
 

   
 
 

 
 

 

 
 

 
 

 

Pravidelně ukládejte (CTRL+S) 
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67. Pomocí  Chordal Fillet, poloměr r=3mm. 

 

   
 

68. Pokud se Vám zobrazí toto varování. Zkontrolujte, že pod Severity je napsáno Information. Potom je to pouze 
upozornění, že plocha byla vygenerována, a že ji máme zkontrolovat. Pokud bude pod Severity napsáno 

Warning, ve většině případech dochází při tvorbě prvku k chybě, která nám může dále způsobovat problémy při 

tvorbě dalších prvků.   
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 

 
 

 

Pravidelně ukládejte (CTRL+S) 
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69. Pomocí  Chordal Fillet, poloměr r=2mm. 

 

   

70. Pomocí  Edge Fillet, poloměr r=1mm. 

 

   
 

 
 

 

Pravidelně ukládejte (CTRL+S) 
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Krok č.12 Vnitřní vybrání (Groove) 

71. Na rovině Bokorys vytvořte skicu (žlutě) dle obrázku. Využijte promítnutí čar z pomocné skici z Krok č.1. 

72. Klikněte na  Groove, vyberte skicu, nastavte úhly na 360°,0° a vyberte osu rotace. 

 

   

Krok č.13 Zaoblení 

73. Pomocí  Edge Fillet, poloměr r=0,8mm. Vyberte vnitřní válcovou plochu. 
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Krok č.14 Sražení 0,5x45° (Chamfer) 

 

Krok č.15 Závit (Thread) 

74. Vytvořte si pomocnou rovinu Offset 8mm od roviny Nárys. Směrem do součásti. 

75. Klikněte na  Thread. Vyberte vnitřní válcovou plochu. Jako Limit Face nastavte rovinu Nárys., 

76. V části Bottom Type vyberte Up-To-Plane a vyberte rovinu.  

77. V části Numerical Definition nastavte No Standard, Thread Diametr: 60mm, Pitch: 2mm 

78. Nastavení potvrďte . 
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79. Zobrazené varování zavřete. Upozorňuje nás totiž na to, že námi tvořený závit zasahuje dále než je vybraná řídící 

plocha. To my ale v tomto případě požadujeme. 
 

 

Krok č.16 Obarvení povrchu 

80. Ve stromě prvků vybereme všechny prvky Groove dolů. A v horní nabídce vybereme odlišnou barvu, takto 

odlišíme obráběná plochy např. 
 

 
 

 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 

 
 

Krok č.17 Nastavení konečných vlastností 

81. Klikněte na  Apply material ve spodní nástrojové liště. 

82. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

83. V záložkách Knihovny (Library) vyberte Metal a Steel. Příkaz ukončete kliknutím na . 

84. Klikněte na  Measure Inertia ve spodní nástrojové liště. 

85. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

86. Klikněte na  a zaškrtněte pouze Volume, Density a Mass a potvrďte . 

87. Zaškrtněte Keep measure a potvrďte . 

88. Ve stromě vyberte Geometrical Set.1 a klikněte na  Hide/Show. 

 

 
 

Nezapomeňte uložit (CTRL+S) 
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10.CVIČENÍ 

CÍL 

Vytvoření těla mlýnku na maso. Mlýnek je odlévaný a zeleně vyznačené plochy jsou po odlití obrobené plochy. 
 

 

PŘEDPOKLADY 

 Připravená šablona ze cvičení 0. 

 Nutná znalost základů modelování součástí z předchozích cvičení. 

NOVĚ PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Triangle Edge 

 Modul pro tvorbu ploch 
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Krok č.1 Vytvoření nové součásti 

1. V nástrojové liště klikněte na tlačítko . 
2. Otevřete si šablonu z předešlého cvičení.  

3. V nabídce File vyberte Save As. 
4. Vyberte složku pro uložení součásti. 

5. Jako File name zadejte 10_TELO 

6. Potvrďte tlačítkem . 

 
 

 
 

Krok č.2 Pomocné skici 

7. V horních nabídkách vyberte Insert -> Geometrical Set. 

8. Pojmenujte nový set jako „Pomocné skici“ Jako Father nastavte Geometrical Set.1 a potvrďte . 
9. Přidejte další sety s názvy Kuzel a Telo (ty využijeme později). 

10. Nastavte Pomocné skici jako objekt, v kterém budeme tvořit skici. 

11. Klikněte na  a vytvořte skicu na rovině Nárys dle obrázku a pojmenujte ji P_TELO 

 Tato skica bude sloužit jako kostra celé části modelu, obsahuje nejdůležitější rozměry této části modelu a budeme k ní 
vazbit prvky tvořící model. 

 

 
 

 
 

 
 

 

V názvech souborů nepoužívejte diakritiku ani speciální znaky. 
Potřebujete-li v názvu souboru mít mezeru, použijte podtržítko “_“. 

 

Více informací o tvorbě skici viz předešlá cvičení. 

 

Pravidelně ukládejte (CTRL+S) 
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12. Klikněte na  a vytvořte pomocnou rovinu pro nohu. Offset 3mm. Poté přejmenujte R_NOHA. 
 

  
 

13. Klikněte na  a vytvořte skicu na rovině Nárys dle obrázku a pojmenujte ji P_NOHA_1. 
 

 

! Pomocná rovina ! 
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14. Klikněte na  a vytvořte skicu na pomocné rovině dle obrázku a pojmenujte ji P_NOHA_2. 

15. Bod.1 vytvořte pomocí  Intersect 3D Element. 
16. Oblouky o poloměru R42 a R24 jsou soustředné a jejich střed leží na rovině symetrie. 

 

 
 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 

Bod.1 

Bod.1 

Více informací o tvorbě skici viz předešlá cvičení. 

 

Pravidelně ukládejte (CTRL+S) 
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Krok č.3 Tvorba profilu kuželu 

17. Nastavte Kuzel (Geometrical set) jako objekt, v kterém budeme tvořit skici. 

 
 

 

18. Vytvořte pomocnou rovinu 62mm od roviny Půdorys. 
 

 

19. Pomocí  Elipse, vytvořte elipsu na pomocné rovině, s počátkem v souřadnicovém systému, dle obrázku. 

 

  

20. Pomocí  Elipse, vytvořte elipsu na rovině Půdorys, s počátkem v souřadnicovém systému, dle obrázku. 
 

  

Pro přehlednost lze skrýt geometrical set - Pomocné roviny. 
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Krok č.4 Tvorba řídících křivek 

21. Vytvořte skicu, na rovině Nárys (viz. obr. vlevo) a na rovině Bokorys (viz. obr. vpravo)  dle obrázku .  

 
 

 

  
 

22.   Pomocí nabídky Start -> Shape -> Generative Shape Design se přepněte do modulu pro plochy. 

23. Klikněte na  Symmetry v boční nástrojové liště (Transformations). 
 

 
 

24. Vyberte jednu křivku (Sketch), a jako Reference nastavte rovinu symetrie pro tuto křivku. 
25. Zopakujte předešlý krok i pro druhou křivku (Sketch). 

 

  

V tomto případě spline křivku nekótujeme. Křivku budeme moci kdykoliv volně zeditovat a tím měnit profil kužele. 

 

K výběru příkazů můžete využít horní nabídku Insert -> Operations…  
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Alternativní způsob tvorby křivek 

Krok č.4b Tvorba řídících křivek (Free Style) 

26. Pomocí nabídky Start -> Shape -> Generative Shape Design se přepněte do modulu pro plochy. 

27. Klikněte na   Extremum a vyberte horní elipsu. Jako Direction nastavte rovinu Bokorys. 

28. Pokud se nezobrazí bod, klikněte na  a potvrďte . 
 

 

29. Klikněte na   Extremum a vyberte horní elipsu. Jako Direction nastavte rovinu Nárys. 

30. Pokud se nezobrazí bod, klikněte na  a potvrďte . 
 

 

31.  Stejným postupem vytvořte dva body na spodní elipse. 
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32. Pomocí nabídky Start -> Shape -> Free Style se přepněte do modulu pro plochy. 

33. Klávesou F6 si zapněte panel potřebný pro správnou tvorbu 3D křivky a zapněte Most Seen Place. 

       
 

 
 

 
 

34. Klikněte na  3D Curve v nabídce nastavte Through points. 
35. Vyberte bod na horní elipse. Při výběru bodu počkejte na zobrazení červené čárkovaná 

kružnice. 
36. Nastavte si pohled na Front View, tímto se automaticky přepne, v horní lište, na yz rovinu. 

Pokud budeme tvořit další body, budou se tvořit v této rovině. 
37. Vytvořte další bod křivky. Pokud potřebujete přesunout bod, neklikejte na vytvořený bod, uchopte za šipku, 

podle směru v kterém potřebujte šipku posunout. 

 

  
 

38. Vytvořte další bod a uzavřete křivku výběrem spodního bodu. 

39. Přiblížením k vytvořeným bodům se zobrazí manipulační šipky. Pomocí nich nastavte tvar křivky a potvrďte 

. 
 

  
 

 
 

 

 
 

Most Seen Place 
Tato funkce Vám automaticky přepíná mezi prvními třemi ikonami v závislosti na natočení modelu. Toho využijeme v následném kroku při 
tvorbě 3D křivek. 

Pravidelně ukládejte (CTRL+S) 

 

Editaci křivky můžete provést poklikáním na ni a posunutím bodů. 
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40. Stejným způsobem propojte druhé dva body. Pouze pohled natočení nyní vyberte Left View. 

 

 

41. Nyní už pouze pomocí  Symmetry přezrcadlete obě křivky. 
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Krok č.5 Tvorba Plochy (Generative Shape Design) 

42. Klikněte na  Multi-sections Surace v boční nástrojové liště. 

43. Vyberte obě elipsy. 

44.  Přemístěte Closing Point (pravým tlačítkem a Replace) na jednu z křivek viz. obrázek, a zkontrolujte orientaci 
šipek. 

45. Pokud kliknete na  vytvoří se lineární kuželová plocha. Která neodpovídá požadovanému tvaru. 
 

  

46. Klikněte do záložky Guides a vyberte všechny 4 křivky. Zobrazená plocha zčervená, což značí, že neodpovídá 

aktuálnímu nastavení, proto klikněte na  a . 

 

 

47. Ve stromě prvků vyberte všechny pomocné skici a prvky symetrie a skryjte je.  
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ALTERNATIVNÍ TVORBA PLOCHY (FREE STYLE) 

Krok č.5b Tvorba Plochy 

48. Klikněte na   Net Surface. 
49. Vyberte řídící křivky, přidržením klávesy Shift a výběrem křivky. 

 

 

50. V okně přepněte na profiles (0) a vyberte profily, přidržením klávesy Shift a výběrem křivky. 

 

 

51. Klikněte na   a potvrďte . 
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Krok č.6 Tvorba profilu těla 

 Pracujeme v prostředí Generative Shape Design. 

52. Přepněte se do Telo (geometrical set) a Kuzel (geometrical set) prozatím skryjte. 

53. Zobrazte si pomocnou skicu P_TELO. 

54. Pomocí  Plane vytvořte rovinu dle obrázku. Použijte Parallel through point.  

 

 

55. Na vytvořenou rovinu vytvořte skicu dle obrázku. 
 

 

56. Pomocí  Plane vytvořte rovinu dle obrázku. Použijte Parallel through point.  
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57. Na vytvořenou rovinu vytvořte skicu dle obrázku. 

 

 

58. Skryjte si skicu P_TELO 

59. Klikněte na  Multi-section Surace a vyberte oba profily. 

60. Vyberte záložku Coupling a vyberte první bod na první skice, a poté stejný bod na druhé skice. 
 

 
 

61. Takto spojte další dva body. 
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62. Zkontrolujte orientaci šipek, klikněte na  a . 

 

 
 
 

 
 

63. Klikněte na  Rotate a vyberte vytvořenou plochu. 

64. Vyberte osu rotace (Osa X). Uhle rotace nastavte 45deg. 

65.  Zaškrtněte Repeat object after OK a potvrďte . 
 

 
 

66. Instance zadejte 6, odškrtněte Create in a new Body a potvrďte . 

 

 

Pravidelně ukládejte (CTRL+S) 
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67. Klikněte na  Join a vyberte všechny plochy, klikněte  a potvrďte . 

 

 

Krok č.7 Tvorba modelu těla 

68. Přepněte se do modulu tvoření těles Start -> Mechanical Design -> Part Design 
69. Nastavte PartBody jako objekt v kterém se budou tvořit prvky. 

70. Klikněte na   Thick Surface a vyberte pomocnou plochu Telo. 

71. First Offset nastavte 5mm, šipky nasměrujte od plochy ven a klikněte . Poté potvrďte . 

 

 

72. Nyní přerovnáme zadní část vytvořeného tělesa. Klikněte na   Split a vyberte zadní pomocnou rovinu. 
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73. Zobrazte si kuželovou plochu z kroku č.5  

74. Klikněte na   Thick Surface a vyberte pomocnou plochu Kuzel. 

75. First Offset nastavte 5mm, šipky nasměrujte od plochy ven a klikněte . Poté potvrďte . 
 

 
 

76. Jak vidíte na obrázku, objemová tělesa se protínají, což je nežádoucí. V dalších dvou krocích tedy ořežeme 

nepotřebné části tělesa plochami, které jsme si dříve připravili, abychom dostali žádaný tvar tělesa. 
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77. Klikněte na  Split a vyberte geometrical set Kuzel. Orientaci šipek nastavte směrem do části, která zůstává.  
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78. Klikněte na  Split a vyberte geometrical set Telo. Orientaci šipek nastavte směrem do části, která zůstává. 
 

 
 

 
 

79. Pro lepší přehlednost v dalším modelování skryjeme geometrical sety Kuzel a Telo. 
 

 

 
 

 

Pravidelně ukládejte (CTRL+S) 
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Krok č.8 Tvorba přední časti těla 

80. Pomocí prvku  Shaft vytvořte přední část těla. Při tvorbě skici využijte pomocnou skicu P_TELO, k promítnutí 
pomocné reference. 

81. Osu rotace nastavte Osa X. 

 Oranžově vyznačená úsečka, je promítnutá reference z pomocné skici P_TELO. 

 

 

  
 
 

 

 
 

 
 

 
 

Pravidelně ukládejte (CTRL+S) 

 

Více informací o tvorbě prvku Shaft(Rotace) viz předešlá cvičení. 
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Krok č.9 Tvorba zadní časti těla 

82. Pomocí prvku  Shaft vytvořte zadní část těla. Při tvorbě skici využijte pomocnou skicu P_TELO, k promítnutí 
pomocné reference. 

83. Osu rotace nastavte Osa X. 

 Oranžově vyznačená úsečka, je promítnutá reference z pomocné skici P_TELO. 

 

 
 

 

 
 

 
 

 
 

 

 
 

Pravidelně ukládejte (CTRL+S) 
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Krok č.10 Tvorba hlavní části nohy 

84. Zobrazte pomocné skici P_NOHA_1 a P_NOHA_2. 
85. V nabídkách vyberte Insert -> Body. Vytvoří se nové body ve stromě, které přejmenujte na Noha. 

86. Pomocí funkce  Pad vytvořte část nohy dle obrázku. Jako hlavní skicu vyberte P_NOHA_1 a vysuňte od roviny 
2,5 mm.  
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87. Na rovině Nárys vytvořte skicu dle obrázku. 

 Oranžově vyznačená přímka, je promítnutá rovina nohy(R_NOHA). Bod je promítnutý z pomocné skici. 

 

 

88. Na rovině R_NOHA vytvořte skicu dle obrázku. 

89. Skicu vytvořte pomocí promítnutí z pomocné skici P_NOHA_2 a oříznutím. 

 

 
 

 
 

 

 

Pravidelně ukládejte (CTRL+S) 
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90.  Pomocí prvku  Rib vytvořte prvek dle obrázku. 
 

 

91. Pomocí  Plane, Normal to curve, vytvořte pomocnou rovinu dle obrázku. 
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92. Pomocí prvku  Pad vytvořte část nohy dle obrázku.  
93. Skicu vytvořte dle obrázku, vložte ji na pomocnou rovinu. 

94. K nastavení vysunutí použijte vysunutí do plochy a vyberte limitní plochu dle obrzku.  

 Jako referenci použíte promítnutou spodní hranu předešlého prvku. 
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Krok č.11 Vyztužení nohy 

95. Zobrazte si profilovou skicu z předešlého kroku. 

 Profilová skica 1 pro tvar výztuhy . 

96. Na rovinu R_HOHA vložte skicu a promítněte si prvky dle obrázku vlevo. Poté vytvořte skicu dle obrázku vpravo. 
 

  

97. Na zadní rovinu prvku Rib (Krok č.10) položte skicu a promítněte si 3 prvky dle obrázku vlevo. Poté vytvořte skicu 

dle obrázku vpravo. 
 

   

98. Na spodní rovinu nohy vložte skicu a vytvořte profil dle obrázku. 
 

 

10 - 25



99. Na rovině Nárys vytvořte vodící skicu pomocí promítnutí čar z pomocné skici P_NOHA_1 a oříznutí. 

 

 

100. Pomocí   Multi-section solid vytvořte výztuhu dle obrázku. 
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101. Na rovině Nárys vytvořte vodící skicu pomocí promítnutí čar z pomocné skici P_NOHA_1 obrázek vlevo. 

102. Vytvořte výztuhu pomocí prvku  Rib. Profilovou skicu položte a vytvořte dle obrázku vpravo. 
 

   

Krok č.12 Přezrcadlení vytvořená části 

103. Pomocí  Mirror vytvořte druhou stranu nohy. 
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Krok č.13 Vytvoření žeber nohy 

104. Na spodní straně nohy vytvořte skicu dle obrázku vlevo a poté zaoblete dle obr vpravo. 

 

   

105. Na rovině R_NOHA, vytvořte skicu pomocí promítnutí z pomocné skici P_NOHA_2. 
 

 
 
 

 
 

Pravidelně ukládejte (CTRL+S) 
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106. Pomocí  Rib žebro nohy. 
 

 

107.   Pomocí  Mirror vytvořte druhé žebro. Nejprve vyberte žebro, poté až klikněte na ikonu. 
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108. Zobrazte pomocnou rovinu z geometrical set Telo. 
109. Ořízněte vystupující část žeber do vnitřku mlýnku. 
 

   

 Spojení těla mlýnku a vytvořené nohy v jeden prvek . 

110. Pusťte příkaz z nabídky Insert -> Boolean Operations ->Add…  

111. Do Add vyberte body Noha. Do To vyberte body PartBody. A potvrďte  

 Na vytvořeném modelu se tento krok vizuálně neprojeví. Přesto dojde ke spojení dvou prvků (tělo, noha) do jednoho 
prvku. Největší změny si lze povšimnout ve stromě prvků. 
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Krok č.14 Oříznutí přední části 

112. Příkazem  Groove vytvořte přední vybrání. K tvorbě skici použijte promítnutí referencí z pomocné skici 
P_Telo. 

 Žluté úsečky jsou prumítnuté reference z P_TELO. 
 

 

Krok č.15 Výstupek na těle 

113. Vytvořte pomocnou rovinu 45mm od roviny bokorys. 
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114. Na pomocné rovině vytvořte skicu dle obrázku. 

 

 

115. Na rovinné ploše zadní části závitové hlavy vytvořte skicu dle obrázku. 

 

 

116. Příkazem   Multi-section solid  vytvořte výstupek dle obrázku. 
 

 

10 - 32



Krok č.16 Válcový spodek nohy 

117. Příkazem  Shaft vytvořte válcový spodek dle obrázku. 
 

  

118. Přepněte se modulu Generative Shape Design pro tvorbu ploch. 

119. Zobrazte si pomocnou skicu P_NOHA_1. 

120. Klikněte na  Boundary a vyberte horní válcovou plochu a nastavte limity dle obrázku. 
 

 

121. Klikněte na  Extrude a vyberte boundary křivku. 
122. Směr vytažení nastavte úsečkou z pomocné skici. A nastavte směr a velikost vytažení dle obrázku. 
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123. Přepněte zpět do objemového modulu (Mechanical design -> Part Design). 

124. Pomocí  Split ořízněte horní část nad vytvořenou pomocnou rovinou. 
 

   

Krok č.17 Symetrická zkosení pro odlévání 

125. Klikněte na  Draft angle a vyberte plochu pro zkosení. V nabídce More nastavte Parting, Draft both 
sides, jako neutral plochu vyberte rovinu Narys. 

126. Velikost zkosení nastavte 2deg klikněte na , zkontrolujte směr zkosení a potvrďte . 

 Zelená šipka určuje směr zkosení . 
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 Protože mlýnek je symetrický podle roviny Narys, bude předešlý postup používat pro všechny zobrazená zkosení. 

 

 
 
 

 

 
 

 
 

Pravidelně ukládejte (CTRL+S) 

 

Více informací o prvku Draft angle (Zkosení) viz předešlá cvičení. 
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Krok č.18 Zkosení pro odlévání 

127. Jako puding Direction vyberte úsečku u oranžové šipky 
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128. Zkoste dle obrázku. Jako Puding Direction nastavte rovinu Nárys, určuje směr sražení. 

 Zelená šipka určuje směr zkosení . Červená plocha je plocha ke sražení. Modrá plocha je neutrální plocha. 

 

 

 
 

 
 

 

 
 

Pravidelně ukládejte (CTRL+S) 
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129. Zkoste dle obrázku. Jako Puding Direction nastavte rovinu Nárys, určuje směr sražení. 
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130. Zkoste dle obrázku. Jako Puding Direction nastavte rovinu Bokorys, určuje směr sražení. 

 

 

 
 

 

 
 

 

Pravidelně ukládejte (CTRL+S) 
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Krok č.19 Zaoblení 

131. Vytvořte zaoblení dle obrázků. 

 Druhy rádiusů jsou značeny v imformativních obdelníkách: Edge Fillet –E, Variable Fillet –V, Choral Fillet - CH 

 

 

 

 

E - R10 

E – R2 

E – R2 
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E – R2 

E – R2 
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132. Zaoblení  Tritangent Fillet.  
133. Nejprve vyberte boční plochy a poté Face to remove, plocha na obrázku červeně. 

134. Takto zaoblete obě nohy. 

 

 

 

E – R2 

E – R2 
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E – R2 E – R2 

E – R1 

E – R2 
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E – R2 E – R2 

E – R1 

E – R2 
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135. Vyberte všechny venkovní hrany dle obrázku. Pozor, tři hrany, dle obrázku, nevybírejte. 
 

 

 

E – R2 

E – R2 

CH – R2 
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E – R2 E – R2 

E – R2 

E – R2 

Pravidelně ukládejte (CTRL+S) 
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136. Zelená šipka označuje vybrané hrany na jedné straně, druhé strana je symetrická. 

 

 

 
 

 
 

CH – R2 

CH – R2 
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E – R0,5 

E – R2 E – R2 

E – R2 CH – R2 E – R2 
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Krok č.20 Díra v noze 

137. Položte skicu na Pudorys a vytvořte kružnice.  

138. Pomocí  Pocket vytvořte díru dle obrázku. 
 

 
 

 
 

 
 

 
 

 

 

E – R2 E – R2 

Pravidelně ukládejte (CTRL+S) 
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Krok č.21 Oříznutí zadní část 

139. Pomocí promítnutí z pomocné skici P_TELO vytvořte skicu na rovině Nárys dle obrázku. 

140. Klikněte na  Groove a ořízněte vnitřek mlýnku. 
 

 

Krok č.22 Oříznutí přední část 

141. Pomocí promítnutí z pomocné skici P_TELO vytvořte skicu na rovině Nárys dle obrázku. 

142. Klikněte na  Groove a ořízněte vnitřek mlýnku. 
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Krok č.23 Oříznutí přední horní části 

143. Pomocí promítnutí z pomocné skici P_TELO a  Profile vytvořte skicu na rovině Nárys dle obrázku. 

144. Klikněte na  Groove a ořízněte vnitřek mlýnku. 
 

 

Krok č.24 Vnější závit 

145. Na oříznuté válcové ploše vytvořte závit M60 pomocí  Thread. 
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Krok č.25 Středící díra 

146. Spusťte příkaz  Hole. 

147. Zakotujte pozici díry dle obrázku. Díra průměr 2,5mm a hloubka 25mm. 

 

 

Krok č.26 Rovina stolu 

148. Vytvořte rovinu procházejícím bodem nožičky dle obrázku.  Pojmenujte ji ROV_STOLU. 

 

 
 
 

 
 

 

Pravidelně ukládejte (CTRL+S) 
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Krok č.27 Oříznutí nožiček 

149. Na rovině stolu vytvořte obdelník dle obrázku. 

 

 

150. Příkazem  Pocket ořízněte nožičku. 

 

 

Krok č.28 Sražení hran 

     

1,5x45° 
 

1x45° 1x45° 
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Krok č.29 Obarvení prvků 

151. Vyberte prvky dle obrázku a obarvěte je zelenou barvou. 

 

     

 

Krok č.30 Nastavení konečných vlastností 

152. Klikněte na  Apply material ve spodní nástrojové liště. 
153. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

154. V záložkách Knihovny (Library) vyberte Metal a Steel. Příkaz ukončete kliknutím na . 

155. Klikněte na  Measure Inertia ve spodní nástrojové liště. 
156. Ve stromě vyberte položku Part1, aby se vybrala celá součást. 

157. Klikněte na  a zaškrtněte pouze Volume, Density a Mass a potvrďte . 

158. Zaškrtněte Keep measure a potvrďte . 

159. Ve stromě vyberte Geometrical Set.1 a klikněte na  Hide/Show. 
 

 

 
 

 
 

 
 

Nezapomeňte uložit (CTRL+S) 
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11.CVIČENÍ 

CÍL 

Vytvoření sestavy mlýnku na maso vložením jednotlivých komponent do sestavy a jejich zavazbením. 

  

 

PŘEDPOKLADY 

 Vymodelované nebo stažené modely součástí sestavy. 

 Základy tvorby vazeb z předešlého cvičení 4. 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Vložení komponenty (Existing Component) 

 Rozpad sestavy (Explode) 
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Krok č.1 Vytvoření nové sestavy 

1. Přes nabídku Start -> Mechanical Design -> Assembly Design 

spustíte modul pro tvorbu sestavy. 
2. Přes nabídku File -> Save nebo CTRL+S, uložte sestavu pod 

názvem 11_MLYNEK. 
3.  

 
 

 

 

Krok č.2 Vložení těla 

4. Klikněte na  Existing Component v boční nástrojové liště. 

5. Po kliknutí se zdánlivě nic nestalo, ačkoliv v dolní informativní lište se zobrazilo… 
 

       
 

      … klikněte na část, do které bude existující komponent vložen. 

6. Proto klikněte ve stromě prvků na Product1. 
7. V otevřené nabídce vyberte model 10_TELO z složky. 

Krok č.3 Obarvení vloženého komponentu 

8. Označte vložený komponent ve stromě prvků a v horní liště vyberte barvu pro tento komponent. 

 To usnadní přehlednost a orientaci v sestavě, zvláště pokud má sestava mnoho komponentů. 

 

 

 

V názvech souborů nepoužívejte diakritiku ani speciální znaky. 
Potřebujete-li v názvu souboru mít mezeru, použijte podtržítko “_“. 

 

Jako barvu obarvení nepoužívejte červenou barvu. Tato barva je často používaná pro zobrazování chyb komponentů. 
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Krok č.4 Ukotvení těla 

9. V boční nástrojové liště klikněte na  Fix a vyberte Telo. 

 Vazba Fix uvazbí komponent ve všech směrech pohybu a otáčení, neboli těleso je nepohyblivé. 

 

    

Krok č.5 Vložení šneku 

 
 

 

 

 
 

 

 
 

 
 

 
 

Pokud se Vám zobrazí toto okno při vkládání komponentu, pomocí  a 

přejmenujte dle odpovídajícího komponentu. 
 

Pravidelně ukládejte (CTRL+S) 
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10. Klikněte na  Existing Component v boční nástrojové liště a poté opět klikněte na Product1. 

11. V otevřené nabídce vyberte 10_SNEK ze složky s modelem. 

12. Obarvěte součást viz. Krok č.4. 

13. Klikněte na  Manipulation v boční nástrojové liště a posuňte si šnek mimo tělo mlýnku. 

 Více o příkazu Manipulation viz Kapitola 04_SROUB_KLIKY. 

 

 

Krok č.6 Uvazbení šneku 

14. Klikněte na  Coicidence Constraint a ve stromě prvků vyberte Osa X u těla a u šneku. 

15. Po vytvoření vazby klikněte na  Manipulation v boční nástrojové liště a posuňte si šnek mimo tělo mlýnku. 
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16. Klikněte na  Contact constraint vyberte plochy dle obrázku. 

 

    

17. Po vytvoření vazby můžete pomocí  Manipulation zkontrolovat, že šnek se může pouze otáčet kolem osy X. 
18. Kontrolu můžete provést též přes nabídku Analyze -> Constraints… Protože jediný pohyb, který může šnek 

vykonávat, je rotace kolem osy x, bude stupeň volnosti 1. 

 Více o příkazu Manipulation viz Kapitola 04_SROUB_KLIKY. 

 Více o příkazu Analyze Constraints viz Kapitola 04_SROUB_KLIKY. 

Krok č.7 Vložení kliky 

19. Klikněte na  Existing Component v boční nástrojové liště a poté opět klikněte na Product1. 

20. V otevřené nabídce vyberte 07_KLIKA ze složky s modelem. 
21. Obarvěte součást viz. Krok č.4. 

22. Klikněte na  Manipulation v boční nástrojové liště a posuňte si kliku mimo tělo mlýnku. 

 Více o příkazu Manipulation viz Kapitola 04_SROUB_KLIKY. 

23. Klikněte na  Offset Constraint a vyberte plochy dle obrázku. 
24. Vzdálenost Offset nastavte 0mm a zkontrolujte natočení kliky 
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25. Klikněte na  Coicidence Constraint vyberte plochy dle obrázku. 

 

 

26. Klikněte na  Quick Constraint a vytvořte vazbu mezi rovinou Nárys u šneku a rovinou Bokorys u kliky. Tato 

vazba vytvoří správné ustavení kliky a šneku. 
 

   

27. Po vytvoření vazby můžete pomocí  Manipulation zkontrolovat, že šnek se může pouze otáčet kolem osy X. 
28. Kontrolu můžete provést též přes nabídku Analyze -> Constraints… Protože jediný pohyb, který může klika 

vykonávat, je rotace kolem osy x, bude stupeň volnosti 1. 

 Více o příkazu Manipulation viz Kapitola 04_SROUB_KLIKY. 

 Více o příkazu Analyze Constraints viz Kapitola 04_SROUB_KLIKY. 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 
 

Pravidelně ukládejte (CTRL+S) 
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Krok č.8 Vložení šroubu kliky 

29. Klikněte na  Existing Component v boční nástrojové liště. 

30. Klikněte ve stromě prvků na Product1. 
31. V otevřené nabídce vyberte 04_SROUB_KLIKA ze složky s modelem. 

32. Obarvěte součást viz. Krok č.4. 

33. Klikněte na  Manipulation v boční nástrojové liště a posuňte si šroub mimo tělo mlýnku. 

 Více o příkazu Manipulation viz Kapitola 04_SROUB_KLIKY. 

34. Klikněte na  Coicidence Constraint vyberte plochy dle obrázku. 
 

     

35. Klikněte na  Contact constraint vyberte plochy dle obrázku. 
 

    

36. Klikněte na  Quick Constraint a vytvořte vazbu mezi rovinami Bokorys u kliky a šroubu.  
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37. Po vytvoření vazby můžete pomocí  Manipulation zkontrolovat, že šnek se může pouze otáčet kolem osy X. 

38. Kontrolu můžete provést též přes nabídku Analyze -> Constraints… Protože jediný pohyb, který může šroub 

vykonávat, je rotace současně s klikou, bude stupeň volnosti 1. 
 

 

Krok č.9 Vložení rukojeti  

39. Klikněte na  Existing Component v boční nástrojové liště, klikněte ve stromě prvků na Product1. 
40. V otevřené nabídce vyberte 02_RUKOJET ze složky modelem. 

41. Obarvěte součást viz. Krok č.4. 

42. Klikněte na  Manipulation v boční nástrojové liště a posuňte si rukojeť mimo tělo mlýnku. 

43. Klikněte na  Coicidence Constraint vyberte plochy dle obrázku. 
 

 

44. Klikněte na  Contact constraint vyberte plochy dle obrázku. Z dalšího obrázku lze vidět, že rukojeť se sama 
otočí do požadované polohy. 
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Krok č.10 Vložení osička 

45. Klikněte na  Existing Component v boční nástrojové liště. 
46. Klikněte ve stromě prvků na Product1. 

47. V otevřené nabídce vyberte 08_OSICKA ze složky  modelem. 

48. Obarvěte součást viz. Krok č.4. 

49. Klikněte na  Manipulation v boční nástrojové liště a posuňte si osičku mimo tělo mlýnku. 

50. Klikněte na  Coicidence Constraint vyberte plochy dle obrázku. 

 

 

51. Klikněte na  Manipulation a posuňte si osička tak, abyste mohli vybrat zobrazené plochy. 
 

 

52. Klikněte na  Contact constraint vyberte plochy dle obrázku. 
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53. Po vytvoření vazeb u rukojeti a tyčky, můžete spustit   Manipulation a uchopit za rukojeť a otáčet tak celou 

klikou. 

54. Kontrolu můžete provést též přes nabídku Analyze -> Constraints… u rukojeti a kliky nyní budou 2 stupně 
volnosti. 

 

 

Krok č.11 Vložení tyčka 

55. Klikněte na  Existing Component v boční nástrojové liště. 

56. Klikněte ve stromě prvků na Product1. 

57. V otevřené nabídce vyberte 08_TYCKA ze složky s modelem. 
58. Obarvěte součást viz. Krok č.4. 

59. Klikněte na  Manipulation v boční nástrojové liště a posuňte si tyčku mimo tělo mlýnku. 

60. Klikněte na  Coicidence Constraint vyberte plochy dle obrázku. 
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61. Klikněte na  Manipulation a posuňte si tyčku mimo tělo mlýnku. 

62. Klikněte na  Offset Constraint a vyberte plochy dle obrázku. Hodnotu Offset nastavte na 2mm, tak aby tyčka 

vyčnívala. 
 

   

Krok č.12 Vložení nůž 

63. Klikněte na  Existing Component v boční nástrojové liště. 
64. Klikněte ve stromě prvků na Product1. 

65. V otevřené nabídce vyberte 05_NUZ ze složky s modelem. 

66. Obarvěte součást viz. Krok č.4. 

67. Klikněte na  Manipulation v boční nástrojové liště a posuňte si nuž mimo tělo mlýnku. 

68. Klikněte na  Coicidence Constraint vyberte osu X u komponentů šnek a nůž. 

 Oranžově vyznačeny osy X, které si zobrazte, pokud je máte pro přehlednost skryté, ve stromě prvků. 

 

 
 

 

 
Pravidelně ukládejte (CTRL+S) 
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69. Klikněte na  Contact constraint vyberte plochy dle obrázku. 

 

 

70. Po vytvoření předešlé vazby se nůž otočí, ale neustaví do správné polohy viz. obrázek vlevo. 

71. K správnému ustavení nože (viz. obrázek vpravo) klikněte na  Quick Constraint a vytvořte vazbu mezi 

rovinami Bokorys u šneku a nože.  

 Pro usnadnění výběru rovin používejte strom prvků. 

 

    

72. Po vytvoření vazeb u nože, můžete spustit   Manipulation a uchopit za rukojeť a otáčet tak celou pohyblivou 

částí mlýnku (rukojeť, klika, šnek a nuž). 
73. Kontrolu můžete provést též přes nabídku Analyze -> Constraints… u rukojeti a kliky nyní budou 2 stupně 

volnosti a u šneku a nože pouze 1 stupeň, protože ty se otáčí pouze kolem osy X. 
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Krok č.13 Vložení sítko 

74. Klikněte na  Existing Component v boční nástrojové liště. 

75. Klikněte ve stromě prvků na Product1. 

76. V otevřené nabídce vyberte 08_SITKO ze složky s modelem. 
77. Obarvěte součást viz. Krok č.4. 

78. Klikněte na  Manipulation v boční nástrojové liště a posuňte si nuž mimo tělo mlýnku. 

79. Klikněte na  Coicidence Constraint vyberte osu X u komponentů šnek a sítko. 

 Oranžově vyznačeny osy X, které si zobrazte, pokud je máte pro přehlednost skryté, ve stromě prvků. 

 

 

80. K nastavení polohy sítka klikněte na  Angle Constraint a ve stromě prvků vyberte roviny Nárys u komponentu 
Telo a Sitko. 

81. Vyberte Sector 4 a hodnotu Angle nastavte na 19deg. 
82. Zkontrolujte zda se sítko pootočilo tak, aby tyčka a drážka v sítku byli soustředné. 
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83. Klikněte na  Contact constraint vyberte plochy dle obrázku. 

 

  

84. Pokud spustíte kontrolu přes nabídku Analyze -> Constraints… tak v záložce Degress of Freedom SITKO 

nebude vůbec uvedeno, protože má 0 stupňů volnosti, plně zavazbeno. 

Krok č.14 Vložení víčko 

85. Klikněte na  Existing Component v boční nástrojové liště. 
86. Klikněte ve stromě prvků na Product1. 
87. V otevřené nabídce vyberte 09_VICKO ze složky s modelem. 

88. Obarvěte součást viz. Krok č.4. 

89. Klikněte na  Manipulation v boční nástrojové liště a posuňte si víčko mimo tělo mlýnku. 

90. Klikněte na  Coicidence Constraint vyberte plochy dle obrázku. 
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91. Klikněte na  Contact constraint vyberte plochy dle obrázku. 

 

 

92. Pokud spustíte kontrolu přes nabídku Analyze -> Constraints… tak VICKO bude mít 1 stupeň volnosti, protože 

se může otáčet kolem své osy (šroubování). 
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Krok č.15 Vložení šroub 

93. Klikněte na  Existing Component v boční nástrojové liště. 

94. Klikněte ve stromě prvků na Product1. 
95. V otevřené nabídce vyberte 03_SROUB ze složky s modelem. 

96. Obarvěte součást viz. Krok č.4. 

97. Klikněte na  Manipulation v boční nástrojové liště a posuňte si šroub mimo tělo mlýnku. 

98. Klikněte na  Coicidence Constraint vyberte plochy dle obrázku. 
 

 

99. Zobrazte si ROV_STOLU a komponentů TELO a SROUB. 

100. Klikněte na  Offset Constraint a vyberte roviny stolu. 

101. Hodnotu Offset nastavte na -30mm. 
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Krok č.16 Vložení podložky 

102. Klikněte na  Existing Component v boční nástrojové liště. 

103. Klikněte ve stromě prvků na Product1. 
104. V otevřené nabídce vyberte 08_PODLOYKA ze složky s modelem. 

105. Obarvěte součást viz. Krok č.4. 

106. Klikněte na  Manipulation v boční nástrojové liště a posuňte si šroub mimo tělo mlýnku. 

107. Klikněte na  Coicidence Constraint vyberte plochy dle obrázku. 
 

 

108. Klikněte na  Contact constraint vyberte plochy dle obrázku. 
 

   

109. Zobrazte si druhý stupeň stromu pomocí nabídky View -> Tree Expansion 
-> Expand Second Level. 

110. U každého Produktu skryjte všechny Geometrical  Sety a roviny (Nárys, 

Půdorys, Bokorys). 
U každého produktu přejmenujte Part Number a Instance name podle toho 

jaké součásti odpovídá. (viz obrázek následné stránce). 
 

 
 

 

 
 

Product 
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111. Upravený strom prvků by měl odpovídat tomuto obrázku. 
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112. Ve stromě prvků skryjte celou část Constraint. 

 

 

113. Pokud provedete analýzu vazeb, zjistíte, že tělo a sítko jsou plně zavazbeny. Rukojeť a osička mají dva stupně 

volnosti. Ostatní součásti pouze jeden stupeň volnosti. 
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Krok č.17 Rozpad sestavy 

114. Pokud potřebujete rychle rozložit sestavu, kvůli pouhé editaci nějakého prvku klikněte na  Explode v boční 

nástrojové liště. 
115. Za Selection vyberte Product1, Fixed Product vyberte tělo. 

116. V nabídce Depth lze nastavit rozpad pouze sestavy, nebo i podsestav. 

117. V nabídce Type lze nastavit několik stylů rozpadu.  
 3D,2D rozpad – rozpad do prostor (viz. obrázek vlevo). 

 Constrained – rozpad v rovině (viz. obrázek vpravo). 

118. Po použití tohoto prvku se zaktivuje ikona  Update. A pokud na ni kliknete, sestava se opět ustaví.  

 

   

119. K vytvoření opakovatelného pohledu na rozpad klikněte na   Enchanced Scene v boční nástrojové liště. 

120. Odškrtněte Automatic Naming a do kolonky Name napište POHLED_1 a potvrďte . 
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121. Klikněte na  Explode a za Selection vyberte Product1, Fixed Product vyberte tělo. 

122. Depth nastavte First level, typ rozložení Constrained. 
 

 

123. Nyní klikněte pravým tlačítkem kříž orientace a 

zaškrtněte Snap Automatically to Selected Object. 

124. Také zaškrtněte Use Local Axis Systém. 
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125. Nyní, pokud kliknete na jakýkoliv komponent automaticky, se Vám ukáže 

pohybový kříž u komponentu. 

126. Chycením a tažením za jednu z úseček kříže můžete komponent přesunout do jakéhokoliv místa. 

127. Chycením oblouku můžete součást libovolně otáčet v této rovině. 
 

    

128. Protože sestava po příkazu Explode je zbytečně rozpadnuté do velkých pozic, přesuňte komponent dle 
obrázku. 

129. Pokud budete mít komponenty ustaveny, kombinací Ctrl + Z vrátíte orientační kříž zpět do pravého horního 
rohu. 
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130. Nastavte si pohled na rozstřel sestavy a klikněte   Save Viewpoint. 

131. Pokud ukončíte tvorbu scény pomocí , uvidíte sestavu bez jakéhokoliv rozpadu. Ale ve stromě prvků se 
vytvořila záložka Applications -> Scenes kde je náš pohled uložen. 

132. Pokud nechcete pokaždé upravovat pozici prvků, pouze pohled. Označte POHLED_1 a klasicky (Ctrl+C,Ctrl+V) 

zkopírujte pohled. 
133. V Properties změňte název pohledu. 

134. Poté dvojklikem na pohled se dostanete do prostředí pro editaci. 

135. Změňte pohled, uložte  Save Viewpoint a ukončete . 
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12.CVIČENÍ 

CÍL 

Tvorba výrobního výkresu součásti podložky sestavy mlýnku na maso. 

 

 

PŘEDPOKLADY 

 Vymodelovaný nebo stažený model součásti 08_PODLOZKA mlýnku na maso. 

 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Základy tvorby výkresů: 
o Vytváření pohledů 

o Kótování 
o Tolerance, drsnosti 

o Vyplňování razítka 
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Krok č.1 Vytvoření nového výkresu a otevření modelu 

1. V dolní nástrojové liště klikněte na tlačítko  New (CTRL+N). 

2. V zobrazené nabídce vyberte Drawing a potvrďte výběr . 

3. V části Standart vyberte typ papíru CEG2. 

4. V části Sheet Style vyberte A4 ISO a potvrďte výběr . 

5. Zaškrtněte natočení papíru Portrait. 

6. V nabídce File vyberte Save As. 
7. Nastavte složku pro uložení. 

8. Jako File name zadejte 12_PODLOZKA 
9. Potvrďte tlačítkem . 

10. Otevřete si model podložky. 
 

 

 
 

 

Krok č.2 Vytvoření základního pohledu 

11. Klikněte na  Front View v boční nástrojové liště.  
12. Nyní se přepněte do okna s modelem. 

 

 
13.  Vyberte rovinu Nárys (obr. vlevo). 

 
 

 

    

14. Nyní v pravém horním rohu uvidíte pohledový kříž pro nastavení orientace pohledu. 

 

15. Protože náš pohled je ve správné poloze, potvrďte pohled klikem mimo pohled. Nebo klikněte na vnitřní bod 

pohledového kříže. 

    

Více informací ukládání viz předešlá cvičení. 

 

V názvech souborů nepoužívejte diakritiku ani speciální 
znaky. Potřebujete-li v názvu souboru mít mezeru, 
použijte podtržítko “_“. 

 

Pomocí Windows v horním panelu nabídek. 

Model nemusíte nijak natáčet, protože v pravém dolním rohu okna se zobrazí skutečný pohled na výběr (obr. vpravo). 
Nemusíte si též dělat starosti s orientací modelu, to popřípadě ošetříte v dalším kroku. 
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16. Nyní klikněte, pravým tlačítkem, na Front View ve stromě pohledů a vyberte Properties. 

17. Do kolonky Scale nastavte měřítko 5:1. 
18. V části Dress-Up zaškrtněte zobrazení Axis. 

19. A potvrďte . 

 

 

20. Přesuňte vytvořený pohled mimo plochu papíru. 

21. Klikněte na  Offset Section View a vyberte první bod dle obrázku vlevo. 

 Pokud se přiblížíte kursorem k ose součásti, automaticky se bude kotvit na jeho osu. 

22. Vyberte druhý bod v ose modelu dle obrázku vpravo. 

23. Dvojklikem u posledního bodu (značka  ) ukončete tvorbu čáry řezu. 
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24. Nyní kursorem umístěte zobrazený model na plochu papíru. 

25. Levým tlačítkem potvrďte tvorbu řezu. 
 

 
 

 

Krok č.3 Kótování 

26. V spodní nástrojové liště zkontrolujte, zda máte aktivovány ikony dle obrázku. 
 

 
 

27. Klikněte na  Dimension v boční nástrojové liště. 

28. Nastavte si Tools Palette dle obrázku.   
 První aktivovaná ikona určuje automatické pozicování kóty dle výběru 

 Poslední aktivovaná ikona slouží k usnadnění výběru konců úseček, k výběru fiktivního rohu, … 

  

 

29. Vytvořte kótu vybráním koncových bodů čáry dle obrázku  

 

 
 

 

 
 

 

Pravidelně ukládejte (CTRL+S) 

 

12 - 4



30. Klikněte na  Diameter Dimension v boční nástrojové liště. 

31. Pokud se přiblížíte do místa fiktivního rohu (obrázek vlevo), automaticky se zobrazí značka bodu výběru. 
32. Potvrďte vybrání a stejným způsobem vyberte druhý bod a umístněte kótu dle obrázku vpravo. 

 

       

33. Klikněte na  Radius Dimension v boční nástrojové liště. 

34. Vyberte rádius a umístněte ho dle obrázku. 
 

 

35. Nyní vytvořte ostatní kóty dle obrázku. 
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36. Klikněte na  Angle Dimension v boční nástrojové liště. 

37. Vyberte čáry dle obrázku. 
38. Než potvrdíte kótu, klikněte pravým tlačítkem a vyberte Angle Sector -> Sector 2. 

 Číslo sektoru závisí na posloupnosti výběru čar. 

 

 
 

39. Umístněte kótu a potvrďte. 

 

40. Vyberte kotu 25 a v horní liště vyberte ANS_NUM2. 

 

 

41. Nyní změňte velikost tolerance ve vedlejší nabídce na hodnotu 0,50. 
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42. Pravým tlačítkem myši klikněte na kótu 1,76 a vyberte Properties.  

43. Vyberte záložku Tolerance. 
44. Do Main Value vyberte ANS_NUM2. 

45. Horní toleranci nastavte +0,3 a spodní 0. 

46. Klikněte na  a potvrďte . 
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Krok č.4 Geometrické tolerance 

47. Klikněte na  Geometrical Tolerance v boční nástrojové liště. 

48. Vyberte čáru a umístněte kótu dle obrázku. 
 

 
 

49. Vyberte tvar geometrické tolerance pro rovinnost . 
50. Hodnotu tolerance vyplňte 0,05. 

51. Nastavení potvrďte . 

 

 

Krok č.5 Drsnosti 

52. Posuňte kótu ø6 dle obrázku. 
53. Podržte Ctrl a vyberte další dvě kóty dle obrázku. (obr. vlevo). 

54. Klikněte na  Align into system v boční nástrojové liště. 

 Kóty se automaticky uspořádají (obr. vpravo). 
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55. Klikněte na  Rougness Symbol v boční nástrojové liště. 

 V místě kde kliknete se vytvoří vrchol trojúhelníku drsnosti. 

56. Vyberte vynášecí čáru kóty ø6 dle obrázku. 
57. V zobrazené nabídce nastavte tvar drsnosti. 

58. Zadejte hodnotu drsnosti Ra 6,3. 

59. Nastavení potvrďte . 
 

 

60. Stejným postupem vytvořte drsnost Ra 6,3 na kótě  ø25±0,50. 
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Krok č.6 Vyplnění vlastností modelu 

61. Přepněte se do okna s modelem. 

62. Klikněte pravým tlačítkem na Product (Podlozka) a vyberte Properties. 
63. Vyberte záložku Product. 

64. Zkontrolujte že, v části Part Number je napsán název součásti (PODLOZKA). 

 

 

65. Klikněte na . 

66. Vedle  vyberte hotnotu String a poté klikněte na . 

67. Přejmenujte String.1 na Material. 
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68. Nyní vyberte hodnotu Mass a klikněte na . 

69. Vytvořený parametr Mass.1 přejmenujte na Weight. 

70. Nabídku potvrďte . 

 

 

71. Nastavení properties nyní potvrďte . 
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72. Klikněte na  Formula v dolní nástrojové liště. 

73. Filter Type nastavte a User Parameters. 

74. Vyberte parametr „…\material“ a klikněte na . 

75. Nyní vyberte ve stromě prvků na parametr ‘Material‘ a potvrďte . 
 

 

76. Vyberte parametr „…\Weight“ a klikněte na . 

77. Nyní vyberte ve stromě prvků v části InertiaVolume na parametr ‘Mass‘ a potvrďte . 

 

 

78. Potvrďte nastavení parametrů . 

79. Pokud změníte název materiálu, tento název se bude zobrazovat ve vlastnostech. 
 

 

 
 

 
 

 

Pravidelně ukládejte (CTRL+S) 

 

Tyto dva parametry využijeme při tvorbě soupisky u sestavy.  
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Krok č.7 Vložení rámečku, razítka a doplnění informací. 

80. Přepněte se do okna s výkresem. 

81. V horní nabídce vyberte Edit -> Sheet Background. 
 

 

82. Klikněte na  Frame and Title Block v boční nástrojové liště. 
83. Zobrazí se okno Manage Frame And Title Block. 

 

 

84. V nabídce Style of Title Block vyberte styl ZCU_Drawing_Titleblock. 

85.  V nabídce Action vyberte Create a klikněte na . 

 

 
 

 

Tímto jste se přepnuli do editace pozadí papíru, zde nelze editovat pohledy.  
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86. Vyberte DesignedBy a klikněte na . 

87. Do zobrazeného okna napište svoje jméno a potvrďte . 

88. V razítku se nyní vyplnila kolonka Kreslil. 

    

89. Pro vyplnění čísla výkresu dvojklikem na textové pole XXX-XX-XXXX spustíte okno pro editaci. 

90. Vyplňte libovolným textem (ZCU-04-001). 

 

 

91. V horní nabídce se přepněte pomocí Edit -> Working View zpět do pracovního prostředí 
92. Uložte výkres (CTRL+S) 

 
 

 

 
 

 

 
 

 

Pokud byste něco změnili ve vlastnostech modelu. Musíte se přepnout opět do pozadí, spustit tvorbu rámečku 

 Frame and Title block a vybrat možnost Update a kliknout na . 

NEZAPOMEŇTE ULOŽIT (CTRL+S) 
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13.CVIČENÍ A 

CÍL 

Tvorba výrobního výkresu součásti podložky sestavy mlýnku na maso. 

  

 

PŘEDPOKLADY 

 Vymodelovaný nebo stažený model součástí 08_TYCKA mlýnku na maso. 

 Znalost tvorby pohledů, kótování, tvorba drsnosti,… z předešlých cvičení. 

 Vkládání razítka 

 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Opakování tvorba pohledu, kótování,… 
 Chamfer Dimension 
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Krok č.1 Vytvoření nového výkresu a otevření modelu 

1. V dolní nástrojové liště klikněte na tlačítko  New (CTRL+N). 

2. V zobrazené nabídce vyberte Drawing a potvrďte výběr . 

3. V části Standart vyberte typ papíru CEG2. 
4. Zaškrtněte natočení papíru Portrait. 

5. V části Sheet Style vyberte A4 ISO a potvrďte výběr . 

6. V nabídce File vybereme Save As. 
7. Nastavte složku pro uložení. 

8. Jako File name zadejte 13_OSICKA 
9. Potvrďte tlačítkem . 

10. Otevřete si model osičky. 
 

 

 
 

 

Krok č.2 Vytvoření základního pohledu 

11. Klikněte na  Front View v boční nástrojové liště.  
12. Přepněte se do okna s modelem a vyberte rovinu Nárys. 
 

 

13. Nastavte orientaci dle obrázku a vytvořte pohled. 
 

 
 

 

 
Pravidelně ukládejte (CTRL+S) 

 

V názvech souborů nepoužívejte diakritiku ani speciální 
znaky. Potřebujete-li v názvu souboru mít mezeru, 
použijte podtržítko “_“. 

 
Více informací ukládání viz předešlá cvičení. 
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14. Nyní klikněte, pravým tlačítkem, na Front View ve stromě 

pohledů a vyberte Properties. 
15. Do kolonky Scale nastavte měřítko 2:1. 

16. V části Dress-Up zaškrtněte zobrazení Axis. 

17. A potvrďte . 
 

 

Krok č.3 Kótování 

18. Klikněte na  Dimension v boční nástrojové liště. 

19. Nastavte si Tools Palette dle obrázku.   
 

 

20. Jako první čáru vyberte spodní plochu hlavy (obr. vlevo). 

21. Jako druhou čáru vyberte oblouk hlavy (obr. vpravo). 

 
 

                       
 

 
 

 

 
 

 
 

 

 

Pozor! Po vybrání oblouku následuje ještě další krok, než umístíte a potvrdíte kótu. 

Pravidelně ukládejte (CTRL+S) 
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22. Klikněte pravým tlačítkem a vyberte Extension Line Anchor -> Anchor 1. 

 

  

23. Nyní kótu umístněte a potvrďte. 
 

 

24. Klikněte na  Dimension v boční nástrojové liště a vytvořte kotu dle obrázku. 

 

 

25. Klikněte na  Chamfer Dimension v boční nástrojové liště a vytvořte kotu dle obrázku. 
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26. Klikněte na  Dimension v boční nástrojové liště a vytvořte kotu dle obrázku. 

 

 

27. Na vytvořené kótě 0,2 klikněte pravým tlačítkem a vyberte Properties. 
28. Vyberte záložku Dimension Text. 

29. Za Main Value napište x45°. 

30. Potvrďte . 
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31. Klikněte na  Radius Dimension v boční nástrojové liště a vytvořte kotu dle obrázku. 

 

 

32. Klikněte na  Radius Dimension v boční nástrojové liště a vytvořte kotu dle obrázku. 

 

 

33. Klikněte na  Diameter Dimension v boční nástrojové liště a vytvořte kotu dle obrázku. 
34. V horní liště nastavte pro tuto kótu toleranci TOL_ALP1 a hodnotu H8 přepište na h8. 
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35. Klikněte na  Diameter Dimension v boční nástrojové liště a vytvořte kotu dle obrázku. 

 

 

Krok č.4 Přerušený pohled 

36. Klikněte na  Broken View v boční nástrojové lište. 

37. Klikněte do místa, kde chcete, aby přerušení začínalo. 

38. Dalším klikem potvrďte, že vertikální tvorbu přerušení. 

 

39. Kliknutím nastavte vzdálenost přerušení. 

 

 

40. Dokončení tvorby přerušení potvrdťe klikem v libovolném místě. 
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Krok č.5 Drsnost 

41. Klikněte na  Rougness Symbol v boční nástrojové liště. 

42. Vyberte válcovou plochu dle obrázku. 

43. Zadejte hodnotu drsnosti Ra 1,6. 

44. Nastavení potvrďte . 

 

 

45. Nyní vytvořte volně na papíře drsnosti Ra 1,6 a Ra 6,3. 
46. Tyto drstnosti umístněte do pravého horního rohu rámečku. 

47. Pomocí  Text poté vytvořte závorky. 

 

Krok č.6 Vyplnění vlastností modelu 

48. Přepněte se do okna s modelem. 

49. Klikněte pravým tlačítkem na Product (OSICKA) a vyberte 
Properties. 

50. Vyberte záložku Product. 
51. Zkontrolujte že, v části Part Number je napsán název součásti 

(OSICKA). 
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52. Klikněte na . 

53. Vedle  vyberte hodnotu String a poté klikněte na . 
54. Přejmenujte String.1 na Material. 

55. Nyní vyberte hodnotu Mass a klikněte na . 
56. Vytvořený parametr Mass.1 přejmenujte na Weight. 

57. Nabídku potvrďte . 
 

 

58. Nastavení properties nyní potvrďte . 
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59. Klikněte na  Formula v dolní nástrojové liště. 

60. Filter Type nastavte a User Parameters. 

61. Vyberte parametr „…\material“ a klikněte na . 

62. Nyní vyberte ve stromě prvků na parametr ‘Material‘ a potvrďte . 
 

 

63. Vyberte parametr „…\Weight“ a klikněte na . 

64. Nyní vyberte ve stromě prvků v části InertiaVolume na parametr ‘Mass‘ a potvrďte . 
 

 

65. Potvrďte nastavení parametrů . 
 

 
 

 
 

 

Tyto dva parametry využijeme při tvorbě soupisky u sestavy.  
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Krok č.7 Vložení rámečku, razítka a doplnění informací. 

66. Přepněte se do okna s výkresem. 

67. V horní nabídce vyberte Edit -> Sheet Background. 
 

 

68. Klikněte na  Frame and Title Block v boční nástrojové liště. 
69. Zobrazí se okno Manage Frame And Title Block. 

 

 

70. V nabídce Style of Title Block vyberte styl ZCU_Drawing_Titleblock. 

71.  V nabídce Action vyberte Create a klikněte na . 
 

 

Tímto jste se přepnuli do editace pozadí papíru, zde nelze editovat pohledy.  
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72. Vyberte DesignedBy a klikněte na . 

73. Do zobrazeného okna napište svoje jméno a potvrďte . 
74. V razítku se nyní vyplnila kolonka Kreslil. 

 

    

75. Pro vyplnění čísla výkresu dvojklikem na textové pole XXX-XX-XXXX spustíte okno pro editaci. 

76. Vyplňte libovolným textem (ZCU-04-0003). 
 

 

77. V horní nabídce se přepněte pomocí Edit -> working View zpět do pracovního prostředí 

78. Uložte výkres (CTRL+S) 
 

 
 

 
 

 

 

 
 

Pokud byste něco změnili ve vlastnostech modelu. Musíte se přepnout opět do pozadí, spustit tvorbu rámečku 

 Frame and Title block a vybrat možnost Update a kliknout na . 

NEZAPOMEŇTE ULOŽIT (CTRL+S) 
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Krok č.1 Vytvoření nového výkresu a otevření modelu 

1. V dolní nástrojové liště klikněte na tlačítko  New (CTRL+N). 

2. V zobrazené nabídce vyberte Drawing a potvrďte výběr . 
3. V části Standart vyberte typ papíru CEG2. 

4. Zaškrtněte natočení papíru Portrait. 

5. V části Sheet Style vyberte A4 ISO a potvrďte výběr . 
6. V nabídce File vyberte Save As. 

7. Nastavte složku pro uložení. 
8. Jako File name zadejte 12_TYCKA 

9. Potvrďte tlačítkem . 
10. Otevřete si model tyčky. 

 

 
 

 
 

 

Krok č.2 Vytvoření základního pohledu 

11. Klikněte na  Front View v boční nástrojové liště.  
12. Přepněte se do okna s modelem a vyberte rovinu Nárys. 

 

 

13. Nastavte orientaci dle obrázku a vytvořte pohled. 

 

 

Více informací ukládání viz předešlá cvičení. 

 

V názvech souborů nepoužívejte diakritiku ani speciální 
znaky. Potřebujete-li v názvu souboru mít mezeru, 
použijte podtržítko “_“. 
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14. Nyní klikněte, pravým tlačítkem, na Front View ve stromě 

pohledů a vyberte Properties. 
15. Do kolonky Scale nastavte měřítko 5:1. 

16. V části Dress-Up zaškrtněte zobrazení Axis. 

17. A potvrďte . 
 

 

Krok č.3 Kótování 

18. V spodní nástrojové liště zkontrolujte, zda máte aktivovány ikony dle obrázku. 

 

 
 

19. Klikněte na  Dimension v boční nástrojové liště. 

20. Nastavte si Tools Palette dle brázku.   
 První aktivovaná ikona určuje automatické pozicování kóty dle výběru 

 Poslední aktivovaná ikona slouží k usnadnění výběru konců úseček, k výběru fiktivního rohu, … 

  

 

21. Vytvořte kótu vybráním koncových bodů čáry dle obrázku  

 

 

22. V horní liště nastavte pro tuto kótu toleranci ANS_NUM2 a hodnotu přepište 0,02 na ±1. 
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23. Klikněte na  Diameter Dimension a vytvořte kótu dle obrázku. 

 

 

24. V horní liště nastavte pro tuto kótu toleranci TOL_ALP1 a hodnotu H8 přepište na h9. 

 

 

25. Klikněte na  Chamfer Dimension v boční nástrojové liště. 

26. Přibližte se ke sražení, zobrazí se znak 312.  

 

 
27. Potvrďte výběr a umístněte kótu dle obrázku. 
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28. Stejné sražení vytvořte i na opačné straně tyčky. 

 

 

Krok č.4 Drsnost 

29. Klikněte na  Rougness Symbol v boční nástrojové liště. 

30. Vyberte válcovou plochu dle obrázku. 

31. Zadejte hodnotu drsnosti Ra 1,6. 

32. Nastavení potvrďte . 

 

 

33. Nyní vytvořte volně na papíře drsnosti Ra 1,6 a Ra 6,3. 

34. Tyto drsnosti po vložení razítka s rámečkem umístněte do pravého horního rohu rámečku. 

Krok č.5 Vyplnění vlastností modelu 

35. Přepněte se do okna s modelem. 
36. Klikněte pravým tlačítkem na Product (TYCKA) a vyberte Properties. 

37. Vyberte záložku Product. 

38. Zkontrolujte že, v části Part Number je napsán název součásti 
(TYCKA). 
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39. Klikněte na . 

40. Vedle  vyberte hodnotu String a poté klikněte na . 

41. Přejmenujte String.1 na Material. 

42. Nyní vyberte hodnotu Mass a klikněte na . 

43. Vytvořený parametr Mass.1 přejmenujte na Weight. 

44. Nabídku potvrďte . 

 

 

45. Nastavení properties nyní potvrďte . 
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46. Klikněte na  Formula v dolní nástrojové liště. 

47. Filter Type nastavte a User Parameters. 

48. Vyberte parametr „…\material“ a klikněte na . 

49. Nyní vyberte ve stromě prvků na parametr ‘Material‘ a potvrďte . 
 

 

50. Vyberte parametr „…\Weight“ a klikněte na . 

51. Nyní vyberte ve stromě prvků v části InertiaVolume na parametr ‘Mass‘ a potvrďte . 

 

 

52. Potvrďte nastavení parametrů . 
 

 
Tyto dva parametry využijeme při tvorbě soupisky u sestavy.  
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Krok č.6 Vložení rámečku, razítka a doplnění informací. 

53. Přepněte se do okna s výkresem. 

54. V horní nabídce vyberte Edit -> Sheet Background. 
 

 

55. Klikněte na  Frame and Title Block v boční nástrojové liště. 
56. Zobrazí se okno Manage Frame And Title Block. 

 

 

57. V nabídce Style of Title Block vyberte styl ZCU_Drawing_Titleblock. 

58.  V nabídce Action vyberte Create a klikněte na . 

 

 

Tímto jste se přepnuli do editace pozadí papíru, zde nelze editovat pohledy.  
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59. Vyberte DesignedBy a klikněte na . 

60. Do zobrazeného okna napište svoje jméno a potvrďte . 

61. V razítku se nyní vyplnila kolonka Kreslil. 

    

62. Pro vyplnění čísla výkresu dvojklikem na textové pole XXX-XX-XXXX spustíte okno pro editaci. 

63. Vyplňte libovolným textem (ZCU-04-0002). 

 

 

64. V horní nabídce se přepněte pomocí Edit -> Working View zpět do pracovního prostředí 

65. Uložte výkres (CTRL+S) 

 
 

 

 
 

 
 

 

 
 

Pokud byste něco změnili ve vlastnostech modelu. Musíte se přepnout opět do pozadí, spustit tvorbu rámečku 

 Frame and Title block a vybrat možnost Update a kliknout na . 

NEZAPOMEŇTE ULOŽIT (CTRL+S) 
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13.CVIČENÍ B 

CÍL 

Tvorba výrobního výkresu součásti podložky sestavy mlýnku na maso. 

  

 

PŘEDPOKLADY 

 Vymodelovaný nebo stažený model součástí 08_OSICKA mlýnku na maso. 

 Znalost tvorby pohledů, kótování, tvorba drsnosti,… z předešléhých cvičení. 

  

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Opakování tvorba pohledu, kótování,… 

 Chamfer Dimension 

 Broken View 
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Krok č.1 Vytvoření nového výkresu a otevření modelu 

1. V dolní nástrojové liště klikněte na tlačítko  New (CTRL+N). 

2. V zobrazené nabídce vyberte Drawing a potvrďte výběr . 

3. V části Standart vyberte typ papíru CEG2. 
4. Zaškrtněte natočení papíru Portrait. 

5. V části Sheet Style vyberte A4 ISO a potvrďte výběr . 

6. V nabídce File vybereme Save As. 
7. Nastavte složku pro uložení. 

8. Jako File name zadejte 13_OSICKA 
9. Potvrďte tlačítkem . 

10. Otevřete si model osičky. 
 

 

 
 

 

Krok č.2 Vytvoření základního pohledu 

11. Klikněte na  Front View v boční nástrojové liště.  
12. Přepněte se do okna s modelem a vyberte rovinu Nárys. 
 

 

13. Nastavte orientaci dle obrázku a vytvořte pohled. 
 

 
 

 

 
Pravidelně ukládejte (CTRL+S) 

 

V názvech souborů nepoužívejte diakritiku ani speciální 
znaky. Potřebujete-li v názvu souboru mít mezeru, 
použijte podtržítko “_“. 

 
Více informací ukládání viz předešlá cvičení. 
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14. Nyní klikněte, pravým tlačítkem, na Front View ve stromě 

pohledů a vyberte Properties. 
15. Do kolonky Scale nastavte měřítko 2:1. 

16. V části Dress-Up zaškrtněte zobrazení Axis. 

17. A potvrďte . 
 

 

Krok č.3 Kótování 

18. Klikněte na  Dimension v boční nástrojové liště. 

19. Nastavte si Tools Palette dle obrázku.   
 

 

20. Jako první čáru vyberte spodní plochu hlavy (obr. vlevo). 

21. Jako druhou čáru vyberte oblouk hlavy (obr. vpravo). 

 
 

                       
 

 
 

 

 
 

 
 

 

 

Pozor! Po vybrání oblouku následuje ještě další krok, než umístíte a potvrdíte kótu. 

Pravidelně ukládejte (CTRL+S) 
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22. Klikněte pravým tlačítkem a vyberte Extension Line Anchor -> Anchor 1. 

 

  

23. Nyní kótu umístněte a potvrďte. 
 

 

24. Klikněte na  Dimension v boční nástrojové liště a vytvořte kotu dle obrázku. 

 

 

25. Klikněte na  Chamfer Dimension v boční nástrojové liště a vytvořte kotu dle obrázku. 
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26. Klikněte na  Dimension v boční nástrojové liště a vytvořte kotu dle obrázku. 

 

 

27. Na vytvořené kótě 0,2 klikněte pravým tlačítkem a vyberte Properties. 
28. Vyberte záložku Dimension Text. 

29. Za Main Value napište x45°. 

30. Potvrďte . 
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31. Klikněte na  Radius Dimension v boční nástrojové liště a vytvořte kotu dle obrázku. 

 

 

32. Klikněte na  Radius Dimension v boční nástrojové liště a vytvořte kotu dle obrázku. 

 

 

33. Klikněte na  Diameter Dimension v boční nástrojové liště a vytvořte kotu dle obrázku. 
34. V horní liště nastavte pro tuto kótu toleranci TOL_ALP1 a hodnotu H8 přepište na h8. 
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35. Klikněte na  Diameter Dimension v boční nástrojové liště a vytvořte kotu dle obrázku. 

 

 

Krok č.4 Přerušený pohled 

36. Klikněte na  Broken View v boční nástrojové lište. 

37. Klikněte do místa, kde chcete, aby přerušení začínalo. 

38. Dalším klikem potvrďte, že vertikální tvorbu přerušení. 

 

39. Kliknutím nastavte vzdálenost přerušení. 

 

 

40. Dokončení tvorby přerušení potvrdťe klikem v libovolném místě. 
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Krok č.5 Drsnost 

41. Klikněte na  Rougness Symbol v boční nástrojové liště. 

42. Vyberte válcovou plochu dle obrázku. 

43. Zadejte hodnotu drsnosti Ra 1,6. 

44. Nastavení potvrďte . 

 

 

45. Nyní vytvořte volně na papíře drsnosti Ra 1,6 a Ra 6,3. 
46. Tyto drstnosti umístněte do pravého horního rohu rámečku. 

47. Pomocí  Text poté vytvořte závorky. 

 

Krok č.6 Vyplnění vlastností modelu 

48. Přepněte se do okna s modelem. 

49. Klikněte pravým tlačítkem na Product (OSICKA) a vyberte 
Properties. 

50. Vyberte záložku Product. 
51. Zkontrolujte že, v části Part Number je napsán název součásti 

(OSICKA). 
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52. Klikněte na . 

53. Vedle  vyberte hodnotu String a poté klikněte na . 
54. Přejmenujte String.1 na Material. 

55. Nyní vyberte hodnotu Mass a klikněte na . 
56. Vytvořený parametr Mass.1 přejmenujte na Weight. 

57. Nabídku potvrďte . 
 

 

58. Nastavení properties nyní potvrďte . 
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59. Klikněte na  Formula v dolní nástrojové liště. 

60. Filter Type nastavte a User Parameters. 

61. Vyberte parametr „…\material“ a klikněte na . 

62. Nyní vyberte ve stromě prvků na parametr ‘Material‘ a potvrďte . 
 

 

63. Vyberte parametr „…\Weight“ a klikněte na . 

64. Nyní vyberte ve stromě prvků v části InertiaVolume na parametr ‘Mass‘ a potvrďte . 
 

 

65. Potvrďte nastavení parametrů . 
 

 
 

 
 

 

Tyto dva parametry využijeme při tvorbě soupisky u sestavy.  
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Krok č.7 Vložení rámečku, razítka a doplnění informací. 

66. Přepněte se do okna s výkresem. 

67. V horní nabídce vyberte Edit -> Sheet Background. 
 

 

68. Klikněte na  Frame and Title Block v boční nástrojové liště. 
69. Zobrazí se okno Manage Frame And Title Block. 

 

 

70. V nabídce Style of Title Block vyberte styl ZCU_Drawing_Titleblock. 

71.  V nabídce Action vyberte Create a klikněte na . 
 

 

Tímto jste se přepnuli do editace pozadí papíru, zde nelze editovat pohledy.  
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72. Vyberte DesignedBy a klikněte na . 

73. Do zobrazeného okna napište svoje jméno a potvrďte . 
74. V razítku se nyní vyplnila kolonka Kreslil. 

 

    

75. Pro vyplnění čísla výkresu dvojklikem na textové pole XXX-XX-XXXX spustíte okno pro editaci. 

76. Vyplňte libovolným textem (ZCU-04-0003). 
 

 

77. V horní nabídce se přepněte pomocí Edit -> working View zpět do pracovního prostředí 

78. Uložte výkres (CTRL+S) 
 

 
 

 
 

 

 

 
 

Pokud byste něco změnili ve vlastnostech modelu. Musíte se přepnout opět do pozadí, spustit tvorbu rámečku 

 Frame and Title block a vybrat možnost Update a kliknout na . 

NEZAPOMEŇTE ULOŽIT (CTRL+S) 
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14.CVIČENÍ 

CÍL 

Tvorba výrobního výkresu součásti podložky sestavy mlýnku na maso. 

  

 

PŘEDPOKLADY 

 Vymodelovaný nebo stažený model součástí 08_SITKO mlýnku na maso. 

 Znalost tvorby pohledů, kótování, tvorba drsnosti,… z předešlých cvičení. 

 Přidání parametrů do Properties (vlastností). 

 Vkládaní razítka a rámečku. 

 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Opakování tvorba pohledu, kótování,… 

 Pomocné skici z modeláře  
 Šrafování 

 Odkazová čára 
 Lomený řez 

 Detail 
 Úprava a pozicování geometrických tolerancí 
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Krok č.1 Vytvoření nového výkresu a otevření modelu 

1. V dolní nástrojové liště klikněte na tlačítko  New (CTRL+N). 

2. V zobrazené nabídce vyberte Drawing a potvrďte výběr . 

3. V části Standart vyberte typ papíru CEG2. 
4. Zaškrtněte natočení papíru LANDSCAPE. 

5. V části Sheet Style vyberte A3 ISO a potvrďte výběr . 

6. V nabídce File vyberte Save As. 
7. Nastavte složku pro uložení. 

8. Jako File name zadejte 14_SITKO 
9. Potvrďte tlačítkem . 

10. Otevřete si model sítka. 
 

 

 
 

 

Krok č.2 Vytvoření základního pohledu 

11. Klikněte na  Front View v boční nástrojové liště.  
12. Přepněte se do okna s modelem a vyberte rovinu Nárys. 

 

 

13. Nastavte orientaci dle obrázku a vytvořte pohled. 

 

 

Více informací ukládání viz předešlá cvičení. 

 

V názvech souborů nepoužívejte diakritiku ani speciální 
znaky. Potřebujete-li v názvu souboru mít mezeru, 
použijte podtržítko “_“. 
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14. Nyní klikněte pravým tlačítkem na Front View ve stromě 

pohledů a vyberte Properties. 
15. Do kolonky Scale nastavte měřítko 2:1. 

16. A potvrďte . 
 

 

Krok č.4 Vytvoření plochy pro šrafy vyznačující kalení 

17. Přepněte se do okna s modelem. 

18. Položte skicu na rovinnou plochu sítka. 

19. Označte plochu, na které leží skica a klikněte na  Project Elements. 
20. Promítnuté hrany změňte na konstrukční. 
21. Pro lepší přehlednost ve stromě prvků nyní skryjte poslední vytvořený prvek  
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22. Vytvořte skicu dle obrázku. 

 využívejte vazbu Symmetry a Concetricity 

 všechny kótované rádiusy mají hodnotu 3mm 

 oranžově vyznačené kóty mají hodnotu 1mm 

 jako první si vytvořte šest pomocných úseček dle obrázku 

 nejjednodušší způsob tvorby je pomocí kružnic a následného ořezání 

 

 
 
 

 
 

23. Po vytvoření skici zobrazte model. 

24. Model uložte. 
 

 

 
 

 
 

Více informací o tvorbě skic viz. předešlá cvičení zabývající tvorbou modelů. 

 

Pravidelně ukládejte (CTRL+S) 
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25. Přepněte se zpět do okna s výkresem sítka. 

26. Klikněte pravým tlačítkem na Front View ve stromě pohledů a vyberte Properties. 
27. V části Dress-up zaškrtněte 3D Wireframe (Can be hidden). 

28. Klikněte na  a potvrďte . 

 

 

Krok č.5 Tvorba řezu 

29. Klikněte na  Aligned Section View v boční nástrojové liště. 

30. První bod vyberte v ose sítka nad středící drážkou (viz. obr. vlevo). 
31. Druhý bod vyberte ve středu sítka, znak  (viz. obr. vlevo). 

32. Třetí bod vyberte dle obrázku. 
 Při tvorbě bodu se nejprve přibližte k oranžově vyznačené úsečce. Poté nastavte bod tak, aby mezi úsečkou a 

tvořenou čarou vynikla vazba kolmosti . 
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33. Dvojklikem u posledního bodu ukončete tvorbu čáry řezu. 

34. Vytáhněte poziční okno mimo hlavní pohled a vytvořte řez. 
 

 

35. Klikněte pravým tlačítkem na šipku ve stromě pohledů a vyberte Properties. 
36. Zaškrtněte Size not dependent on view scale. 

37. Klikněte na  a potvrďte . 
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38. Pokud kvůli kótování potřebujete posunout konce čáry řezu, dvojklikem na čáru aktivujete prostředí pro její 

úpravu. 
 

 

 

39. K vytvoření vazbené čáry klikněte na  Replace Profile a vytvořte potřebou čáru (viz. obr. vpravo). 

40. Tvorbu čáry potvrďte klikem na . 

             

41. Upravte pozici označení (písmena A), uchopením a přetažením na požadované místo. 

42. Přepište popisku řezu pouze na označení řezu A-A 

 

Pozor! Při editaci čáry nedochází nyní k tvorbě automatických vazeb. Proto i při menším úpravě může dojít 
k vytvoření nesprávného řezu (viz. obr. vlevo). 
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Krok č.6 Tvorba detailu 

43. Klikněte pravým tlačítkem na základní pohled a vyberte Active View. 

 
 

44. Klikněte na  Detail v boční nástrojové liště. 

45. Vytvořte kružnici určující plochu detailu (viz. obr. vlevo). 
46. Po vytvoření kružnice se ke kurzoru ukotví nápis Scale 4:1 měřítko detailu. 

47. V místě kliku se vytvoří detail (viz. obr. vpravo). 
 

      

48. Klikněte pravým tlačítkem na Detail a spusťte Properties. 
49. Nastavte hodnotu Scale na 5:1. 

50. V View Name smažte popis Detail. 

51. Klikněte na  a potvrďte . 

 

 
 

Aktivaci pohledu lze také provést poklikáním na modrý obdélník pohledu, který následně zčervená. 
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52. V popisce smažte nápis Scale: a B přesuňte do středu měřítka. 

53. Přesuňte popisku dle obrázku. 
 

 

Krok č.7 Tvorba šraf 

54. Klikněte na   Area Fill Creation v boční nástrojové liště a klikněte do oblasti 1. 

55. Klikněte na   Area Fill Creation v boční nástrojové liště a klikněte do oblasti 2. 

 
 

     
 
 

 
 

 

 

1 

2 

Pravidelně ukládejte (CTRL+S) 
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56. Podržte CTRL a vyberte obě šrafy. 

57. Klikněte pravým tlačítkem na vybrané šrafy a spusťte Properties. 
58. Přepište hodnotu Pitch na 2mm. 

59. Klikněte na  a potvrďte . 

 

 

Krok č.7 Tvorba os 

60. Klikněte na  Center Line v boční nástrojové liště a vyberte vnější kružnici. 
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61. Klikněte na  Axis Line v boční nástrojové liště a vyberte kružnice dle obrázku vlevo. 

 

                      

62. Výběrem koncových kružnic postupně vytvořte osy dle obrázku. 

 
 
 

14 - 11



63. Pomocí  Center Line vytvořte osy u drážky na hlavním pohledu a detailu. 

 

 

Krok č.3 Kótování 

64. Klikněte na  Dimension v boční nástrojové liště a vytvořte kóty dle obrázku. 

 
 
 

 

Více informací o tvorbě kót a vkládání tolerancí viz. předešlá cvičení 12, 13a, 13b. 
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65. Klikněte na  Radius Dimension v boční nástrojové liště a vytvořte koty dle obrázku. 

 

66. Klikněte na  Diameter Dimension v boční nástrojové liště a vytvořte koty dle obrázku. 
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67. Klikněte na  Angle Dimension v boční nástrojové liště a vytvořte kóty dle obrázku. 

 

68. Klikněte na  Radius Dimension v boční nástrojové liště a vytvořte koty dle obrázku. 
69. Klikněte pravým tlačítkem na kótu a spusťte Properties. 

70. V záložce Dimension Texts vložte do kolonek před a za Main Value závorku dle obrázku. 

71. Klikněte na  a potvrďte . 
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72. Klikněte na  Dimension v boční nástrojové liště a vytvořte kóty dle obrázku. 

 

 

73. Klikněte na  Diameter Dimension a vytvořte koty dle obrázku vlevo. 

74. Klikněte na  Chamfer Dimension a vytvořte koty dle obrázku vpravo. 

75. Klikněte na  Dimension vytvořte kotu dle obrázku vpravo (vyznačena oranžově). 

 

 

                          
 
 

 

Pravidelně ukládejte (CTRL+S) 
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Krok č.4 Geometrické tolerance 

76. Klikněte na   Geometrical Tolerance v boční nástrojové liště. 

77. Vytvořte volně kótu geometrické tolerance. 

78. Vyberte znak pro soustřednost  a přepište hodnotu na 0,001. 

 

 
 

79. Klikněte na  a potvrďte . 

80. Vyberte vytvořenou toleranci. 

81. Pravým tlačítkem myši klikněte na žlutý bod a vyberte Remove Leader / Extremity 

 

82. Klikněte pravým tlačítkem na geometrickou toleranci a vyberte Orientation Link -> Create 

83. Vyberte kótovací čáru dle obrázku vpravo. 
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84. Po vybrání kóty dojde k otočení značení geometrické tolerance. 

 

                        

85. Posuňte geometrickou toleranci tak, aby se kotovací čára a spodní čára geometrické značky překrývali. 

 

                                

86. Klikněte na geometrickou toleranci a vyberte 
Positional Link -> Create a poté vyberte kótu ø8. 

 
 

 

 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

Přidržením klávesy Shift dosáhnete přesnějšího posouvání a umísťování geometrické tolerance. 

Pokud nyní budete posouvat kótou , geometrická tolerance se 
bude posouvat taktéž. 
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87. Klikněte pravým tlačítkem na kótu ø8 a vyberte Properties. 

88. Vyberte záložku Value. 
89. Nastavte hodnotu Offset tak, aby hodnota kóty ležela nad geometrickou tolerancí (8mm). 

 

 

90. Stejným způsobem vytvořte geometrickou toleranci rovinnosti  o hodnotě 0,05 u kóty šířky 5mm. 
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Krok č.5 Drsnosti 

91. Zaktivujte si pohled detailu, abyste mohli vybírat čáry. 

92. Klikněte na   Rougness Symbol v boční nástrojové liště. 
93. Drsnost volně vložte na papír poblíž oblouku u detailu drážky. Případně ji posuňte. 

94. Hodnotu drsnosti nastavte Ra 3,2 a potvrďte . 

 

 

95. Klikněte pravým tlačítkem myši na drsnost a vyberte Add Leader. 
96. Vyberte čáru oblouku. Automaticky se vytvoří vynášecí čára. 

 

 

97. Zaktivujte si pohled řezu, abyste mohli vybírat čáry. 
98. Předešlým způsobem vytvořte drsnost Ra 1,6 dle obrázku. 
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99. Vytvořte drsnost Ra 1,6. Nad drsnost připište VYSTRUZENO. 

100. Drsnost umístněte pod kótu ø8. 
 

 
 

 

101. Klikněte pravým tlačítkem myši na drsnost a vyberte Add Leader. 
102. Přidržte klávesu Shift a klikněte na spodní šipku kóty ø8. 
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103. Vytvořte drsnost Ra 0,8. Nad drsnost připište BROUSENO. 

104. Drsnost umístněte nad horní hranu sítka. 
 

 

105. Klikněte pravým tlačítkem myši na drsnost a vyberte Add Leader. 

106. Vyberte boční stranu sítka. 

 

107. Klikněte pravým tlačítkem myši na žlutý bod drsnost a vyberte Add a Breakpoint. 
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108. Přemístěním vytvořeného bodu a bílého bodu umístněte šipku tak, aby směřovala přímo na bok sítka.  

 
 

 

109. Klikněte pravým tlačítkem myši na drsnost a vyberte Add Leader. 

110. Vyberte druhou stranu sítka. 

 

111. Přidejte dva Breakpointy a umístněte je dle obrázku. 

 

 

Přidržením klávesy Shift dochází k automatické tvorbě kolmice. 
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Krok č.6 Popisky nad razítko 

112. Ve stromě prvků aktivujte Sheet.1. 

113. Klikněte na  Circle a vytvořte kružnici o průměru přibližně 3-4mm nad razítkem. 

114. Klikněte na  Area Fill Creation a vytvořte uvnitř kružnice šrafy. 

115. Otevřete vlastnosti šraf a Pitch nastavte hodnotu 2mm. 

116. Klikněte na  Text a vedle kružnice vytvořte nápis: KALENA PLOCHA 

 

117. Klikněte na  Text a vytvořte nápis: TVRDOST :min. HV 650 10 

118. Klikněte na  Text a vytvořte nápis: POCET DER ø4 = 48, Ra 3,2 

119. Umístněte text dle obrázku. 
 

 
120. Pro jednoduché posouvání všech textů současně nastavte Positional Link na vytvořenou kružnici.  

Krok č.7 Vyplnění vlastností modelu 

121. Přepněte se do okna s modelem. 
122. Klikněte pravým tlačítkem na Product (TYCKA) a vyberte Properties. 

123. Vyberte záložku Product. 
124. Zkontrolujte že, v části Part Number je napsán název součásti (TYCKA). 

125. Klikněte na . 

126. Vedle  vyberte hodnotu String a poté klikněte na . 

127. Přejmenujte String.1 na Material. 

128. Nyní vyberte hodnotu Mass a klikněte na . 

129. Vytvořený parametr Mass.1 přejmenujte na Weight. 

130. Nabídku potvrďte . 

131. Nastavení properties nyní potvrďte . 
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132. Klikněte na  Formula v dolní nástrojové liště. 

133. Filter Type nastavte a User Parameters. 

134. Vyberte parametr „…\material“ a klikněte na . 

135. Nyní vyberte ve stromě prvků na parametr ‘Material‘ a potvrďte  

136. Vyberte parametr „…\Weight“ a klikněte na . 

137. Nyní vyberte ve stromě prvků v části InertiaVolume na parametr ‘Mass‘ a potvrďte . 

138. Potvrďte nastavení parametrů . 

139. Nastavení parametrů můžete zkontrolovat v Properties, budou vyplněny hodnoty dle parametrů. 
 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 

Pravidelně ukládejte (CTRL+S) 
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Krok č.8 Vložení rámečku, razítka a doplnění informací. 

140. Přepněte se do okna s výkresem. 

141. V horní nabídce vyberte Edit -> Sheet Background. 
 

 

142. Klikněte na  Frame and Title Block v boční nástrojové liště. 
143. Zobrazí se okno Manage Frame And Title Block. 

 

 

144. V nabídce Style of Title Block vyberte styl ZCU_Drawing_Titleblock. 

145.  V nabídce Action vyberte Create a klikněte na . 

 

 
 

 
 

Tímto jste se přepnuli do editace pozadí papíru, zde nelze editovat pohledy.  
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146. Vyberte DesignedBy a klikněte na . 

147. Do zobrazeného okna napište svoje jméno a potvrďte . 

148. V razítku se nyní vyplnila kolonka Kreslil. 

    

149. Pro vyplnění čísla výkresu dvojklikem na textové pole XXX-XX-XXXX spustíte okno pro editaci. 

150. Vyplňte libovolným textem (ZCU-03-0004). 
 

 

151. V horní nabídce se přepněte pomocí Edit -> Working View zpět do pracovního prostředí 
152. Upravte pozici popisku. 

153. Uložte výkres (CTRL+S) 

 
 

 

 
 

 

 
 

Pokud byste něco změnili ve vlastnostech modelu. Musíte se přepnout opět do pozadí, spustit tvorbu rámečku 

 Frame and Title block a vybrat možnost Update a kliknout na . 

NEZAPOMEŇTE ULOŽIT (CTRL+S) 
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15.CVIČENÍ 

CÍL 

Tvorba výrobního výkresu součásti podložky sestavy mlýnku na maso. 

  

 

PŘEDPOKLADY 

 Vymodelovaný nebo stažený model součástí 02_RUKOJET mlýnku na maso. 

 Znalost tvorby pohledů, kótování, tvorba drsnosti,… z předešlých cvičení. 

 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Opakování tvorba pohledu, kótování,… 
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Krok č.1 Vytvoření nového výkresu a otevření modelu 

1. V dolní nástrojové liště klikněte na tlačítko  New (CTRL+N). 

2. V zobrazené nabídce vyberte Drawing a potvrďte výběr . 

3. V části Standart vyberte typ papíru CEG2. 
4. Zaškrtněte natočení papíru Portrait. 

5. V části Sheet Style vyberte A4 ISO a potvrďte výběr . 

6. V nabídce File vyberte Save As. 
7. Nastavte složku pro uložení. 

8. Jako File name zadejte 15_RUKOJET 
9. Potvrďte tlačítkem . 

10. Otevřete si model rukojeti. 

 
 

 
 

 

Krok č.2 Vytvoření základního pohledu 

11. Klikněte na  Front View v boční nástrojové liště.  
12. Přepněte se do okna s modelem a vyberte rovinu Půdorys. 
 

 

13. Nastavte orientaci dle obrázku a vytvořte pohled. 

 

 
14. Odstraňte popisku u vytvořeného pohledu. 

 

Více informací ukládání viz předešlá cvičení. 

 

V názvech souborů nepoužívejte diakritiku ani speciální 
znaky. Potřebujete-li v názvu souboru mít mezeru, 
použijte podtržítko “_“. 

 

15 - 2



15. Nyní klikněte pravým tlačítkem na Front View ve stromě 

pohledů a vyberte Properties. 
16. Do kolonky Scale nastavte měřítko 2:1. 

17. A potvrďte . 
 

 

Krok č.3 Tvorba řezu 

18. Posuňte vytvořený pohled mimo papír 

19. Klikněte na  Offset Section View a vytvořte řez v ose rukojeti. 
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20. Smažete popisek řezu. 

Krok č.4 Úprava šrafování 

21. Podržte CTRL a vyberte obě hnědé plochy. 
22. Klikněte pravým tlačítkem myši na vybrané šrafy a vyberte Properties. 

23. Vyberte záložku Pattern. 
24. V nabídce Colloring vyberte Hatching.  

25. Klikněte na  . 

26. Vyberte alu 45   (dvojité šrafování). 

27. Vyberte záložku Hatching11 a hodnotu Pitch nastavte 5mm. 

28. Vyberte záložku Hatching22 a hodnotu Angle nastavte 135deg (°) a Pitch 5mm. 

29. Klikněte na  a potvrďte . 

 

 
 

 
 

 

Pravidelně ukládejte (CTRL+S) 
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Krok č.4 Pomocné osy pro kotování 

30. Aktivujte si tvorbu v okně řezu. 

31. Klikněte na  Line a vytvořte 4 úsečky dle obrázku. 

 

32. Podržte CTRL a vyberte vytvořené úsečky. 
33. V horní lište, vyberte tloušťku čáry (viz. obr.1) a druh čáry (viz. obr.2). 
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Krok č.5 Kotování 

34. Klikněte na  Diameter Dimension v boční nástrojové liště a zakótujte úsečky dle obrázku. 

 

 
 

35. Dvojklikem na kótu zobrazte nabídku pro její editování. 

36. Odškrtněte Drive geometry a potvrďte . 

37. Předešlý krok proveďte u dalších třech kót. 

 

 
 

 
 

 
 

 

 

Hodnota těchto kót se bude v závislosti na poloze úsečky automaticky měnit.  

Pravidelně ukládejte (CTRL+S) 
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38. Klikněte na  Dimension v boční nástrojové liště. 

39. Vytvořte kóty dle obrázku. Kóty k vytvořeným úsečkám přepište na hodnotu dle obrázku (kóty průměrů se 

automaticky upraví). 

 

40. Klikněte na  Line a vytvořte ostrý roh vyznačených rohů na obrázku. 
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41. Klikněte na  Diameter Dimension a vytvořte kóty dle obrázku. 

 

42. Klikněte na  Radius Dimension a vytvořte kóty dle obrázku. 
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43. Klikněte na  Chamfer Dimension a vytvořte kóty dle obrázku. 

 

Krok č.6 Označení povrchové úpravy 

44. Přepněte se do okna s modelem. 
45. Dle obrázku vytvořte skicu na rovině Nárys.  

 Při tvorbě skici využijte promítnutí profilu ze základní skici  

 

 
 

 

 
 

 

Pravidelně ukládejte (CTRL+S) 

 

Více informací o tvorbě skic viz. předešlá cvičení zabývající tvorbou modelů. 
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46. Přepněte se do výkresového okna. 

47. Pravým tlačítkem klikněte na pohled řezu a vyberte Properties. 
48. V záložce View aktivujte 3D Wireframe (Can be hiden). 

49. Klikněte na  a potvrďte . 

 

 
 

 

 
 

50. Vyberte nově zobrazenou čáru v pohledu řezu. 

51. V horní liště vyberte typ čáry  , v našem případě styl 32. 
 

 

 

Po aktivaci této funkce se zobrazí vytvořená skica z modelu. Pokud tuto skicu v modelu skryjete, dojde ke skrytí této čáry taktéž. Toto 
provázání pohledu s modelem lze zrušit pomocí funkce Isolate (pravým tlačítkem na pohled řezu -> Section View A-A object -> Isolate).  
Pozor! Pokud takto zrušíte provázání s modelem, pohled se nebude upravovat, pokud změníte rozměry v modelu.  
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Krok č.7 Geometrická tolerance 

52. Klikněte na  Geometrical Tolerance a vytvořte geometrickou toleranci válcovitosti   o hodnotě 0,05 na 

průměru vnitřní díry. 

   

53. Pokud se nevytvoří šipka na odkazovací čáře, přidejte ji. Pravým tlačítkem klikněte na žlutý bod a vyberte Symbol 
Shape -> a druh šipky. 

 

 
 
 

 
 

Pravidelně ukládejte (CTRL+S) 
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Krok č.8 Drsnost 

54. Klikněte na   Rougness Symbol a v pravém horním rohu vytvořte drsnost Ra 3,2. 

 

Krok č.9 Popisky 

55. Klikněte na  Text with Leader a vyberte čerchovanou čáru a vložte text BROUSIT. 
 

 

56. Klikněte na  Text a vložte text. Po vložení razítka přesuňte popisek nad razítko. 
 

 
 

 
 

UPRAVIT 
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Krok č.10 Vyplnění vlastností modelu 

57. Přepněte se do okna s modelem. 

58. Klikněte pravým tlačítkem na Product (RUKOJET) a vyberte Properties. 
59. Vyberte záložku Product. 

60. Zkontrolujte že, v části Part Number je napsán název součásti (RUKOJET). 

61. Klikněte na . 

62. Vedle  vyberte hodnotu String a poté klikněte na . 
63. Přejmenujte String.1 na Material. 

64. Nyní vyberte hodnotu Mass a klikněte na . 
65. Vytvořený parametr Mass.1 přejmenujte na Weight. 

66. Nabídku potvrďte . 

67. Nastavení Properties nyní potvrďte . 

68. Klikněte na  Formula v dolní nástrojové liště. 

69. Filter Type nastavte a User Parameters. 

70. Vyberte parametr „…\material“ a klikněte na . 

71. Nyní vyberte ve stromě prvků na parametr ‘Material‘ a potvrďte  

72. Vyberte parametr „…\Weight“ a klikněte na . 

73. Nyní vyberte ve stromě prvků v části InertiaVolume na parametr ‘Mass‘ a potvrďte . 

74. Potvrďte nastavení parametrů . 
75. Nastavení parametrů můžete zkontrolovat v Properties, budou vyplněny hodnoty dle parametrů. 
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Krok č.11 Vložení rámečku, razítka a doplnění informací. 

76. Přepněte se do okna s výkresem. 

77. V horní nabídce vyberte Edit -> Sheet Background. 
 

 

78. Klikněte na  Frame and Title Block v boční nástrojové 
liště. 

79. Zobrazí se okno Manage Frame And Title Block. 

 
 

80. V nabídce Style of Title Block vyberte styl ZCU_Drawing_Titleblock. 

81.  V nabídce Action vyberte Create a klikněte na . 

82. Vyberte DesignedBy a klikněte na . 

83. Do zobrazeného okna napište svoje jméno a potvrďte . 
 

 
 

 

 
 

 
 

 

 
 

Tímto jste se přepnuli do editace pozadí papíru, zde nelze editovat pohledy.  
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84. Pro vyplnění čísla výkresu dvojklikem na textové pole XXX-XX-XXXX spustíte okno pro editaci. 

85. Vyplňte libovolným textem (ZCU-04-0005). 
 

 
 

86. V horní nabídce se přepněte pomocí Edit -> Working View zpět do pracovního prostředí 
87. Upravte pozici popisku. 

88. Uložte výkres (CTRL+S) 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 

 
 

 

Pokud byste něco změnili ve vlastnostech modelu. Musíte se přepnout opět do pozadí, spustit tvorbu rámečku 

 Frame and Title block a vybrat možnost Update a kliknout na . 

NEZAPOMEŇTE ULOŽIT (CTRL+S) 

 

15 - 15





16.CVIČENÍ 

CÍL 

Tvorba výrobního výkresu součásti podložky sestavy mlýnku na maso. 

  

 

PŘEDPOKLADY 

 Vymodelovaný nebo stažený model součástí 03_SROUB mlýnku na maso. 

 Znalost tvorby pohledů, kótování, tvorba drsnosti,… z předešlých cvičení. 

 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Využití deaktivovaných prvků z modelu 
 Isolovaný řez 

 Průřez 

 Částečný řez 
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Krok č.1 Vytvoření nového výkresu a otevření modelu 

1. V dolní nástrojové liště klikněte na tlačítko  New (CTRL+N). 

2. V zobrazené nabídce vyberte Drawing a potvrďte výběr . 

3. V části Standart vyberte typ papíru CEG2. 
4. Zaškrtněte natočení papíru LANDSCAPE. 

5. V části Sheet Style vyberte A3 ISO a potvrďte výběr . 

6. V nabídce File vyberte Save As. 
7. Nastavte složku pro uložení. 

8. Jako File name zadejte 16_SROUB 
9. Potvrďte tlačítkem . 

10. Otevřete si model šroubu. 
 

 

 
 

 
 

Krok č.2 Vytvoření pohledů 

11. Klikněte na   Front View v boční nástrojové liště.  

12. Přepněte se do okna s modelem a vyberte rovinu Nárys. 

 

 

13. Nastavte orientaci dle obrázku a vytvořte pohled. 

 

 

Více informací ukládání viz předešlá cvičení. 

 

V názvech souborů nepoužívejte diakritiku ani speciální 
znaky. Potřebujete-li v názvu souboru mít mezeru, 
použijte podtržítko “_“. 
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14. Klikněte na  Projection View v boční nástrojové liště a vytvořte spodní pohled. 
15. Smažte popisky pohledů. 

 

 

 
 

16. Vyberte všechny pohledy a spusťte Propertes. 

17. Do kolonky Scale nastavte měřítko 2:1. 
18. V části Dress-up zaškrtněte: 

 Axis 

 Thread 

 Fillets – Boundaries 

A potvrďte . 

 
 

 

 
 

 

Pravidelně ukládejte (CTRL+S) 

 

Protože Catia je trochu neoblomná v tvorbě pohledů (viz. spodní pohled), upravíme tuto chybu překreslením 
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19. Klikněte na  Point a vyberte horní konec půl elipsy (obrázek vlevo). 

20. Vyberte vytvořený bod a klikněte na  Constraint. 

21. Vedle kurzoru se zobrazí nápis (Create) Fix, kliknutím tuto vazbu potvrďte (obrázek vpravo). 

 

 

22. Skryjte půl elipsu. 
 

  

23. Pomocí  Elipse,  Line a  Quick Trim vytvořte horní část součásti dle obrázku. 

 

 

24. Přepněte se do okna s modelem a zaktivujte dva deaktivované prvky, tvar roznýtování. 
 

 
 
 

 
Více o Aktivaci /Deaktivaci prvků viz. cvičení č. 03_SROUB.  
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25. Přepněte do okna s výkresem. 

26. Klikněte na  Update v spodní nástrojové liště. 
 

 

 Tvorba řezu. 

27. Klikněte na  Offset Section View a vytvořte částečný řez spodního pohledu dle obrázku. 

 

 
 

 
 

 
 

 

 

Více informací o tvorbě řezů viz. předešlá cvičení. 

 

Pravidelně ukládejte (CTRL+S) 

 

16 - 5



28. Smažte popisek řezu. 

29. Skryjte označení řezu na pohledu. 
30. Klikněte pravým tlačítkem myši na vytvořený řez a vyberte Propeties. 

31. Nastavte hodnotu Scale 1:1 a potvrďte . 

 

 
 

32. Klikněte pravým tlačítkem myši na vytvořený řez a vyberte Section View A-A object -> Isolate. 
33. Klikněte pravým tlačítkem myši na vytvořený řez a vyberte View Positioning -> Position Independently of 

reference View. 
 

 

34. Přepněte do okna s modelem a deaktivujte prvky roznýtování. 

35. Přepněte do okna s výkresem a klikněte na  Update. 

 

Díky tomuto nastavení nyní můžete posouvat pohled řezu nezávisle na řídícím pohledu. 
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 Tvorba bočního řezu. 

36. Klikněte na   Offset Section View v boční nástrojové liště a vytvořte řez základního pohledu dle obrázku. 

 

37. Klikněte pravým tlačítkem na vytvořený řez a vyberte Properties. 
38. Vyberte záložku View. 

39. V části View Name smažte Prefix (Section view) a přepište ID B na A. 

40. Potvrďte nastavení . 

41. Klikněte pravým tlačítkem na čáru řezu a vyberte Properties. 

42. Zaškrtněte Size not dependent on view scale a potvrďte . 

43. Popisku upravte tak, aby zůstalo pouze označení pohledu A-A. 
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 Tvorba průřezu. 

44. Klikněte na  Offset Section Cut v boční nástrojové liště. 
45. Vytvořte průřez na ose součásti dle obrázku. 

 

46. Smažte popisku průřezu a skryjte čáru průřezu. 
47. Vytvořený průřez posuňte do osy hlavního pohledu. 

 

 
 

 
 

 

Pravidelně ukládejte (CTRL+S) 
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 Tvorba částečného řezu. 

48. Klikněte na  Breakout View v boční nástrojové liště. 

49.  Vytvořte přibližný výběr dle obrázku. 

 

50. V okně 3D Viewer nastavujete pozici roviny částečného řezu. Automaticky je vybrána rovina Nárys, která je řídící 

rovinou tohoto pohledu. 

51. Potvrďte toto nastavení . 
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Krok č.3 Úprava os 

52. Označte osu, kterou chcete upravit.  

53. Pokud nyní uchopíte bílí čtverec na konci osy, posunete s ním, osa se bude symetricky prodlužovat. Což je 
nevýhoda, pokud potřebujete posunout pouze jeden konec osy. 

54. Proto podržte CTRL a poté posuňte konec osy. 

55. Takto upravte oranžově vyznačené osy dle obrázku. 

 

Krok č.4 Tvorba pomocný čar pro kótování 

56. Přepněte se do modelu a vytvořte skicu dle 

obrázku na rovině Nárys. 

 Skicu vytvořte pomocí promítnutí řídících 

skic prvků Rib a Multi-section Solid 
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57. Přepněte se do výkresu a u hlavního pohledu spusťte Properties. 

58. V záložce View v části Dress-Up aktivujte 3D Wireframe -> Is always visible. 

 

Krok č.5 Kótování 

59. Vytvořte kóty dle obrázku. 
 

 

 

Více o tvorbě kót v předešlých cvičeních. 
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60. Klikněte na  Thread Dimension v boční nástrojové liště. 

61. Vyberte závit na pohledu bočního řezu. 
 

                       

62. Klikněte na kotu 35.63 a spusťte nabídku Properties. 

63. V záložce Value zaškrtněte Fake Dimension. 
64. U Main Value přepište *Fake* na SLISOVANO. 

65. Úpravu potvrďte . 
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66. Klikněte na  Line a vyberte dva body a vytvořte tak úsečku dle obrázku. 

 

 

 

67. Zakótujte úhel dle obrázku. 

 

68. Skryjte vytvořenou úsečku a přepište hodnotu kóty na 5,9° 
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Krok č.6 Popisky 

69. Klikněte na  Text with Leader a vyberte čáru neroznýtované části spodního pohledu- 

70. Vložte text PŘI MONTAZI ROZNYTOVAT a MAXIMALNI NYTOVACI SILA 1000N . 

 

 

71. Nad razítko vložte NEKOTOVANE POLOMERY 0,5 mm pomocí  Text. 

 

Krok č.7 Vyplnění vlastností modelu 

72. Přepněte se do okna s modelem. 

73. Klikněte pravým tlačítkem na Product (SROUB) a vyberte Properties. 
74. Vyberte záložku Product. 

75. Zkontrolujte že, v části Part Number je napsán název součásti (SROUB). 

76. Klikněte na . 

77. Vedle  vyberte hodnotu String a poté klikněte na . 
78. Přejmenujte String.1 na Material. 

79. Nyní vyberte hodnotu Mass a klikněte na . 

80. Vytvořený parametr Mass.1 přejmenujte na Weight. 

81. Nabídku potvrďte . 

82. Nastavení Properties nyní potvrďte . 

83. Klikněte na  Formula v dolní nástrojové liště. 

84. Filter Type nastavte a User Parameters. 

85. Vyberte parametr „…\Material“ a klikněte na . 

86. Nyní vyberte ve stromě prvků na parametr ‘Material‘ a potvrďte  

87. Vyberte parametr „…\Weight“ a klikněte na . 

88. Nyní vyberte ve stromě prvků v části InertiaVolume na parametr ‘Mass‘ a potvrďte . 

89. Potvrďte nastavení parametrů . 
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90. Nastavení parametrů můžete zkontrolovat v Properties, budou vyplněny hodnoty dle parametrů. 

 

 
 

Krok č.11 Vložení rámečku, razítka a doplnění informací. 

91. Přepněte se do okna s výkresem. 

92. V horní nabídce vyberte Edit -> Sheet Background. 

 
 

93. Klikněte na  Frame and Title Block v boční nástrojové 
liště. 

94. Zobrazí se okno Manage Frame And Title Block. 

 
 

 
 

 
 

 

 
 

 
 

 

 
 

Tímto jste se přepnuli do editace pozadí papíru, zde nelze editovat pohledy.  
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95. V nabídce Style of Title Block vyberte styl ZCU_Drawing_Titleblock. 

96.  V nabídce Action vyberte Create a klikněte na . 

97. Vyberte DesignedBy a klikněte na . 

98. Do zobrazeného okna napište svoje jméno a potvrďte . 

 

 

99. Pro vyplnění čísla výkresu dvojklikem na textové pole XXX-XX-XXXX spustíte okno pro editaci. 

100. Vyplňte libovolným textem (ZCU-03-0006). 
 

 
 

 

 
 

 
NEZAPOMEŇTE ULOŽIT (CTRL+S) 
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17.CVIČENÍ 

CÍL 

Tvorba výrobního výkresu součásti podložky sestavy mlýnku na maso. 

  

 

PŘEDPOKLADY 

 Vymodelovaný nebo stažený model součástí 04_SROUB_KLIKA mlýnku na maso. 

 Znalost tvorby pohledů, kótování, tvorba drsnosti,… z předešlých cvičení. 

 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Izometrický pohled 
 Kóta svaru 

 Generování pozic 

 Generování soupisky 
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Krok č.1 Vytvoření nového výkresu a otevření modelu 

1. V dolní nástrojové liště klikněte na tlačítko  New (CTRL+N). 

2. V zobrazené nabídce vyberte Drawing a potvrďte výběr . 

3. V části Standart vyberte typ papíru CEG2. 
4. Zaškrtněte natočení papíru LANDSCAPE. 

5. V části Sheet Style vyberte A3 ISO a potvrďte výběr . 

6. V nabídce File vyberte Save As. 
7. Nastavte složku pro uložení. 

8. Jako File name zadejte 17_SROUB_KLIKY. Potvrďte tlačítkem . 
9. Otevřete si model sítka. 

 
 

 

 

Krok č.2 Vytvoření základního pohledu 

10. Klikněte na  Front View v boční nástrojové liště.  

11. Přepněte se do okna s modelem a vyberte rovinu Nárys. 

 

 

12. Nastavte orientaci dle obrázku a vytvořte pohled. 

 

 

V názvech souborů nepoužívejte diakritiku ani speciální 

znaky. Potřebujete-li v názvu souboru mít mezeru, 
použijte podtržítko “_“. 
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13. Nyní klikněte pravým tlačítkem na Front View ve stromě 

pohledů a vyberte Properties. 
14. Do kolonky Scale nastavte měřítko 5:1. 

15. V části Dress-Up zaškrtněte: 

 Hidden Lines 

 Thread 

 Axis. 

 3D Wireframe 

16. A potvrďte . 
17. Smažte popisku pohledu. 
 

 

18. Upravte vytvořený pohled dle obrázku. 

 Smažte dvě úsečky dle obrázku. 
 V horní liště změňte tloušťku a typ čar dle obrázku. 

 

                   
 
 

 

 
 

 
 

 
 

 

Pravidelně ukládejte (CTRL+S) 

 

Více informací o úpravě typů čar viz. předešlá cvičení (15, 16).  
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Krok č.3 Tvorba a úprava os 

19. Přepněte se do okna s modelem (sestava). 

20. Dvojklikem na PartBody součásti OKO se přepněte do prostředí pro úpravu modelu. 
21. Na rovině Nárys vytvořte skicu dle obrázku. 

 Úsečku vytvořte v horizontální ose oka 

 Středovou čáru promítněte z řídící skici prvku Rib 

 

 

22. Uložte provedenou úpravu. 

23. Přepněte zpět do pro prostředí s výkresem. 

24.  Klikněte na ikonu  Update. 
 

                       

17 - 4



25. Upravte pohled dle obrázku. 

 V horní liště změňte tloušťku a typ čar dle obrázku. 

 Protáhněte osu symetrie až nad horní část oka 

                 

Krok č.4 Tvorba průřezu 

26. Klikněte na  Offset Section Cut boční nástrojové liště. 
27. Vytvořte čáru řezu ve středu symetrie součásti oko 
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28. Smažte popisek průřezu 

29. Skryjte čáru průřezu 
30. Posuňte průřez do středu symetrie součásti. 

 

Krok č.5 Tvorba šraf 

31. Příkazem   Area Fill Creation v boční nástrojové liště vytvořte šrafy dle obrázku. 
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32. Přidržte CRTL a vyberte vytvořené šrafy. 

33. Klikněte pravým tlačítkem na výběr a spusťte Properties. 

 

34. Vyberte záložku Pattern. 

35. V nabídce Colloring vyberte Hatching.  

36. Klikněte na  . 

37. Vyberte alu 45   (dvojité šrafování). 

38. Vyberte záložku Hatching11 a hodnotu Pitch nastavte 5mm. 

39. Vyberte záložku Hatching22 a hodnotu Angle nastavte 135deg (°) a Pitch 5mm. 

40. Klikněte na  a potvrďte . 
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Krok č.6 Vložení izometrického pohledu 

41. Klikněte na  Isometric v boční nástrojové liště. 

42. Přepněte se do modeláře a nastavte si model do požadované polohy. 
 

 
 

43. Dvojklikem na jakoukoliv součást potvrdíte nastavení pohledu (automaticky se přepnete zpět). 
 

 
 
 

 

 
 

 
 

Pravidelně ukládejte (CTRL+S) 
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44. Nyní klikněte pravým tlačítkem na izometrický pohled ve stromě pohledů a vyberte Properties. 

45. Do kolonky Scale nastavte měřítko 5:1. 
 V části Dress-Up zaškrtněte: Hidden Lines, Thread, Fillets - Boundaries 

46. A potvrďte . 

47. Smažte popisku pohledu. 

 

Krok č.7 Kótování 

48. Klikněte na  Welding Symbol v boční nástrojové liště. 
49. Klikněte do vyšrafované plochy svaru. 

50. Klikněte na pozici, kde chcete značku svaru vytvořit. 
 

 

2 

1 
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51. V zobrazeném okně nastavte typ svaru koutový. 

52. Před značku svaru napište hodnotu 5 a za značku svaru hodnotu 8. 

53. Nastavení potvrďte . 
 

 

54. Okótujte pohled dle obrázku. 
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55. Klikněte na  Line a vytvořte úsečku dle obrázku (zeleně zvýrazněna). 

56. Vytvořte kótu úhlu dle obrázku. 

 

 

Krok č.7 Tvorba pozic 

57. Přepněte se do okna s modelem. 

58. Přepněte se do modulu pro tvorbu sestav Start -> Mechanical Design -> Assembly Design. 

59. Klikněte na  Generate Numbering v boční nástrojové liště. 

60. Vyberte Product1. 

61. V zobrazeném okně v části Existing numbers vyberte styl Integer: 1,2,3… 
 

 
 

62. Přepněte se do okna s výkresem. 

63. Klikněte na  Balloons Generation v boční nástrojové liště. 

 
64. Odkaz pozice 3 poté smažte. 
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Krok č.8 Popisek 

65. Nad soupisku vytvořte popisek  

 

Krok č.9 Vyplnění vlastností modelu  

66. Přepněte se do okna s modelem. 
67. Klikněte pravým tlačítkem na Product (SROUB_KLIKY) a vyberte Properties. 

68. Vyberte záložku Product. 

69. Zkontrolujte že, v části Part Number je napsán název součásti ( SROUB_KLIKY ). 

70. Klikněte na . 

71. Vedle  vyberte hodnotu String a poté klikněte na . 

72. Přejmenujte String.1 na Material. 

73. Nyní vyberte hodnotu Mass a klikněte na . 

74. Vytvořený parametr Mass.1 přejmenujte na Weight. 

75. Nabídku potvrďte . 
76. Do kolonky Material vyplňte 11 373. 

77. Nastavení Properties nyní potvrďte . 

78. Vyberte parametr „…\Weight“ a klikněte na . 

79. Nyní vyberte ve stromě prvků v části InertiaVolume na parametr ‘Mass‘ a potvrďte . 

80. Potvrďte nastavení parametrů . 

81. Nastavení parametrů můžete zkontrolovat v Properties, budou vyplněny hodnoty dle parametrů. 
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82. Nyní nastavte parametry i u jednotlivých částí sestavy (CEP, OKO). 

83. Oba přidané parametry (Material, Weight) provažte s parametry jako v předešlých cvičeních. 
 

     
 

Krok č.10 Vložení číslování a generace soupisky 

84. V horní nabídce vyberte Analyze -> Bil Of Material 

85. V zobrazeném okně klikněte na  . 
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86. Klikněte na . Přidá se nový formát, který upravíme. 
 

 

87. Klikněte na , celý levý sloupec bude prázdný. 

88. Nyní vyberte postupně v pravém sloupci uvedené hodnoty a přidejte je do levého sloupce pomocí .  

 Vyberte Number, Part Number,Product Description, Material, Definition, Weight, Quantity 

 

 
 

89. Potvrďte nastavení . 

90. Nastavení soupisky potvrďte . 
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Krok č.11 Vložení rámečku, razítka a doplnění informací. 

91. Přepněte se do okna s výkresem. 

92. V horní nabídce vyberte Edit -> Sheet Background. 

93. Klikněte na  Frame and Title Block v boční nástrojové liště. 

94. Zobrazí se okno Manage Frame And Title Block. 

 

95. V nabídce Style of Title Block vyberte styl ZCU_Drawing_Titleblock. 

96.  V nabídce Action vyberte Create a klikněte na . 

97. Vyberte DesignedBy a klikněte na . 

98. Do zobrazeného okna napište svoje jméno a potvrďte . 

 

 

99. Pro vyplnění čísla výkresu dvojklikem na textové pole XXX-XX-XXXX spustíte okno pro editaci. 

100. Vyplňte libovolným textem (ZCU-03-0007). 
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Krok č.12 Vložení a úprava soupisky 

101. Klikněte na  Bill of material v boční nástrojové liště. 

102. Přepněte se do okna se sestavou a vyberte SROUB_KLIKY. 

103. Poté klikněte mimo papír. 
 

 

104. Smažte spodní část tabulky. 

105. Přesuňte tabulku nad razítko (tabulka bude přesahovat přes razítko). 
106. Dvojklikem na tabulku se přepnete na editaci tabulky. 

 
 

107. Označte první řádek tabulky a smažte pomocí klávesy Del obsah řádku. 

108. Upravte tabulku dle obrázku. 
109. Dvojklikem do buňky provedete její editaci. 

110. Pod Definition doplňte čísla výkresů čepu a oka. 
 

 
 

111. Přesuňte popisek nad soupisku. 
 

 
 

 

 
 

 
 

 

 
 

Editace tabulky je podobná jako editace tabulek v programech Excel či Word. 

NEZAPOMEŇTE ULOŽIT (CTRL+S) 
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18.CVIČENÍ 

CÍL 

Tvorba výrobního výkresu součásti víčko sestavy mlýnku na maso. 

  

 

PŘEDPOKLADY 

 Vymodelovaný nebo stažený model součástí 09_VICKO mlýnku na maso. 

 Znalost tvorby pohledů, kótování, tvorba drsnosti,… z předešlých cvičení. 

 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Opakování tvorba pohledu, kótování,… 
 Detail 

 Přerušená kóta 

 Izometrický pohled 
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Krok č.1 Vytvoření nového výkresu a otevření modelu 

1. V dolní nástrojové liště klikněte na tlačítko  New (CTRL+N). 

2. V zobrazené nabídce vyberte Drawing a potvrďte výběr . 
3. V části Standart vyberte typ papíru CEG2. 

4. Zaškrtněte natočení papíru LANDSCAPE. 

5. V části Sheet Style vyberte A3 ISO a potvrďte výběr . 
6. V nabídce File vyberte Save As. 
7. Nastavte složku pro uložení. 

8. Jako File name zadejte 18_VICKO. Potvrďte tlačítkem . 
9. Otevřete si model víčka. 

 
 

 

 

Krok č.2 Vytvoření základního pohledu řezu 

10. Klikněte na  Front View v boční nástrojové liště.  

11. Přepněte se do okna s modelem a vyberte rovinu Nárys. 
 

 

12. Nastavte orientaci dle obrázku a vytvořte pohled. 
 

 

V názvech souborů nepoužívejte diakritiku ani speciální 
znaky. Potřebujete-li v názvu souboru mít mezeru, 
použijte podtržítko “_“. 
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13. Nyní klikněte pravým tlačítkem na Front View ve stromě 

pohledů a vyberte Properties. 
14. Do kolonky Scale nastavte měřítko 2:1. 

15. A potvrďte . 
16. Posuňte vytvořený pohled mimo papír. 

 
 

17. Klikněte na  Offset Section View v boční nástrojové liště. 

18. Vytvořte řez v ose součásti základního pohledu. Řez vytvořte na papíře. 

 
19. Smažte popisek řezu. 
20. Ve vlastnostech řezu nastavte zobrazení závitu (Thread). 

 

 
 

 
 

 
Pravidelně ukládejte (CTRL+S) 
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Krok č.3 Vytvoření detailu 

21. Klikněte na  Detail v boční strojové liště. 
22. Prvním kliknutím vyberte střed detailu, poté určete oblast 

23. Spusťte  Properties. 

24. Nastavte měřítko detailu 5:1 a popis detailu 
25. Zobrazení závitu (Thread) a Fillets – Projected Original Edges. 

26. Nastavení potvrďte . 
27. Upravte odkaz a popisku pohledu detailu.  
 

 
 

 

 
 

 
 

 

 

Pravidelně ukládejte (CTRL+S) 

 

Více informací o detailu viz. cvičení č.14.  
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Krok č.4 Vytvoření izometrického pohledu 

28. Klikněte na  Isometric v boční nástrojové liště. 

29. Přepněte se do modeláře a nastavte si model do požadované polohy. 

 

30. Nyní klikněte pravým tlačítkem na izometrický pohled ve stromě pohledů a vyberte Properties. 

31. Do kolonky Scale nastavte měřítko 2:1. 

 V části Dress-Up zaškrtněte: Thread, Fillets - Boundaries 

32. A potvrďte . 
33. Smažte popisku pohledu. 
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Krok č.5 Kótování 

34. Okótujte pohledy dle obrázku. 

 

35. Pravým tlačítkem myši klikněte na kótu ø60,5 a vyberte Dimension.25 object -> Create/Modifi Clipping 
36. Dvakrát klikněte na libovolné místo poblíž vynášecí čáry v horní části kóty. 
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37. Podržte klávesu Shift a posuňte hodnotu kóty blíže k detailu. 
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Krok č.6 Geometrické tolerance  

38. Klikněte na  Datum Feature v boční nástrojové liště. 
39. Vytvořte základnu na kótě ø60,5 mm obrázek vlevo. 

40. Klikněte na žlutý bod pravým tlačítkem, vyberte Symbol Shape ->Filled Triangle. 

 
 

                               

41. Vytvořte geometrické tolerance dle obrázku. 

 
 
 

 

 
 

 
 

 

 
 

Více informací o tvorbě geometrických tolerancí viz. předešlá cvičení. 

 

Pravidelně ukládejte (CTRL+S) 
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Krok č.6 Drsnosti 

42. Vytvořte drsnost dle obrázku. 

 

43. V pravém horním rohu vytvořte drsnosti dle obrázku. 

44. Pomocí  Text v boční nástrojové liště dotvořte závorky dle obrázku. 
45. Pro lepší přesun vytvořte pro drsnost Ra 3,2 a textové pole Positional Link a přední drsnost.  
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Krok č.7 Vyplnění vlastností modelu 

46. Přepněte se do okna s modelem. 

47. Klikněte pravým tlačítkem na Product (VICKO) a vyberte Properties. 
48. Vyberte záložku Product. 

49. Zkontrolujte že, v části Part Number je napsán název součásti (VICKO). 

50. Klikněte na . 

51. Vedle  vyberte hotnotu String a poté klikněte na . 
52. Přejmenujte String.1 na Material. 

53. Nyní vyberte hodnotu Mass a klikněte na . 
54. Vytvořený parametr Mass.1 přejmenujte na Weight. 

55. Nabídku potvrďte . 

56. Nastavení Properties nyní potvrďte . 

57. Klikněte na  Formula v dolní nástrojové liště. 
58. Filter Type nastavte a User Parameters. 

59. Vyberte parametr „…\Material“ a klikněte na . 

60. Nyní vyberte ve stromě prvků na parametr ‘Material‘ a potvrďte  

61. Vyberte parametr „…\Weight“ a klikněte na . 

62. Nyní vyberte ve stromě prvků v části InertiaVolume na parametr ‘Mass‘ a potvrďte . 

63. Potvrďte nastavení parametrů . 
64. Nastavení parametrů můžete zkontrolovat v Properties, budou vyplněny hodnoty dle parametrů. 
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Krok č.8 Vložení rámečku, razítka a doplnění informací. 

65. Přepněte se do okna s výkresem. 

66. V horní nabídce vyberte Edit -> Sheet Background. 

67. Klikněte na  Frame and Title Block v boční nástrojové liště. 

68. Zobrazí se okno Manage Frame And Title Block. 
 

69. V nabídce Style of Title Block vyberte styl ZCU_Drawing_Titleblock. 

70.  V nabídce Action vyberte Create a klikněte na . 

71. Vyberte DesignedBy a klikněte na . 

72. Do zobrazeného okna napište svoje jméno a potvrďte . 
 

 

73. Pro vyplnění čísla výkresu dvojklikem na textové pole XXX-XX-XXXX spustíte okno pro editaci. 
74. Vyplňte libovolným textem (ZCU-03-0008). 
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19.CVIČENÍ 

CÍL 

Tvorba výrobního výkresu součásti nuž sestavy mlýnku na maso. 

  

 

PŘEDPOKLADY 

 Vymodelovaný nebo stažený model součástí 05_NUZ mlýnku na maso. 

 Znalost tvorby pohledů, kótování, tvorba drsnosti,… z předešlých cvičení. 

 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Opakování tvorba pohledu, kótování,… 
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Krok č.1 Vytvoření nového výkresu a otevření modelu 

1. V dolní nástrojové liště klikněte na tlačítko  New (CTRL+N). 

2. V zobrazené nabídce vyberte Drawing a potvrďte výběr . 

3. V části Standart vyberte typ papíru CEG2. 
4. Zaškrtněte natočení papíru LANDSCAPE. 

5. V části Sheet Style vyberte A3 ISO a potvrďte výběr . 

6. V nabídce File vyberte Save As. 
7. Nastavte složku pro uložení. 

8. Jako File name zadejte 19_NUZ. Potvrďte tlačítkem . 
9. Otevřete si model nože. 

 
 

 

Krok č.2 Vytvoření základných pohledů 

10. Klikněte na  Front View v boční nástrojové liště.  

11. Přepněte se do okna s modelem a vyberte horní rovinou plochu nože. 
 

 

12. Nastavte orientaci dle obrázku a vytvořte pohled. 

 

V názvech souborů nepoužívejte diakritiku ani speciální 
znaky. Potřebujete-li v názvu souboru mít mezeru, 
použijte podtržítko “_“. 
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13. Nyní klikněte pravým tlačítkem na Front View ve stromě 

pohledů a vyberte Properties. 
14. Do kolonky Scale nastavte měřítko 2:1. 

15. Nastavte zobrazení Fillets – Boundaries. 

16. A potvrďte . 
17. Smažte popisek pohledu.  
 

  

18. Klikněte na  Projection View v boční nástrojové liště. 

19. Vytvořte promítnutý pohled dle obrázku. 
20. Smažte popisek pohledu. 

 

21. Klikněte na  Izometric a vytvořte izometrický pohled. 

22. Smažte popisek pohledu. 
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23. Klikněte pravým tlačítkem na Izometrický pohled a spusťte Properties. 

24. Nastavte měřítko Scale 2:1. 
25. Nastavte zobrazení Fillets-Boundaries. 

26. Umístněte pohled do levého horního rohu. 

 

Krok č.3 Vytvoření řezů a průřezů 

27. Klikněte na   Offset Section View a vytvořte řez základního pohledu. 
 
 

 

 
 

Nejlepší způsob tvorby čáry řezu neumístění prvního bodu ve středu nože a vytažení čáry tak, aby se zobrazil znak kolmosti. 
Po vytvoření čáry poté tuto čáru zeditujte pouze vytažením krajů čáry mimo pohled. 
 
 
 
 
 
 
uchopení  
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28. Klikněte na  Offset Section Cut a vytvořte průřez části nože 

 

29. Pro lepší přehlednost řezu vypněte zobrazení Fillets - Boundaries. 

30. Smažte popisek řezu a popisek průřezu. 
31. Skryjte šipky a popisky čáry průřezu. 

32. Upravte čáru průřezu dle obrázku. 
33. Přesuňte průřez dle obrázku. 
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Krok č.4 Vytvoření detailu 

34. Klikněte na  Detail a vytvořte detail dle obrázku. 

35. Měřítko detailu nastavte 20:1 a popisek detailu nastavte B. 

 

Krok č.5 Upravení šraf 

36. Označte šrafy, spusťte Properties a nastavte hodnotu Pitch na 2mm. 

 
 

 
 

 

 
 

 
 

Více informací o tvorbě detailů a úprav šraf viz. předchozí cvičení. 

Pravidelně ukládejte (CTRL+S) 
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Krok č.6 Trajektorie obrábění břitu frézou 

37. Přepněte se do okna s modelem. 

38. Položte skicu na rovinu Půdorys. 
39. Vytvořte skicu dle obrázku. 
 

 

40. Přepněte se zpět do výkresu. 
41. U základního pohledu spusťte 3D Wireframe – Can be hidden. 

42. Změňte tloušťku čáry a nastavte typ čerchovaná.  

 
 

 
 

Více informací o tvorbě promítnutých skic z modelu viz předešlá cvičení. 
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Krok č.7 Tvorba os a okótování 

43. Vytvořte osy a okótujte pohledy dle obrázku. 

 

44. Podržte CTRL a označte kóty dle obrázku. 

45. Spusťte vlastnosti (Properties) a vyberte záložku Text. 

46. Do kolonky Frame vyberte Oblong a potvrďte . 

47. Přepněte se na záložku Value a nastavte hodnotu Offset na 4mm. 
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Krok č.8 Drsnosti a textové popisky 

48. Doplňte do výkresu drsnosti a textové popisky dle obrázku. 

 

49. Nad razítko vytvořte popisek dle obrázku. 
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Krok č.9 Vyplnění vlastností modelu 

50. Přepněte se do okna s modelem. 

51. Klikněte pravým tlačítkem na Product (NUZ) a vyberte Properties. 
52. Vyberte záložku Product. 

53. Zkontrolujte že, v části Part Number je napsán název součásti (NUZ). 

54. Klikněte na . 

55. Vedle  vyberte hodnotu String a poté klikněte na . 

56. Přejmenujte String.1 na Material. 

57. Nyní vyberte hodnotu Mass a klikněte na . 

58. Vytvořený parametr Mass.1 přejmenujte na Weight. 

59. Nabídku potvrďte . 

60. Nastavení Properties nyní potvrďte . 

61. Klikněte na  Formula v dolní nástrojové liště. 

62. Filter Type nastavte a User Parameters. 

63. Vyberte parametr „…\Material“ a klikněte na . 

64. Nyní vyberte ve stromě prvků na parametr ‘Material‘ a potvrďte  

65. Vyberte parametr „…\Weight“ a klikněte na . 

66. Nyní vyberte ve stromě prvků v části InertiaVolume na parametr ‘Mass‘ a potvrďte . 

67. Potvrďte nastavení parametrů . 

68. Nastavení parametrů můžete zkontrolovat v Properties, budou vyplněny hodnoty dle parametrů. 
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Krok č.10 Vložení rámečku, razítka a doplnění informací. 

69. Přepněte se do okna s výkresem. 

70. V horní nabídce vyberte Edit -> Sheet Background. 

71. Klikněte na  Frame and Title Block v boční nástrojové liště. 

72. Zobrazí se okno Manage Frame And Title Block. 

 

73. V nabídce Style of Title Block vyberte styl ZCU_Drawing_Titleblock. 

74.  V nabídce Action vyberte Create a klikněte na . 

75. Vyberte DesignedBy a klikněte na . 

76. Do zobrazeného okna napište svoje jméno a potvrďte . 

 

 

77. Pro vyplnění čísla výkresu dvojklikem na textové pole XXX-XX-XXXX spustíte okno pro editaci. 
78. Vyplňte libovolným textem (ZCU-03-0009). 
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20.CVIČENÍ 

CÍL 

Tvorba výrobního výkresu součásti těla sestavy mlýnku na maso. 

  

 

PŘEDPOKLADY 

 Vymodelovaný nebo stažený model součástí 10_TELO mlýnku na maso. 

 Znalost tvorby pohledů, kótování, tvorba drsnosti,… z předešlých cvičení. 

 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Opakování tvorba pohledu, kótování,… 
 Lomený řez 

 Výřez 

 
 

 
 

 

20 - 1



 

Krok č.1 Vytvoření nového výkresu a otevření modelu 

1. V dolní nástrojové liště klikněte na tlačítko  New (CTRL+N). 

2. V zobrazené nabídce vyberte Drawing a potvrďte výběr . 

3. V části Standart vyberte typ papíru CEG2. 
4. Zaškrtněte natočení papíru LANDSCAPE. 

5. V části Sheet Style vyberte A0 ISO a potvrďte výběr . 
6. V nabídce File vyberte Save As. 

7. Nastavte složku pro uložení. 
8. Jako File name zadejte 20_TELO. Potvrďte tlačítkem . 

9. Otevřete si model těla. 

 
 

 

Krok č.2 Vytvoření pohledů 

10. Klikněte na  Front View v boční nástrojové liště.  
11. Přepněte se do okna s modelem a vyberte rovinu Bokorys. 

 

 

V názvech souborů nepoužívejte diakritiku ani speciální 
znaky. Potřebujete-li v názvu souboru mít mezeru, 
použijte podtržítko “_“. 
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12. Nastavte orientaci dle obrázku a vytvořte pohled. 

 

 

13. Nyní klikněte pravým tlačítkem na Front View ve stromě 
pohledů a vyberte Properties. 

14. Do kolonky Scale nastavte měřítko 2:1. 

15. Zapněte zobrazení Fillets – Boundaries, Thread. 

16. A potvrďte . 

 
 

 

 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 

 
 

 

Pravidelně ukládejte (CTRL+S) 
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17. Klikněte na  Projection View a vytvořte promítnutý pohled dle obrázku. 

18. Smažte popisek pohledu. 
 

 

19. Klikněte na  Isometric a vytvořte izometrický pohled. 
20. Zapněte zobrazení Fillets – Boundaries. 
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Krok č.3 Vytvoření částečného řezu 

21. Pomocí  Breakout View a vytvořte částečné řezy dle obrázku. 
 

 

Krok č.4 Vytvoření řezů 

22. Klikněte na  Offset Section View a vytvořte lomený řez dle obrázku. 
23. Všechny části čáry řezu leží v příslušných osách těla. 
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24. Klikněte na  Offset Section View a vytvořte řez dle obrázku. 
25. Čára řezu leží v ose těla mlýnku. 

 
 

 
 

 
 

 
 

 

Pravidelně ukládejte (CTRL+S) 
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26. Klikněte na  Offset Section View a vytvořte řez dle obrázku. 
27. Čára řezu leží v ose díry pro osičku. 

 

28. Klikněte na   Clipping View Profile a u vytvořeného řezu vyberte profil dle obrázku. 

29. Pro výřez změňte měřítko na 5:1. 

 

            
 

 
 

 

Pravidelně ukládejte (CTRL+S) 
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30. Smažte popisky u pohledů. 

31. Popisky u řezů upravte tak, aby zobrazovali pouze písmenné označení řezu. U výřezu ponechte i měřítko. 
32. Vyberte všechny popisky a v horní liště změňte velikost písma na 10mm. 
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Krok č.5 Vytvoření průřezů 

33. Klikněte na  Offset Section Cut a vytvořte průřezy dle obrázků. 
34. U každého průřezu smažte popisek a přesuňte ho na čáru řezu. 
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Krok č.6 Tvorba os 

35. Přidejte osy dle obrázku. 
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Pravidelně ukládejte (CTRL+S) 
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Krok č.7 Vyplnění razítka 

36. Okótujte, doplňte geometrické tolerance a drsnosti dle obrázků. 
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Pravidelně ukládejte (CTRL+S) 
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Pravidelně ukládejte (CTRL+S) 
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Pravidelně ukládejte (CTRL+S) 
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Krok č.8 Popisek nad razítko 

37. Klikněte na  Text a vytvořte nad razítkem text dle obrázku. 
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Krok č.9 Vyplnění vlastností modelu 

38. Přepněte se do okna s modelem. 

39. Klikněte pravým tlačítkem na Product (TELO) a vyberte Properties. 
40. Vyberte záložku Product. 

41. Zkontrolujte že, v části Part Number je napsán název součásti (TELO). 

42. Klikněte na . 

43. Vedle  vyberte hodnotu String a poté klikněte na . 
44. Přejmenujte String.1 na Material. 

45. Nyní vyberte hodnotu Mass a klikněte na . 

46. Vytvořený parametr Mass.1 přejmenujte na Weight. 

47. Nabídku potvrďte . 

48. Nastavení Properties nyní potvrďte . 

49. Klikněte na  Formula v dolní nástrojové liště. 
50. Filter Type nastavte a User Parameters. 

51. Vyberte parametr „…\Material“ a klikněte na . 

52. Nyní vyberte ve stromě prvků na parametr ‘Material‘ a potvrďte  

53. Vyberte parametr „…\Weight“ a klikněte na . 

54. Nyní vyberte ve stromě prvků v části InertiaVolume na parametr ‘Mass‘ a potvrďte . 

55. Potvrďte nastavení parametrů . 

56. Nastavení parametrů můžete zkontrolovat v Properties, budou vyplněny hodnoty dle parametrů. 
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Krok č.10 Vložení rámečku, razítka a doplnění informací. 

57. Přepněte se do okna s výkresem. 

58. V horní nabídce vyberte Edit -> Sheet Background. 

59. Klikněte na  Frame and Title Block v boční nástrojové liště. 
60. Zobrazí se okno Manage Frame And Title Block. 

 

61. V nabídce Style of Title Block vyberte styl ZCU_Drawing_Titleblock. 

62.  V nabídce Action vyberte Create a klikněte na . 

63. Vyberte DesignedBy a klikněte na . 

64. Do zobrazeného okna napište svoje jméno a potvrďte . 
 

 

65. Pro vyplnění čísla výkresu dvojklikem na textové pole XXX-XX-XXXX spustíte okno pro editaci. 
66. Vyplňte libovolným textem (ZCU-00-0010). 
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21.CVIČENÍ 

CÍL 

Tvorba výrobního výkresu součásti šnek sestavy mlýnku na maso. 

  

 

PŘEDPOKLADY 

 Vymodelovaný nebo stažený model součástí 06_SNEK mlýnku na maso. 

 Znalost tvorby pohledů, kótování, tvorba drsnosti,… z předešlých cvičení. 

 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Opakování tvorba pohledu, kótování,… 
 Isolované pohledy 

 Comulated Dimension 

 Arrow 
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Krok č.1 Vytvoření nového výkresu a otevření modelu 

1. V dolní nástrojové liště klikněte na tlačítko  New (CTRL+N). 

2. V zobrazené nabídce vyberte Drawing a potvrďte výběr . 

3. V části Standart vyberte typ papíru CEG2. 
4. Zaškrtněte natočení papíru LANDSCAPE. 

5. V části Sheet Style vyberte A1 ISO a potvrďte výběr . 

6. V nabídce File vyberte Save As. 
7. Nastavte složku pro uložení. 

8. Jako File name zadejte 21_SNEK. Potvrďte tlačítkem . 
9. Otevřete si model šneku. 

 
 

 

Krok č.2 Vytvoření pohledů, řezů a průřezů. 

10. Klikněte na  Front View v boční nástrojové liště.  

11. Přepněte se do okna s modelem a vyberte rovinu Půdorys. 

 

 

12. Nastavte orientaci dle obrázku a vytvořte pohled. 
 

 

V názvech souborů nepoužívejte diakritiku ani speciální 
znaky. Potřebujete-li v názvu souboru mít mezeru, 
použijte podtržítko “_“. 
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13. Nyní klikněte pravým tlačítkem na Front View ve stromě 

pohledů a vyberte Properties. 
14. Do kolonky Scale nastavte měřítko 2:1. 

15. Zapněte zobrazování Fillets – Boundaries. 

16. A potvrďte . 
17. Smažte popisek pohledu. 
 

 

18. Klikněte na  Projection View a vytvořte promítnutý pohled dle obrázku. Po vytvoření smažte popisek. 

 

19. Klikněte na  Offset Section View a vytvořte řez dle obrázku. Po vytvoření smažte popisek. 
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20. Klikněte na  Projection View a vytvořte promítnutý pohled dle obrázku. Po vytvoření smažte popisek. 

 

21. Klikněte na  Offset Section Cut a vytvořte průřez dle obrázku. Po vytvoření smažte popisek. 

 

22. Pomocí   Isometric vytvořte dva izometrické pohledy dle obrázku. 

23. U těchto pohledů ponechte měřítko 1:1 a zapněte zobrazení Fillets – Boundaries. 
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Krok č.3 Vložení grafů z modelu 

24. Přepněte se do okna s modelem. 

25. Vložte novou skici na rovinu zadní. 
26.  A vytvořte skici dle obrázku. 

 

 

27. Skryjte model šneku (PartBody). 

28. Přepněte se do okna s výkresem. 
29. V horní liště spusťte Tools-> Options… 

30. Nyní v bočním stromě vyberte Mechanical Design -> Drafting 
31. Vyberte záložku View a zde zaktivujte Project 3D Wireframe. 

32. Toto nastavení potvrďte . 

33. Klikněte na  Front View a vyberte rovinu zadní. 
 

 

34. Po vložení klikněte pravým tlačítkem na pohled a vyberte Front View object -> Isolate. 

35. Upravte tloušťky čar dle obrázku. 
 

 
 

 

 

 
 

 

Pravidelně ukládejte (CTRL+S) 
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36. Přepněte se do okna s modelem. 
37. Skryjte tuto vytvořenou skicu. 

38.  Zobrazte skicu profilu, kterou jste využívali k tvorbě zákona (geometrical set SNEK – první skica). 

 

 

39. Přepněte se do okna s výkresem. 

40. Klikněte na  Front View a vyberte rovinu zadní. 

 

 

41. Po vytvoření pohledu nastavte tomuto pohledu měřítko 2:1. 

42. Po nastavení měřítka pohled opět isolujte (Front View object -> Isolate). 

 

Graf pro zákon (Law) lze též vytvořit předešlým způsobem. Následující způsob je využití vytvořené skici a následném 
dokreslení potřebných čar v okně výkresu. 
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43. Přepněte se do okna s modelem. 

44. Skryjte tuto skicu. 
45. Zobrazte model a model uložte (CTRL+S). 

46. Přepněte se do okna s výkresem a klikněte na  Update. 

 

47. Smažte popisek posledního pohledu a dokreslete čáry dle obrázku. 

 

21 - 7



Krok č.4 Upravení pohledů a okótování 

48. Doplňte osy, kóty, drsnosti, popisky,… dle obrázků. 

 

 

49. Klikněte na  Comulated Dimension v boční nástrojové liště. 

50. Vyberte oranžově vyznačené čáry a poté umístněte vytvořenou skicu. 
 

 
 

 
 

 
 

Pokud preferujete horizontální orientaci kót. Označte všechny kóty a spusťte Properties. Přejděte na záložku 

Value a změňte Orientation na Perpendicular. 
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51. Stejným způsobem vytvořte kóty na vertikální straně. 

52. Poté doplňte textové popisky. 

 

53. Klikněte na  Arrow v boční nástrojové liště a přidejte šipky dle obrázku. 
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54. Šipky u textu POLOHA a DELKA L dokreslete pomocí oblouku a čar. 

 

Krok č.5 Dokreslení čar dělící roviny 

55. Dokreslete značky a čáry dělící roviny. Plné trojúhelníky vytvořte plným vyšrafováním oblasti. 

56. Pro všechny čáry a takto vytvořené značky nastavte červenou barvu. 

 
 

 

21 - 10



Krok č.7 Popisek nad razítkem 

57. Nad razítkem vytvořte text dle obrázku. 

 

Krok č.8 Vyplnění vlastností modelu 

58. Přepněte se do okna s modelem. 

59. Klikněte pravým tlačítkem na Product (SNEK) a vyberte Properties. 
60. Vyberte záložku Product. Zkontrolujte že, v části Part Number je napsán název součásti (SNEK). 

61. Klikněte na . 

62. Vedle  vyberte hodnotu String a poté klikněte na . 
63. Přejmenujte String.1 na Material. 

64. Nyní vyberte hodnotu Mass a klikněte na . 

65. Vytvořený parametr Mass.1 přejmenujte na Weight. 

66. Nabídku potvrďte . 

67. Nastavení Properties nyní potvrďte . 

68. Klikněte na  Formula v dolní nástrojové liště. 

69. Filter Type nastavte a User Parameters. 

70. Vyberte parametr „…\Material“ a klikněte na . 

71. Nyní vyberte ve stromě prvků na parametr ‘Material‘ a potvrďte  

72. Vyberte parametr „…\Weight“ a klikněte na . 

73. Nyní vyberte ve stromě prvků v části InertiaVolume na parametr ‘Mass‘ a potvrďte . 

74. Potvrďte nastavení parametrů . 

75. Nastavení parametrů můžete zkontrolovat v Properties, 
budou vyplněny hodnoty dle parametrů. 
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Krok č.9 Vložení rámečku, razítka a doplnění informací. 

76. Přepněte se do okna s výkresem. 

77. V horní nabídce vyberte Edit -> Sheet Background. 

78. Klikněte na  Frame and Title Block v boční nástrojové liště. 

79. Zobrazí se okno Manage Frame And Title Block. 
 

80. V nabídce Style of Title Block vyberte styl ZCU_Drawing_Titleblock. 

81.  V nabídce Action vyberte Create a klikněte na . 

82. Vyberte DesignedBy a klikněte na . 

83. Do zobrazeného okna napište svoje jméno a potvrďte . 
 

 

84. Pro vyplnění čísla výkresu dvojklikem na textové pole XXX-XX-XXXX spustíte okno pro editaci. 
85. Vyplňte libovolným textem (ZCU-01-0011). 
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22.CVIČENÍ 

CÍL 

Tvorba výrobního výkresu součásti podložky sestavy mlýnku na maso. 

  

 

PŘEDPOKLADY 

 Vymodelovaný nebo stažený model součástí 07_KLIKA mlýnku na maso. 

 Znalost tvorby pohledů, kótování, tvorba drsnosti,… z předešlých cvičení. 

 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Opakování tvorba pohledu, kótování,… 
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Krok č.1 Vytvoření nového výkresu a otevření modelu 

1. V dolní nástrojové liště klikněte na tlačítko  New (CTRL+N). 

2. V zobrazené nabídce vyberte Drawing a potvrďte výběr . 

3. V části Standart vyberte typ papíru CEG2. 
4. Zaškrtněte natočení papíru LANDSCAPE. 

5. V části Sheet Style vyberte A2 ISO a potvrďte výběr . 

6. V nabídce File vyberte Save As. 
7. Nastavte složku pro uložení. 

8. Jako File name zadejte 22_KLIKA. Potvrďte tlačítkem . 
9. Otevřete si model kliky. 

 
 

 

Krok č.2 Vytvoření základných pohledů 

10. Klikněte na  Front View v boční nástrojové liště.  

11. Přepněte se do okna s modelem a vyberte rovinu Nárys. 

 

 

12. Nastavte orientaci dle obrázku a vytvořte pohled. 

 

 

V názvech souborů nepoužívejte diakritiku ani speciální 

znaky. Potřebujete-li v názvu souboru mít mezeru, 
použijte podtržítko “_“. 
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13. Nyní klikněte pravým tlačítkem na Front View ve stromě 

pohledů a vyberte Properties. 
14. Do kolonky Scale nastavte měřítko 2:1. 

15. Zapněte zobrazení Fillets -> Boundaries. 

16. A potvrďte . 
17. Smažte popisek pohledu. 

 

18. Pomocí  Projection View a vytvořte promítnutý pohled dle obrázku. 
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19. Přepněte se do okna s modelem a zobrazte skici z prvku Multi-sections Solid dle obrázku vlevo. 

20. Přepněte se do okna s výkresem a pomocí  Projection View a vytvořte promítnutý pohled dle obrázku. 
21. U vytvořeného pohledu, ve vlastnostech, vypněte zobrazení Fillets a zapněte zobrazení 3D Wireframe  

22. Poté pohled Isolujte. 
 

 
 

 
 

 
 

 

 
 

 
 

Více informací o využití skic z modelu a isolování pohledu viz předešlá cvičení. 

 

Pravidelně ukládejte (CTRL+S) 
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23. Přepněte se do okna s modelem a skryjte skici z prvku Multi-sections Solid. 

24. Zobrazte skici z prvku druhého prvku Multi-section Solid (výřez) dle obrázku vlevo. 

25. Přepněte se do okna s výkresem a pomocí  Projection View a vytvořte promítnutý pohled dle obrázku. 

26. U vytvořeného pohledu, ve vlastnostech, vypněte zobrazení Fillets a zapněte zobrazení 3D Wireframe  

27. Poté pohled Isolujte. 
 

 
 

28. Přepněte se do okna s modelem a skryjte zobrazené skici a poté model uložte. 

29. Přepněte se do okna s výkresem a klikněte na  Update. 
 

 

 
 

 

22 - 5



Krok č.3 Vytvoření řezů a průřezů 

30. Pomocí   Offset Section View vytvořte tři řezy kliky dle obrázku. 

31. U každého řezu upravte popisek řezu dle obrázku. 
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32. Pomocí  Offset Section Cut vytvořte průřez kliky dle obrázku. Přesuňte ho na čáru průřezu. 

 Nejlepší způsob tvorby čáry řezu je vytvořit si pomocí  Line osu dle obrázku. 

  Poté ze středu této čáry vytvořit další čáru kolmou na ni. 

 Poté kliknout na Offset Section Cut a vybrat druhou čáru. 

 Po vytvoření průřezu zeditovat čáru průřezu a obě předešlé čáry skrýt. 
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Krok č.4 Upravení pohledů a okótování 

33. Upravte pohledy, vytvořte osy dle obrázků, okótujte, vytvořte popisku,… dle obrázků 

 

 
 

 
 

 
 

 

 

Pravidelně ukládejte (CTRL+S) 
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Krok č.5 Vyplnění vlastností modelu 

34. Přepněte se do okna s modelem. 

35. Klikněte pravým tlačítkem na Product (SNEK) a vyberte Properties. 
36. Vyberte záložku Product.  

37. Zkontrolujte že, v části Part Number je napsán název součásti (SNEK). 

38. Klikněte na . 

39. Vedle  vyberte hodnotu String a poté klikněte na . 
40. Přejmenujte String.1 na Material. 

41. Nyní vyberte hodnotu Mass a klikněte na . 

42. Vytvořený parametr Mass.1 přejmenujte na Weight. 

43. Nabídku potvrďte . 

44. Nastavení Properties nyní potvrďte . 

45. Klikněte na  Formula v dolní nástrojové liště. 

46. Filter Type nastavte a User Parameters. 

47. Vyberte parametr „…\Material“ a klikněte na . 

48. Nyní vyberte ve stromě prvků na parametr ‘Material‘ a potvrďte  

49. Vyberte parametr „…\Weight“ a klikněte na . 

50. Nyní vyberte ve stromě prvků v části InertiaVolume na parametr ‘Mass‘ a potvrďte . 

51. Potvrďte nastavení parametrů . 
52. Nastavení parametrů můžete zkontrolovat v Properties, budou vyplněny hodnoty dle parametrů. 
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Krok č.6 Vložení rámečku, razítka a doplnění informací. 

53. Přepněte se do okna s výkresem. 

54. V horní nabídce vyberte Edit -> Sheet Background. 

55. Klikněte na  Frame and Title Block v boční nástrojové liště. 

56. Zobrazí se okno Manage Frame And Title Block. 

 

57. V nabídce Style of Title Block vyberte styl ZCU_Drawing_Titleblock. 

58.  V nabídce Action vyberte Create a klikněte na . 

59. Vyberte DesignedBy a klikněte na . 

60. Do zobrazeného okna napište svoje jméno a potvrďte . 

 

 

61. Pro vyplnění čísla výkresu dvojklikem na textové pole XXX-XX-XXXX spustíte okno pro editaci. 

62. Vyplňte libovolným textem (ZCU-02-0012). 
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23.CVIČENÍ 

CÍL 

Tvorba výrobního výkresu součásti podložky sestavy mlýnku na maso. 

  

 
 

 
 

PŘEDPOKLADY 

 Vymodelovaný nebo stažený model součástí 11_SESTAVA mlýnku na maso. 

 Znalost tvorby pohledů z předešlých cvičení. 

 

PROBÍRANÉ PRVKY, FUNKCE A POSTUPY 

 Opakování tvorba pohledu, kótování,… 

 Izo-pohled rozpadlé sestavy 
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Krok č.1 Vytvoření nového výkresu a otevření modelu 

1. V dolní nástrojové liště klikněte na tlačítko  New (CTRL+N). 

2. V zobrazené nabídce vyberte Drawing a potvrďte výběr . 

3. V části Standart vyberte typ papíru CEG2. 
4. Zaškrtněte natočení papíru LANDSCAPE. 

5. V části Sheet Style vyberte A1 ISO a potvrďte výběr . 

6. V nabídce File vyberte Save As. 
7. Nastavte složku pro uložení. 

8. Jako File name zadejte 23_SESTAVA. Potvrďte tlačítkem . 
9. Otevřete si model sestavy. 

 
 

 

Krok č.2 Vytvoření základných pohledů 

10. Klikněte na  Front View v boční nástrojové liště.  

11. Přepněte se do okna s modelem a vyberte rovinu Nárys. 
 

 

V názvech souborů nepoužívejte diakritiku ani speciální 

znaky. Potřebujete-li v názvu souboru mít mezeru, 
použijte podtržítko “_“. 
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12. Nastavte orientaci dle obrázku a vytvořte pohled. 

 

13. V Properties nastavte zobrazení Fillem – Boundaries a potvrďte . 

14. Smažte popisek. 
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15. Klikněte na  Projection View a vytvořte promítnutý pravý pohled (smažte popisek). 

 

 

16. Pomocí  Isometric vytvořte izometrický pohled. 
17. A v Properties nastavte zobrazení Fillets – Boundaries. 
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Krok č.3 Horní a dolní poloha kliky. 

18. Přepněte se do okna s modelem. 

19. Ve stromě prvků zobrazte rovinu Nárys u modelů TELO, RUKOJET a rovinu Bokorys u KLIKY. 

20. Klikněte na  Quick Constraint a vyberte zobrazené roviny těla a kliky. 

 Poloha kliky po vytvořené vazbě. 

 

 

21. Rozklikněte si část Constraints a poslední vytvořenou vazbu deaktivujte. 
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22. Klikněte na  Quick Constraint a vyberte zobrazené roviny těla a rukojeti. 

 Poloha kliky po vytvořené vazbě (dolní poloha). 

 

 

23. Klikněte na  Section Cut / Annotation Plane v boční nástrojové liště. 

24. Vyberte zobrazenou rovinu těla. 

 
 

 

 
 

 
 

 
 

 
 

 

Ve stromě prvků se vytvoří položka Annotation Set – > Views – > Section Cut View.1 

Pravidelně ukládejte (CTRL+S) 
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25. Přepněte se do okna s výkresem.  

26. Klikněte na  View from 3D v boční nástrojové liště. 
27. V okně s modelem vyberte vytvořený Section Cut View. 

28. Umístněte pohled prozatím mimo papír. 

29. Na vytvořeném pohledu vytvořte kótu dle obrázku. 
 

 
 

 

 
 

 
 

 

 
 

Pravidelně ukládejte (CTRL+S) 
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30. Klikněte pravým tlačítkem myši na pohled a vyberte Section Cut View.1 A-A object -> Overload Properties. 

31. Nyní postupně vyberte na pohledu všechny součásti (zobrazí se v okně). 
 

 

32. Podržte CTRL a vyberte všechny součásti kromě rukojeti. 

33. Po výběru klikněte na . 
34. V zobrazeném okně odznačte Shown. 

 

   

35. Nastavení potvrďte  (obrázek vlevo). 

36. Skryjte šrafy (obrázek vpravo). 
 

                               

23 - 8



37. Vytvořený pohled izolujte. 

38. Klikněte pravým tlačítkem na pohled a vyberte View Positioning -> Superpose. 
 

 

39. Vyberte levý pohled (pohled se přesune na odpovídající pozici v tomto pohledu). 
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 Horní poloha kliky. 

40. Přepněte se do okna s modelem. 

41. Vyberte poslední vytvořenou vazbu a dvojklikem spusťte její editaci. 

42. Klikněte na  a místo Same nastavte Oposite a potvrďte . 

 

 Poloha kliky po update (horní pozice). 
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43. Klikněte na  View from 3D v boční nástrojové liště. 

44. V okně s modelem vyberte vytvořený Section Cut View. 
45. Stejným způsobem jako v krocích 26.-36. Vytvořte pohled dle obrázku. 

 

46. Tento pohled opět umístněte do levého pohledu pomocí superpose. 
47. Přepněte se do okna s modelem, deaktivujte poslední vytvořenou vazbu a aktivujte vazbu mezi klikou a tělem. 

48. Klikněte na   Update. 
 

 
 

 

 
 

Pokud levý pohled posunete, musíte opět přiřadit pomocí Superpose polohu pro průřezy. 
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Krok č.4 Tvorba řezů. 

 Aktivujte levý pohled. 

49. Klikněte na   Breakout View a vyberte oblast dle obrázku. 

 

 

50. Pro nastavení roviny řezu vyberte v předním pohledu jakoukoliv kružnici, která svým středem určí střed mlýnku. 

51. Nastavení potvrďte . 
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52. Stejným způsobem vytvořte částečné řezy dle obrázku. 
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53. Klikněte pravým tlačítkem na pohled a vyberte  Left View object -> Overload Properties. 

54. Vyberte všechny součásti. 
 

 

 

 
 

55. Nyní nastavte pro všechny součásti vlastnosti dle tabulky. A potvrďte . 

 

 
 
 

 

 
 

 
 

Pomocí Edit můžete pro každou součást nastavit, zda bude zobrazena (Shown), promítána (Use when projecting), pokud může být 
zobrazena v řezu (Cut in section views), barvu čar, tloušťku a typ čáry. 

Pravidelně ukládejte (CTRL+S) 
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56. U součástí v řezu upravte nastavení šraf. 

 

 

23 - 15



57. Vytvořte řez dle obrázku. 

58. Řez umístněte volně na papír. 
59. Nastavte mu popisek C-C a měřítko 2:1 a zobrazení závitů (Thread). 

60. V Overload Properties nastavte pro čep a svar, že se nezobrazují součásti v řezu. 

 

 

Krok č.5 Úprava pohledů 

61. Dokreslete označení řezů A-A, B-B, upravte osy, okótujte,… pohledy dle obrázků. 
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Pravidelně ukládejte (CTRL+S) 
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Krok č.6 Vložení rámečku, razítka a doplnění informací. 

62. Přepněte se do okna s výkresem. 

63. V horní nabídce vyberte Edit -> Sheet Background. 

64. Klikněte na  Frame and Title Block v boční nástrojové liště. 

65. Zobrazí se okno Manage Frame And Title Block. 

 

66. V nabídce Style of Title Block vyberte styl ZCU_Drawing_Titleblock. 

67.  V nabídce Action vyberte Create a klikněte na . 

68. Vyberte DesignedBy a klikněte na . 

69. Do zobrazeného okna napište svoje jméno a potvrďte . 

 

 

70. Pro vyplnění čísla výkresu dvojklikem na textové pole XXX-XX-XXXX spustíte okno pro editaci. 

71. Vyplňte libovolným textem (ZCU-01-0000). 
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Krok č.7 Generování pozic a tvorba soupisky 

72. Přepněte se do okna s modelem. 

73. Klikněte na  Generate Numbering v boční nástrojové liště. 

74. Vyberte Product ( MLYNEK_NA_MASO ). A potvrďte . 

75. V horní nabídce vyberte Analyze - > Bill of material… 
76. Nadefinujte kusovník tak, aby postupně následovaly toto položky: 

  Number, Part Number,Product Description, Material, Definition, Weight, Quantity 

77. Spodnímu kusovník nadefinujte pouze Number a Part Number. 
78. Pokud nyní zkontrolujete horní tabulku, můžete si všimnout, že SROUB_KLIKA je bez čísla a je vprostřed tabulky.  
 

 
79. Nastavení kusovníku potvrďte .  

80. Klikněte na   Graph tree Reordering v boční nástrojové liště.  

81. Vyberte hlavní product (MLYNEK_NA_MASO). 

82. Označte SROUB_KLIKA a přesuňte ho na konec. 
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83. Přepněte se do okna s výkresem. 

84. Klikněte na   Balloons Generation v boční nástrojové liště. 

85. Po vložení upravte polohu pozic. 
 

 

86.  Pomocí   Balloon V boční nástrojové liště vložte pozici dle obrázku. 
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87. Klikněte na  Bill of material v boční nástrojové liště. 

88. Přepněte se do okna se sestavou a vyberte  MLYNEK_NA_MASO. 
89. Poté klikněte mimo papír. 

 

 

90. Upravte horní tabulku (kusovník) dle obrázku. 
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91. Přesuňte kusovník nad razítko a upravte tak, aby nepřesahoval. 
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Krok č.8 Katalogový list 

92. Klikněte na   New Sheet v boční nástrojové liště. 
93. Přepněte se do okna s modelem. 

94. Klikněte na  Explode a nastavte rozpad First level, Constrained. 

95. Poté upravte pozici dle obrázku. 
 

 
 

 

96. Pomocí   Isometric vytvořte pohled dle obrázku. 
 

 

Více informací o rozpadu viz cvičení 11_SESTAVA. 
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97. Vytvořte pozice a upravte jejich polohu. 

 

 

98.  Doplňte popisky dle obrázku. 
99. Překopírujte z papíru jedna tabulku číslo 3 
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